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Manage Model Change

As users contribute new content and change existing
content, a repository will become a valuable data store of
organizational information assets. It is imperative that this
asset is protected and changes are managed and controlled
including being able to revert models back to previous
versions or states. Enterprise Architect has a number of
sophisticated tools to ensure the information is protected,
including full integration with all the leading Version
Control Systems, Baselines that are snapshots of your model
that can be taken at important milestones, and Auditing that
can track the finest changes to a model. A Project Transfer
function helps you to make backups of models without
involving information technology personnel. There are also
Model Validation and Project Integrity Checkers to ensure
the repository is maintained with a clean bill of health, and
an effective role based Security System to ensure users can
collaborate easily and sections of the model can be locked to
users or groups.

Facilities

Facility Detail
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Baselines Baselines create snapshots of model
content; a changed model can then be
compared to the snapshot and changes
can be reverted to the Baseline content if
required.

Baselines are created at the Package·

level providing snapshots of an entire
Package including elements, features
and diagrams  and optionally also the
Packages it contains
As a model is altered the changed·

Package can be compared with a
baseline, including visual diagram
changes and, if required, the current
model can be reverted to the content
stored in the Baseline
Baselines require no setup and provide·

an easy way for business and technical
users to  restore models to previous
states at any level of granularity
Baselines created for Package-trees can·

be published for external use via the
Reusable Asset Service (RAS)

Reusable
Asset Service

The RAS portion of the Pro Cloud Server
helps you to define Packages that can be
used in any model. A registered
Package-tree includes:

Version of the Package held in the·
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registry
Diagrams and elements (including·

child Package elements) contained by
the Asset Package
Dependencies on parent Packages of·

any external elements that the Asset
Package references
Dependencies on MDG Technologies.·

This makes everything required by that
Package available to any repository that
has access to that RAS, as well as
features for comparing that RAS Package
against a Package in the current model.
The RAS service can also host Baselines.

Auditing Auditing records changes to the content
in a repository and provides a practical
view that can be used to drill down into
changes from the Package level down to
changes to element features.

Auditing is typically used by librarians·

and administrators to investigate who
made a change to the model and the
date and time it was changed
It can be used to locate problems in·

model development or for contractual
reasons where third parties have been
given access to manage model content
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and the source of a change needs to be
identified
Auditing can be enabled and disabled·

at any time and the audit logs can be
saved and reload as needed

Version
Control

Version Control allows model content to
be versioned allowing check-out and
check-in of Packages to facilitate keeping
track of different versions of parts of the
model and allowing rollback to prior
versions.

Coordinate sharing of Packages·

between users, with either read-only
access or update access, ensuring that
work on different areas of the model is
coordinated and synchronous rather
than conflicting
Allow check-out and check-in of·

Packages to and from working storage
including users working offline.
Save and retrieve a history of changes·

to Packages
To use Version Control in Enterprise
Architect, you require a third-party
source-code control application such as:

Subversion·

CVS·
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MS Team Foundation Server (TFS), or·

Any other Version Control product that·

complies with the Microsoft Common
Source Code Control standard

Compare
Projects

The Compare Project facility, compares a
Source and Target Repository for
differences and provides a summary of
the changes to a repository, as a
comparison of the number of rows in
each table in the source and the target
repositories.

Project Data
Transfer

Enterprise Architect enables you to
transfer project data between project data
repositories either for:

Sections of the project (XMI and CSV)·

or
The whole project, row by row, table·

by table (in the Corporate, Unified and
Ultimate Editions of Enterprise
Architect)
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Timelines Window
The Timelines window is a collection of tab windows that
provides facilities for viewing and managing snapshots and
baselines associated with diagrams, packages and individual
elements as they change over time, during the development
of your model.

Access

Ribbon Start > All Windows > Design > Tools >
Timelines
Design > Package > Timelines
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The Diagram Tab
The diagram tab contains two sub-tabs, 'Current Session'
and 'Snapshots', that are used to display and manage
'snapshots' of a diagram at various points in time as the
model is developed.

The 'Current Session' sub-tab displays a list diagram
snapshots for the current session.  These snapshots are
created when the current diagram is first opened, and
thereafter, each time the diagram is saved.  Current Session
snapshots are stored in application memory.  They are
discarded when the application shuts down.

The 'Snapshot' sub-tab displays a list of diagram snapshots
captured either automatically or manually.  These snapshots
are stored within the model database.

Each of the sub-tabs provides a range of commands for
creating, displaying, saving and deleting the snapshots it
displays.  The menus are displayed by either clicking on the

  icon, or right-clicking within the tab window.  The menu
options are described below.

Access

Ribbon Start > All Windows > Design > Tools >
Timelines | Diagram
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Current Session (sub-tab)

The 'Current Session' sub-tab displays a list of diagram
snapshots for the current session.  These snapshots are
created when the current diagram is first opened, and
thereafter, each time the diagram is saved.

The snapshot information is displayed as a table comprising
three columns.  The columns are described here:

Column Description

Snapshot The creation timestamp

Objects The number of Objects on the diagram at
the time of capture

Connectors The number of Connectors on the
diagram at the time of capture
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Current Session Menu Options

The 'Current Session' sub-tab provides a range of commands
for creating, saving, comparing and deleting the diagram
snapshots.  The commands are accessed via a menu, which
is displayed either by clicking on the  icon in the title bar,
or by right-clicking within the tab window.  The menu
options are described here:

Menu Option Description

Show
Snapshot

Shows the selected snapshot image in a
popup viewer

Save to
Snapshots...

Saves the selected snapshot image to
model which then can be viewed in the
adjacent ‘Snapshots’ tab

Delete
Snapshot

Deletes the selected snapshot image from
memory

Delete All Deletes all of the currently listed
snapshots from memory

Snapshot (sub-tab)

The 'Snapshot' sub-tab displays a list of diagram snapshots
captured and stored within the model database.  Diagram
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snapshots can be captured both automatically and manually.
To enable automatic snapshots, choose the ribbon option
'Settings | Model | Options | General | Snapshots'.

The snapshot information is displayed as a table comprising
three columns.  The columns are described here:

Column Description

Snapshot The creation timestamp

User The ID of the user that created the
snapshot

Type Image, Baseline, Image & Baseline,
Cached.
(Cached is the captured image used for
WebEA.)
Additionally, an asterisk is used to
indicate the following;

Image*  - the image is tagged as a·

filtered view
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Baseline*  - the baseline includes full·

object features

Snapshot Menu Options

The 'Snapshots' sub-tab provides a range of commands for
creating, saving, comparing and deleting the diagram
snapshots.  The commands are accessed via a menu, which
is displayed either by clicking on the  icon in the title bar,
or by right-clicking within the tab window.  The menu
options are described here:

Menu Option Description

Create Image
Snapshot...

Creates a stored image of the current
diagram

Create
Baseline
Snapshot...

Creates a Native XML format snapshot of
the current diagram and elements it
contains

Create Both
Snapshots...

Creates both an image and Native XML
snapshot of the current diagram

Show
Snapshot

Shows the selected snapshot image in a
popup viewer

Compare Compares the selected Native XML
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Snapshot snapshot with the current diagram and
displays the results in the Snapshot
Comparison view

Compare
Selected
Snapshots

Compares two selected Native XML
snapshots.  The results are displayed in
the Snapshot Comparison window

Save
Snapshot to
Native XML
File...

Exports the selected Native XML
snapshot to a file

Show/Hide
Comments

Show/Hide comments associated with the
listed snapshots

Edit
Comment...

Edit the selected snapshot's comment

Visible
Timeframe

Filter the list of displayed snapshots, to
show only those saved within the last
specified number of days:
Today, 2, 3, 5, 7, 30, 90

Show All Clears the value for 'Visible Timeframe'
and shows all captured snapshots

Delete
Snapshot

Delete the selected snapshot
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The Package Tab
The Package tab contains two sub-tabs, used to display and
manage package snapshots and baselines, that capture the
changing states of a package at various points in time as the
model is developed.  Snapshots capture the package
information using Native XML format, whilst baselines
capture package information using extended XML 1.1
format.  All snapshots and baselines are stored within the
model.

Each of the sub-tabs provides a range of commands for
creating, displaying, saving and deleting the snapshots or
baselines it displays.  The menus are displayed by either
clicking on the   icon, or right-clicking within the tab
window.  The menu options are described below.

Access

Ribbon Start > All Windows > Design > Tools >
Timelines | Package

Snapshots (sub-tab)

The Snapshots sub-tab displays a list of snapshots of the
currently selected package.
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The information is displayed as table, with columns
showing:

Column Description

Snapshot The creation timestamp

User The ID of the user that created the
snapshot

Snapshots Menu Options

The 'Snapshots' sub-tab provides a range of commands for
creating, saving, comparing and deleting the package
snapshots.  The commands are accessed via a menu, which
is displayed either by clicking on the  icon in the title bar,
or by right-clicking within the tab window.  The menu
options are described here:

Menu Option Description
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Create
Snapshot...

Creates a Native XML format snapshot of
the current Package, Diagrams and
Elements

Compare
Snapshot

Compares the selected Native XML
snapshot with the currently selected
Package.  The results are displayed in the
Snapshot Comparison View.

Compare
Selected
Snapshots

Compares two selected Native XML
snapshots and displays the results in the
Snapshot Comparison window

Save
Snapshot to
Native XML
File...

Exports the selected Native XML
snapshot to a file

Export
Package and
all Snapshots

Exports Package and all its Snapshots to
a file, using Native XML format

Import
Package and
Snapshots

Imports a Native XML file containing
Package and all its Snapshots, into the
model

Show/Hide
Comments

Show/Hide comments associated with the
listed snapshots
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Edit
Comment...

Edit the selected snapshot's comment

Visible
Timeframe

Filter the list of displayed snapshots, to
show only those saved within the last
specified number of days:
Today, 2, 3, 5, 7, 30, 90

Show All Clears the value for 'Visible Timeframe'
and shows all captured snapshots

Delete
Snapshot

Delete the selected snapshot

Baselines (sub-tab)

The Baselines sub-tab displays a list of Baselines for the
currently selected package.

The information is displayed as a table, with two columns,
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showing:

Column Description

Snapshot The creation timestamp

Version The baseline version label

Baselines Menu Options

The 'Baselines' sub-tab provides a range of commands for
managing and comparing the package baselines.  The
commands are accessed via a menu, which is displayed
either by clicking on the  icon in the title bar, or by
right-clicking within the tab window.  The menu options are
described here:

Menu Option Description

Create
Package
Baseline...

Create a XML 1.1 Baseline of the
selected Package

Compare
Baseline

Compares the current Package with the
selected Baseline, and displays the results
in the Baseline Comparison view

Open
Baselines...

Display the Baselines dialog, with the
currently selected item highlighted
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Show/Hide
Comments

Show/Hide comments associated with the
listed baselines

Visible
Timeframe

Filter the list of displayed baselines, to
show only those saved within the last
specified number of days:
Today, 2, 3, 5, 7, 30, 90

Show All Clears the value for 'Visible Timeframe'
and shows all baselines
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The Element Tab
The Element tab is used to display and manage element
snapshots, that capture the changing states of an element at
various points in time as the model is developed.  The
snapshot information is stored within the model database
using Native XML format.

The list of snapshots is shown as a table comprising two
columns:

Snapshot - the creation timestamp·

Type - either Full (the full object features are stored in the·

snapshot) or Core (only the core properties are stored in
the snapshot).

Access

Ribbon Start > All Windows > Design > Tools >
Timelines | Element
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Menu Options

The 'Elements' tab provides a range of commands for
creating, saving, comparing and deleting the element
snapshots.  The commands are accessed via a menu, which
is displayed either by clicking on the  icon in the title bar,
or by right-clicking within the tab window.  The menu
options are described here:

Menu Option Description

Create
Snapshot...

Creates a Native XML format snapshot of
the currently selected Element.

Compare
Snapshot

Compares the selected Native XML
snapshot with the currently selected
Element.  The results are displayed in the
Snapshot Comparison View.

Compare
Selected
Snapshots

Compares two selected Native XML
snapshots and displays the results in the
Snapshot Comparison window.

Save
Snapshot to
Native XML
File...

Exports the selected Native XML
snapshot to a file.
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Show/Hide
Comments

Show/Hide comments associated with the
listed snapshots.

Edit
Comment...

Edit the selected snapshot's comment.

Visible
Timeframe

Filter the list of displayed snapshots, to
show only those saved within the last
specified number of days:
Today, 2, 3, 5, 7, 30, 90

Show All Clears the value for 'Visible Timeframe'
and shows all captured snapshots.

Delete
Snapshot

Delete the selected snapshot.
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The TAM Tab
The TAM (Time Aware Modeling) tab displays the
hierarchy of Ancestor/Clone relationships and provides
access to compare differences between models.

Access

Ribbon Start > All Windows > Design > Tools >
Timelines | TAM

Drop-down Menu

The drop-down menu is displayed by clicking on the
hamburger icon (or anywhere in the title bar that contains
the icon).

Menu Option Description
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Switch to
Related
Element

Switches context to the selected item

View Related
Element
Properties

Switches the context to the selected item

Find in all
Diagrams

Display a list of all diagrams containing
the selected item.

Context Menu

The context menu is displayed by right-clicking within the
TAM tab window.

Menu Option Description

Clone
Structure as
New
Version…

Clones the currently selected structure as
a new version.
Enables with context Package

Compare
with Version

Clones the currently selected structure as
a new version.
Enables with context Package
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The Version Control Tab
The Version Control tab of the Timelines window allows
users to view a comprehensive list of revisions for packages,
diagrams, and individual model elements that are under
version control. Users can utilize this feature to view all
revisions of the version-controlled package containing the
selected model element.

Additionally, it enables users to compare the model content
against any selected revision from version control.

Access

Keyboard "Alt +1", then choose "Tools >
Timelines".
In the "Timelines" window, open the
"Version" tab.

Ribbon "Start > All Windows > Design | Tools |
Timelines" or "Design > Diagram >
Manage | Tools | Timelines"
In the "Timelines" window, open the
"Version" tab.

Selecting Model Elements for Comparison
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To choose a model element for comparison, you have
several options: you can select an element (a package,
diagram, or individual element) in the Browser window,
pick an element from a diagram, or click on an open
diagram. You can make your selection before opening the
Timelines window's Version page, and you can also modify
your selection after the Timelines window is open.

Performing Comparisons

With the 'Version' page of the 'Timelines' window
displayed, select a model element, then on the 'Version'
page, select the revision against which you wish to perform
a comparison.  Right-click on the revision and choose the
menu option "Compare model to selected revision".

                    
The 'Comparison' window will open, showing the
differences between the model and the selected 'baseline'.

While the comparison is performed at the level of the
version controlled package, the results window will initially
display the differences for the selected model object,

(c) Sparx Systems 2025 Page  33 of 417



Manage Model Change 2 September, 2025

whether it be a package, a diagram or a single model
element.

Within the results window, you can subsequently choose
other model objects for which to display differences.

Menu Options

A range of version control operations is also available
through the drop-down menu at the top of the 'Version'
page.

These commands operate on the version controlled package
that contains the selected package, diagram or element.
Where the selected package is itself version controlled, the
operations will act on that package.
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Menu Option Description

Check Out... Synchronize the currently selected
Package with the latest revision from the
Version Control repository and unlock
the Package to allow editing.

Only available for Packages that are not
already checked-out (and whose
associated Package file is not
checked-out).

Check In... Commit a new revision of the currently
selected Package to the Version Control
repository and lock the Package against
further editing.

Only available for Packages that you
have checked-out yourself.

Undo Check
Out...

Reverses the check-out of a Package,
discarding any modifications that have
been made by restoring the Package
content to the latest revision held in
Version Control.

Put Latest... Commit a new revision of the currently
selected Package to the Version Control
system, while keeping the Package
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checked-out.

This is equivalent to checking a Package
in and immediately checking it back out
again.

Only available for Packages that you
have checked-out yourself.

Get Latest... Synchronize the currently selected
Package with the latest revision from the
Version Control repository.

Available only for Packages that are
checked in.

File
Properties...

Display Version Control properties
pertaining to the XMI export file
associated with the currently selected
Package; this also identifies who has
checked out the Package.

Compare
model to
selected
revision

Invokes a comparison between the
version controlled package in the model
and the selected revision of the same
package in version control.
While the comparison is performed at the
package level, the results window will
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display a comparison for the model object
that is currently selected.

Help Opens a web browser and loads the User
Guide page related to the VC page of the
Timelines window (this page).

Notes

This feature is only available for use with the following
version control providers:

Microsoft Team Foundation Server·

Subversion·
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The Auditing Tab
The Audit tab lists the context item's audit logs to provide
access to the ‘System Output > Audit History’ for quick
access without having to open the Auditing window.

The audit log items are displayed as a table with two
columns:

User - The logged-in user that made the change·

Timestamp - The timestamp attached to the change·

Access

Ribbon The Audit tab list the context item's audit
logs to provide access to the ‘System
Output > Audit History’ for quick access
without having to open the Auditing
window.
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Drop-down Menu

Menu Option Description

Show Audit
Window

Opens the Audit View window

Notes

The Audit tab is only available in models for which auditing
is enabled.
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Tracking Change
If you want to track changes to data across your project, you
can use two separate but complementary facilities - Auditing
and Baselines.

Facilities

Facility Detail

Auditing of
model
changes

Auditing is a project-level feature,
available in the Corporate, Unified and
Ultimate Editions, that enables you to
record model changes in Enterprise
Architect.
By enabling this feature, model
administrators can view a range of
information regarding changes, such as:

Who changed an element·

How many elements they changed·

When they changed the data·

What the previous values were, and·

What type of elements they changed·

Baselining
and
differencing

The Enterprise Architect Corporate,
Unified and Ultimate Editions provide a
facility to ' baseline ' or snapshot a model
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to capture
and roll back
changes

branch in XMI format at a particular
point in time, and store it within the
model in compressed format.
More than one baseline can be stored
against a single Enterprise Architect
Package; using baselines, you can
compare Packages at the current and
earlier stages of development, using the
Compare (Diff) utility.
The Compare utility is available in the
Professional, Corporate, Unified and
Ultimate Editions of Enterprise Architect;
it enables you to compare the current
model with:

A Baseline·

An exported Enterprise Architect XMI·

file in the file management system
A version-controlled Enterprise·

Architect XMI file in the file
management system
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Baselines
Baselines are snapshots of parts of the repository at a given
point in time, that can be used for later comparison and
restoration, if required.

A Baseline creates a snapshot of a model Package and its
contents at a point in time and, as the model changes, allows
you to compare the current state and the snapshot; if
required you can revert to the previous (baselined) state.
Baselines are created at the Package level and can include
child Packages; any number of Packages can be baselined,
and a Package can be baselined any number of times,
typically at important project milestones. Baselines are by
default conveniently stored within the repository making
them available to any model user who has the security
privileges to work with them. Alternatively, a Baseline can
be stored in a Cloud-based Reusable Asset Service. These
options will be explored in a later topic.

This diagram illustrates the Baseline comparison tool,
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showing model and Baseline properties; Status and Version
have changed.

Baselines are a type of insurance policy that ensures you can
always revert to a previously captured state. In this topic
you will learn how to create Baselines, and some of the
common business and technical purposes of the technique.
You will also learn to use the comparison tool, which allows
you to identify what has changed in the model since a
Baseline (snapshot) was created. You can reverse changes
back to the Baseline state at any level of granularity. This
will be indispensable when working with Project Teams
using conventional or agile techniques, or, where there are
important governance or contractual requirements to
manage change.

Current Repository or Reusable Asset Service

Baselines can be stored in the same repository in which the
source Packages are located. They can also be stored in a
Reusable Asset Service (RAS), and made accessible to users
working on other repositories that have access, via a Pro
Cloud Service, to the RAS repository.

These topics discuss the management of Baselines,
including exploring the options and benefits of storing them
in the repository or, alternatively, in a Reusable Asset
Service (RAS).
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Brief Introduction
Baselines are easy to set up and require only a small amount
of meta-data, such as the Version Number and some Notes
that are pre-filled with the time and date the Baseline was
created. You can add your own comments such as 'After
Requirements Sign-Off' to indicate the significance of a
milestone or reason for the Baseline.

The basic steps in working with Baselines are:

Create a Baseline - this will be for a selected Package and1.
optionally its child Packages.

Compare the model to the selected Baseline - there can be2.
multiple Baselines of the same Package.

Revert the model to one or more Baseline items - or3.
choose to ignore the differences.

It is important to understand a fundamental difference
between Baselines and Version Control. Baselines are
user-initiated, so if a user has not created a Baseline for a
given Package at a previous time it is not possible to
compare the model to an earlier 'version'. However, once
Version Control is set up for a Package, any changes that are
made to the Package will be automatically versioned and
will be available at a later time. These two facilities can be
used in conjunction and it would be the responsibility of a
Librarian or Administrator to determine how best to use
them together.

Baselines are stored in the same XML format as is used for
Version Control, but are stored in compressed format either
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within the project or in a Reusable Asset Service Registry.
By default, Baselines are stored within the model; you can
save a Baseline to an external XML file for storage or
archive, or for distributing to other users working on models
derived from a master project.

Creating Baseline

With a Package selected in the Browser window, choose the
'Create Baseline' option to create a new Baseline of the
selected Package. You will be required to complete some
details for the Baseline, as indicated:

New Baseline window showing details entered when
creating a Baseline, including the version number.

Version - a user defined version number used to identify·

the Baseline when running comparisons

Include sub-packages - choose whether to Baseline·

subordinate Packages as well as the main Package

Notes - used to describe the Baseline; e.g. 'Requirements·

Sign-Off' pre-filled with the Baseline time and date

Comparing to the Model
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The management of baselines makes use of the comparison
tool and presents a tabular presentation of the differences.
The comparison tool shows the differences between the
elements, their properties and features, relationships or
visual changes in diagrams at the current time and the time
of the baseline or model export. A tree view presents the
comparison items and can be used to navigate through the
changes which are presented on the panel on the right hand
side.

Reverting to Baselines

Once the comparison (differencing) is complete, you can
revert changes by merging information from the Baseline
into the current project; it is not possible to go the other
way.

You can:

Merge information manually, change by change·

Merge information automatically by electing to merge in·

all changes in one batch procedure

Revert completely to the original Baseline by importing·

the stored XMI directly

Merge information and elements from a Baseline in a·

different project, making it possible to keep multiple
versions of a single model in synch

The merge options are available through the toolbar, context
menus and the keyboard on the 'Compare Utility' view,
which shows the results of a comparison.
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Visual Differencing

Changes to a model might include:

Adding or removing or changing elements and connectors·

on a diagram, or

Changing the position of elements or the overall layout of·

a diagram

You might believe that a diagram has changed, and select to
compare it with a baseline using a ribbon option.
Alternatively, you might perform a baseline comparison on
a Package or a model and select from the comparison output
any diagrams that are flagged as changed.

Visual (diagram) differences for a number of existing and
new requirement elements.
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Creating Baselines
This topic details the basics of creating new Baselines of
model Packages. You can create Baselines in the model
(using the 'Baselines' dialog) or in a Reusable Asset Service
Registry (using the 'Reusable Asset Service - Baseline'
view). The appropriate screen displays by default according
to whether the 'Store Package Baselines in a Reusable Asset
Service Registry' checkbox is selected on the 'Baselines'
page of the 'Manage Model Options' dialog.

Access

Select a Package in the Browser window, then open the
appropriate screen for the storage system using one of the
methods outlined here.

Ribbon Design > Package > Manage > Manage
Baselines : 'Baselines' dialog : New
Baseline (or)
Design > Package > Manage > Manage
Baselines : 'Reusable Asset Service -
Baseline' view : New

Keyboard
Shortcuts

Ctrl+Alt+B : 'Baselines' dialog > New
Baseline (or)
Ctrl+Alt+B : 'Reusable Asset Service -
Baseline' view : New
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Create a new baseline

Field Action

Name Display the Package name of the
currently selected model branch.

Version Type a unique version reference for this
Baseline, which can consist of any
alphanumeric characters.
The 'Package Baselines' dialog sorts the
Baselines according to the value of this
field.

Include
sub-Packages

Include the entire sub-Package hierarchy
of this branch in the Baseline; this option
defaults to selected.
If you deselect the checkbox, only the
immediate contents (XMI stubs) of the
Package are included in the Baseline.

Note Edit the default current time and date to
any other value.
The field is a single-line entry, for display
on the 'Package Baselines' dialog (a
one-line-per-entry list).
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OK Click to create a new Baseline and return
to the 'Package Baselines' dialog.
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Compare a Model to Baselines
A Baseline is created with an intention that it could be
required as a backup or point of reference at some time in
the future, so that a model that has changed can be
compared with the snapshot and differences determined.
This might be required just to identify that differences exist,
or so that the entire Package or individual changes can be
rolled back to the state contained in the Baseline (snapshot).

The first step in this process is to locate the required
Baseline and then to identify the differences. The Baseline
Comparison tool can be used to visualize the changes that
have occurred between the time of the Baseline and the
current time. Individual changes are not recorded as they are
in the auditing facility, but rather the accumulative results of
the changes are presented.

Find Baselines

You can locate the Baselines for a model by selecting a
Package in the Browser and then opening the Manage
Baselines window. In the event that you have forgotten or
are unsure of the location of one or more Baselines you can
use the Model Search utility to locate all Packages that have
Baselines. The window conveniently displays the name of
the Package and the Baseline Version, Date and Notes.
From this window you can locate the Package in the
Browser window and then launch the Manage Baselines
window.
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The Compare Utility (Diff)
Enterprise Architect has a comprehensive built-in Compare
(diff) utility, which enables you to:

Explore what has changed within a model over time·

Explore how previous versions of a model branch differ·

from what is currently in the model

Perform a full model comparison by exporting all of·

Model A to XMI, then using 'Compare Model to File'
from within the current model (Model B)

Comparing and checking model development at various
points in the process is an important aspect of managing
change and development, monitoring what is being modified
and ensuring the development and design process is on
track.

Using the Compare Utility you can Compare a model
branch in Enterprise Architect with:

A Baseline created using the Baseline functionality·

(Corporate, Unified and Ultimate Editions)

A  Baseline stored in a different model·

An XML 1.1 file created previously using the Enterprise·

Architect XML export facility (user selects file)

The current version-controlled XMI 1.1 file as created·

when using Version Control in Enterprise Architect (file
automatically selected)
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Access

Select a Package in the Browser window, then open the
'Baselines' dialog or 'Reusable Asset Service - Baseline'
view (depending on whether Baselines are stored in model
or in a Registry) using one of the methods outlined here.

Ribbon Publish > Model Exchange > Package
Control > Compare Package to XMI
Design > Package > Manage > Manage
Baselines : Show Differences ('Baselines'
dialog)
Design > Package > Manage > Manage
Baselines : Compare ('Reusable Asset
Service - Baseline' view)

Keyboard
Shortcuts

Ctrl+Alt+B : Show Differences
('Baselines' dialog)
Ctrl+Alt+B  : Compare ('Reusable Asset
Service - Baseline' view)

Differencing With Baselines

As a Baseline contains all information about elements and
connections for a Package at a point in time, it can be used
within Enterprise Architect to track changes to model
elements over time.
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The Differencing engine first builds a representation of the
current Package in memory, based on what is currently in
the model.

It then compares this with the stored Baseline, highlighting
changes, new elements, missing elements and elements that
have been moved to other Packages.

It is possible to filter the resultant output to display only one
particular kind of change: for example, additions to the
model.

If a Baseline has been created to ignore child Package
content, a comparison between that Baseline and the model
does not include any child Package content in the model.

See the example provided in the Example Comparison Help
topic.

Notes

This utility is available in the Professional, Corporate,·

Unified and Ultimate Editions of Enterprise Architect

You cannot compare the current model with an XMI 2.1·

file; the utility can only compare with an XMI 1.1 file
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Compare Options
You use the 'Baseline Compare Options' dialog to refine the
output of the Compare utility when it compares the current
model with a Baseline.

To display the dialog, either:

Click on the Options button on the 'Package Baselines'·

dialog, or

Click on the 'Compare Options' icon in the 'Compare·

Utility' view toolbar

If the 'Compare Utility' view shows the results of a Baseline
comparison, when you click on the OK button the display
refreshes to refine the information according to the options
you have selected.

Options

Option Action

Always
Expand to
Differences

Always display the list of elements fully
expanded to show changes.
If you deselect the checkbox, when the
'Compare Utility' view is first opened it
lists the Package contents to element
level, and you expand each element as
required to show the changed items.
For large branches of the model, it is
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better to leave the checkbox unselected.

Show
Elements that
are

List elements that:
Have been changed since the Baseline·

was created
Are in the Baseline only (that is, have·

been deleted from the model since the
Baseline was created)
Are in the model only (that is, have·

been created since the Baseline was
created)
Have not changed since the Baseline·

was created (you might generally leave
this checkbox unselected)

Suppress
these
Changes

Exclude:
Changes to diagrams·

Changes to the 'Date Modified' field for·

an item
Changes to the 'Date Created' field for·

an item
Child items of a deleted item·

Changes to advanced properties·

(defaults to selected)
Changes to the 'Author' field for an·

item

Baseline Select the checkbox to always open the
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Diagram
Compare
Option

first parent Package for which there is a
Baseline, when you select the diagram for
comparison from the Browser window.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Compare To Package In Another
Model
Using the built-in Compare utility, it is possible to
determine what has changed in a package in the current
Enterprise Architect project against the same package
(having the same package GUID) in a different Enterprise
Architect project. The target Enterprise Architect project can
be file-based (.qea, .feap or .eap/.eapx files), DBMS Server
based ( such as MySQL, SQL Server, Oracle ) or a Cloud
based repository.

Access

Select a Package in the Browser window and then using the
ribbon menu, open the 'Select Model' dialog.

Ribbon Publish > Model Exchange > Package
Control > (Compare) Package to Model

Options

Field/Button Action

Package Displays the name of the
currently-selected Package.
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If this is not the required Package, click
on the Browse package button and select
the correct Package.

Location Click on this button to specify details of
the target Enterprise Architect project.
Click on the drop-down arrow and select:
-  Local File - the file browser dialog
displays and allows locating/selecting an
existing .QEA, .QEAX, .EAP, .EAPX or
.FEAP file
-  Server Connection - click on the
drop-down arrow and select:

'Native Connection' - the 'Open Server·

Connection' dialog displays
'ODBC Connection Wizard' - the·

Windows 'Data Link Properties' dialog
displays; you can also use this method
to define the repository connection

-  Connect to Cloud - the  'Cloud
Connection' dialog displays, on which
you specify the server URL and model
name to access via the Cloud.

Model Displays the selected target Enterprise
Architect project path/connection details

Name Displays name of the selected target
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Enterprise Architect project

Type Displays connection type of target
Enterprise Architect project .i.e., whether:

Local File·

Native Connection·

ODBC Connection·

Cloud Connection·

OK Click on this button to connect to the
target Enterprise Architect project and
compare the selected Package in the
current model with that in the target
project
Note:  If the package (with the same
GUID) does not exist in the target
project, the comparison window will
indicate that an error has occurred and the
message "Package <packageName> does
not exist in the selected model" will be
displayed in the System Output window.

Cancel Click on this button to close this dialog
without any further action

Help Click on this button to display this Help
topic
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Example Comparison
This diagram shows the result of a comparison between a
Package (Log in/out Use Cases) in the current project and
that Package in a Baseline captured at an earlier date.

The results of the comparison are displayed on the
'Comparison Utility' view.

Review Changes

Aspect Description

Interpretation A hierarchy of model elements is
displayed in the left-hand pane.
From the triangle-based icons and the
highlighted lines on the report, it is
clearly visible which items in the
hierarchy have, since the Baseline was
captured, been:
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Changed·

Deleted from the model (in the·

Baseline only)
Added to the model (in the Model·

only) or
Switched to different Packages·

(changes in the Parent Package
property)

If you click on an item in the left hand
pane, the right-hand pane displays a table
of properties showing the values of those
properties in the current model and in the
Baseline.
For each property where there is a
difference between the model and the
Baseline, the row is highlighted.
The 'Compare Utility' view enables you
to perform operations (such as merging or
rolling back changes) on the reported
information, using the toolbar, context
menu and keyboard.

Increase
Level of
Detail

The right panel of the 'Compare Utility'
view might, for some fields, display only
part of the value.
It might also not be immediately obvious
what a change is.
In either case, you can double-click on
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the property to display full details and to
highlight the exact differences; this
example shows the highlighted changes
to the 'Name' property.

Notes

The Compare utility is available in the Professional,·

Corporate, Unified and Ultimate Editions of Enterprise
Architect
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Compare Utility View Options
The 'Comparison Utility' view enables you to perform
operations on the reported information, using the toolbar,
context menu, 'Merge' dialog and certain keyboard keys.

The toolbar is at the top of the left-hand panel; the icons·

operate either on the comparison as a whole or on the
currently-selected item in the left hand panel of the
'Comparison Utility' view

Each item in the hierarchy has a context menu, which you·

display by right-clicking on the item; the options
displayed depend on the level of the item in the hierarchy

The 'Merge' dialog enables you to specify which changes·

to roll back in the model from the baseline

You can use a selection of keyboard keys to move up and·

down the hierarchy, or to roll back changes

Toolbar Options

Option Action

Refresh Re-run the comparison to refresh the
current display.

Merge To
Model

Merge the values of the
currently-selected item in the Baseline
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back into the model.

Next Change Highlight the next changed item (this
skips Moved items).

Previous
Change

Highlight the previously-changed item.

Expand All Fully expand the selected item.

Collapse All Collapse the changed items in the
selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only (in the event that you
have selected to also show unchanged
items in the comparison).

Find in
Project
Browser

Highlight the item in the Browser
window.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Compare
Options

Display the 'Baseline Compare Options'
dialog.
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Manage
Package
Baselines

Re-display the 'Package Baselines' dialog
or 'Reusable Asset Service - Baseline'
view, as appropriate.

Help Display the Help topic Package
Baselines.

Context Menu Options

Option Action

Merge from
Baseline
Add from
Baseline

Restore the item in the model to the
Baseline state, or restore a deleted item
from the Baseline.

Delete from
Model

Remove a recently-created item from the
model.

Merge From
Baseline
(with
Options)

(For the root node of the hierarchy on the
'Compare Utility' view.)
Display the 'Merge' dialog, which you
can use to specify options for rolling back
the whole model branch to the Baseline
state.
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Refresh (Object-level items.)
Re-run the comparison to refresh the
current display.

Find in
Project
Browser

Locate and highlight the item in the
Browser window.

Open
Baseline
Diagram
Compare

(For a diagram listed in the comparison.)
Display the Baseline Diagram Compare
window, showing differences in diagram
content and layout.

Expand All Fully expand the selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only.

Collapse All Collapse the changed items in the
selected item.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Baseline
Compare

Display the 'Baseline Compare Options'
dialog.
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Options

Merge Dialog Options

Option Action

Changed Restore all changed items in the model
branch to the Baseline state.

In Baseline
Only

Restore all deleted items to the model
branch from the Baseline.

In Model
Only

Remove all recently-created items from
the model branch.

Moved Restore all moved items to their original
locations, as identified in the Baseline.

Full Restore
from XMI

Completely restore the model branch to
the version held in the Baseline XMI 1.1
file, (using the 'XMI Import' function).
(This option automatically selects all the
other options)

Keyboard Keys
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Ctrl+ ↓ - expand and highlight the next changed item·

Ctrl+ ↑ - expand and highlight the previous changed item·

Ctrl+ ← - undo the changes for a selected item (roll back·

to the Baseline values)
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Visual Diagram Changes
The Baseline Diagram Compare feature is a quick and easy
way to visually compare a current diagram with an earlier
version from a saved Baseline, and highlight any elements
in the diagram that have been added, deleted, resized or
moved.

You can then review these changes and optionally roll back
individual changes if needed to their previous state from the
Baseline.

The changes are identified on the 'Baseline Diagram
Compare' dialog and on the diagram itself.

Access

Select the diagram to be checked, then apply one of these
access methods:

Ribbon Design > Diagram > Manage > Compare
to Baseline (on an open diagram)

Other Perform a comparison of a Package1.
and Baseline (see The Compare Utility
(Diff) Help topic).
Locate the diagram in the results on the2.
'Baseline Comparison' view.
Right-click on the diagram name and3.
select the 'Compare to Baseline' option
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to display the 'Baseline Diagram
Compare' dialog and to open the
diagram (refer to the Results section).

Multiple Owner Packages

When you create a Baseline, it can be for a Package that
contains one or more levels of child Package, and you might
create Baselines for the Package(s) at each level. If the
diagram you are checking is at a lower level in the
hierarchy, there might therefore be a number of Baselines
that contain information on the diagram, perhaps taken at
different times and capturing different changes to the
diagram.

When you open the diagram before performing the check,
and select one of the direct ribbon access paths, if the
diagram is referenced in multiple Baselines you might be
required to select the Package from which to use a Baseline,
on the 'Load Baselines from Package' dialog.
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The 'Load Baselines from Package' dialog provides the
facility to compare the diagram with one of a broader range
of Baselines than just those from the diagram's immediate
parent.

This dialog displays if you have NOT selected the 'Always
open first parent with a Baseline' checkbox on either:

The 'Load Baselines from Package' dialog itself or·

The 'Baseline Compare Options' dialog·

Selecting or deselecting the option in one location also
selects or deselects it in the other.

Click on the required Package, and click on the OK button.
In this case, or if the dialog did not display at all (the
checkboxes were selected), the 'Baselines dialog displays.

Processing
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Click on the required Baseline and on the Show Differences
button. The 'Baseline Diagram Compare' dialog displays.
Refer to the Results section and the Options table.

Results

The 'Baseline Diagram Compare' dialog shows the elements
that have been changed on the diagram, and what kind of
change was made (examine the 'Status' field).

As you select elements on the dialog, images are shown on
the diagram itself to indicate where the changed element
was and what kind of change it underwent.

Options

Option Detail

Select (click The 'Status' column indicates whether the
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on) name of
element

element has been:
Moved or re-sized (Changed)·

Deleted from the diagram (Baseline·

only)
Added to the diagram since the·

Baseline was captured (Model only), or
Deleted from its parent external·

Package, and there is no record in the
current Baseline (because the Baseline
is only for the current diagram's parent
Package)
This diagram-linked element has been
deleted from the model. The element
might be found in a different baseline
either in a parent Package baseline or a
different Package baseline outside of
the current Package. If the external
referenced element is restored to the
model, the visual comparison will be
able to resolve the missing diagram
object in the current baseline.

When an item is selected, the
corresponding element on the diagram is
highlighted as shown:

Deleted from the diagram·

Added to the diagram·
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Resized or moved to a new position·

A deleted external element on the·

diagram

The highlighted element on the diagram
is marked with a colored dot, as shown,
to indicate that it is in focus.

Position the
diagram to
show the
selected
element

To scroll the diagram so that you can see
the original (Baseline) position of an
element, double-click on the item in the
list.
To scroll the diagram so that you can see
the current (model) position of the
element, press and hold Ctrl while you
double-click on the item.

Leave the
changes in
the item as
they are

Ensure that the checkbox against the item
is not selected.
Click on the OK button.
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Roll the
changes back
to the
Baseline
position

Click on the checkbox against each
required item (or click on the Check All
button to select every item).
The 'Action' column displays the action
required to roll each element's
relationship to the diagram back to the
Baseline relationship, and on the diagram
the selected elements are represented as
shown:

This deleted element will be restored·

This added element will be removed·

This resized/repositioned element will·

be put back in its original position

This element from another Package,·

deleted from the diagram, cannot be
restored from this Baseline

The comparison automatically shows a
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blue direction arrow for each reposition
or resize that has been checked. For a
heavily edited diagram this might be
confusing. However, you can hide the
arrow for all elements except the one
currently in focus; to do this:

Deselect the 'Visually link new and old·

position for checked items' checkbox
To roll back the changes for all items for
which a checkbox is selected:

Click on the Apply button·

Notes

Diagram Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Revert Model to a Baseline
You can return any part of a model to the content stored in
the Baseline. This is a simple process of selecting the item
in the Baseline comparison tool and using the 'Merge to
Model' toolbar icon.

The 'Merge to Model' option for a selected Requirement
element.

The 'Merge to Model' option is useful when you or your
team identify unwanted changes that have been made to the
model since the Baseline was created. There could be items
such as elements, Features, Tagged Values, connectors and
diagram objects that have been:

Deleted·

Modified, or·

Created·

You will be warned that this option is not reversible, and if
changes are merged from the Baseline to the model the
changes to the model will be lost. Note that it is not possible
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to merge model changes to a Baseline, as the Baseline is a
snapshot and cannot be altered.
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Manage Baselines
Baselines are snapshots of a repository Package taken at a
point in time. These snapshots are stored in a format called
XMI, which is an XML format. These files must be stored
so that they can be recalled and used for comparisons at a
future time. There are two primary places to store Baselines:

In the current repository - this is the default location·

In a Reusable Asset Service - a Reusable Asset Service·

needs to be nominated as the location

Baselines are by default stored in the repository so when, for
example, you create a Baseline of a Requirements Package
at a given milestone, the 'snapshot' would by default be
stored in the same model as the Requirements. This type of
storage is practical and sufficient for small, isolated project
teams, but for larger teams and endeavors, Enterprise
Architect provides some mechanisms to store the Baselines
as reusable and universally accessible snapshots available to
any project or organizational team, anywhere in the world.
This reusable storage is particularly useful in this age of
innovation and agility, where geographically independent
teams need to share information and reuse existing assets at
Internet speed. The facility uses the Reusable Asset Server
(RAS), which is Cloud-based (including on the home
premises) and provides sophisticated mechanisms to manage
these valuable corporate assets.

Management of the Baselines differs depending on the
option selected. A librarian or administrator typically
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decides which option is most appropriate for a given
repository and team. Factors such as whether the Baselines
need to be made available to a distributed audience and
whether dependency analysis is required would be
considerations in this decision.

Access

Ribbon Settings > Model > Options > Baseline

Specify Reusable Assert Server for Baselines

To store baselines in a Reusable Asset Server, you need to
define this on the 'Baseline' page of the 'Manage Model
Options' dialog, where you specify Cloud connection and
storage details and options.

(c) Sparx Systems 2025 Page  83 of 417



Manage Model Change 2 September, 2025

Manage Baselines in Model
When you manage baselines in the model, all of the
Baseline features are available through the Manage
Baselines window. As discussed in a prior topic, this is the
default way to work with baselines and the files themselves
are stored in compressed format inside the repository. This
ensures these baseline snapshots are available to all model
users who have the requisite permissions to manage the
baselines where security has been enabled.

Storing the baselines in the repository is much more
immediate and convenient, and is suitable for small teams
and situations where baselines are used in a cohesive team
environment. If these baselines are important assets that
need to be shared or managed by wider communities of
users, the Reusable Asset Server can be used to provide
access to distributed users.

Access

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B
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Baseline Management

Create, select and process Baselines using the 'Package
Baselines' dialog.

Option Action

Current
Baselines For
Package:
<Name>

Review the Baselines for the current
model branch, listed by version reference
with the highest alphabetical/numerical
value at the top.
If an entry is longer than the display area,
a horizontal scroll bar displays at the
bottom of the panel; use this to scroll to
the text that is not shown.

Show
Differences

Run the Compare utility on the selected
Baseline and the current model branch or
diagram, to display the differences
between the two.

Restore to
Baseline

Completely restore the model branch
from the selected Baseline.

New
Baseline

Create a new Baseline.

Delete
Selected

Delete the selected Baseline.
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Load Other
Baselines

Display a drop-down menu that enables
you to load Baselines from another
model, in either a project file or a DBMS
repository.

For project files, a browser displays;·

locate the required project file
For DBMS repositories, the Windows·

'Data Link Properties' dialog displays;
select the data provider and click on the
OK button to display the 'Select Data
Source' dialog, from which you select
the required project

In either case, the Connected To:
message at the bottom of the 'Package
Baselines' dialog changes to the name of
the alternative model.
To return the dialog to the original
project, select the third option on the drop
down list: 'Load From Selected Package'.

Import File Import an XML 1.1 file from the file
system as a new Baseline for this current
model branch.

Export File Export the selected Baseline to an XML
file.

Compare
Model to File

Compare the selected model branch with
an XML 1.1 file in the file management
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system; a browser displays, which you
use to locate the file.

Options Set filters to make the comparison more
specific.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Manage Baselines in Reusable Asset
Service
When you manage Baselines through the Reusable Asset
Server (RAS) all of the Baseline features are available but in
addition there are a range of other features only available
when using RAS baselines. As discussed in a prior topic the
baselines are available to a much wider audience, including
other teams and departments, customers, standards
authorities, partners, consultants, testers and more, all
protected by robust industry standard security. Baselines
stored in the RAS are more transparent and searchable,
making it easier to understand and work with the content
they contain.

Enterprise Architect provides a range of facilities for
working with and managing Baselines stored in a Reusable
Asset Service Registry, using the 'Reusable Asset Service -
Baseline' view. When you open this view, the 'Baseline
Browser' tab immediately displays a list of the Baselines
available for the Package that is currently selected in the
Browser window. You can review and use these Baselines
using the context menu and buttons on the tab.
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You can review the contents of the selected Baseline using
the tabs in the lower half of the 'Reusable Asset Service -
Baseline' view, underneath the 'Baseline Browser' tab.

If you have left the 'Baseline Browser' open for a while,
there is a possibility that the contents of the Storage in
Registry might have changed. Click on the  icon in the
'Reusable Asset Service - Baseline' toolbar to refresh the
Browser with the latest contents of the Storage.

Note: To store Baselines in a Reusable Asset Service
Registry, select the 'Baseline' page in the 'Manage Model
Options' dialog and configure the Cloud connection to the
Registry, then select or create the Storage in which to store
all the Baselines for the Packages in the model.
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Access

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Baseline Management

Create, select and process Baselines using the 'Reusable
Asset Service - Baseline' view.

Option Action

Registry Displays the Registry name, as specified
on the 'Baseline' page of the 'Manage
Model Options' dialog.

Storage Displays the Storage name, as defined on
the 'Baseline' page of the 'Manage Model
Options' dialog.

Package Displays the name of the Package
currently selected in the Browser
window.
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Find Other
Packages

Click on this button to open the 'Reusable
Asset Services' view, displaying the
Storage and its full contents; that is, all
Packages with Baselines, and any other
Packages held in the Storage.

Baseline
Browser

Lists the Baselines, if any, for the current
Package. The Baselines are listed by
version - with the highest alphabetical or
numerical value at the top.
When you select a Baseline in the
Browser, details of the Baseline are
displayed in the tabs beneath the
'Baseline Browser' tab.
Note: You can right-click on the column
headings and select the 'Toggle Filter Bar'
option to show or hide the Filter Bar on
the display. If you show the Filter Bar,
type in the appropriate characters to list
only those Baselines that have that string
of characters in the value in the
corresponding column.

New Click on this button to create a new
Baseline.
Note: You can also click on the  icon in
the 'Reusable Asset Service - Baseline'
toolbar to create a new Baseline.
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Compare Click on this button to run the Compare
utility on the selected Baseline and the
current Package, to display any
differences between the two. The results
of the comparison are displayed on the
'Comparison Utility' view.
Note:
You can also run the Compare utility by:

Clicking on the  icon in the 'Reusable·

Asset Service - Baseline' toolbar or
Right-clicking on the Baseline name·

and selecting the 'Compare' context
menu option

Restore Click on this button to completely restore
the Package in the model from the
selected Baseline.
Note:
You can also restore the Package from
the selected Baseline by:

Clicking on the  icon in the 'Reusable·

Asset Service - Baseline' toolbar
Right-clicking on the Baseline name·

and selecting the 'Restore' context
menu option

Run Check this option to automatically run the
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Compare
after Restore

Compare utility once the Package is
completely restored from the selected
Baseline.

Notes

The Package Baseline facilities are available in the·

Corporate, Unified and Ultimate Editions of Enterprise
Architect

Reusable Asset Service Registry details must be·

configured in the 'Baseline' page of the 'Manage Model
Options' dialog

If a 'Read-Only Access' password is entered for the·

Storage in the 'Baseline' page of the 'Manage Model
Options' dialog, you will not be able to create new
Baselines in the 'Reusable Asset Service - Baseline' view
as the 'New' button will be disabled

If security is enabled, you must have 'Baselines - Restore·

model' permission to restore a Package from the selected
Baseline
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Baseline Contents
In the 'Reusable Asset Service - Baseline' view, when you
select a Baseline in the 'Baseline Browser' tab, the three tabs
in the lower half of the view are updated with information
on the Baseline. The 'Contents' tab lists the diagrams and
elements (including any child Packages) held in the selected
Baseline, listing the two types of object separately. You can
organize the information within a column into alphabetical
or reverse-alphabetical order for ease of reference, and use
the Filter bar to filter the display to show only items with
values containing specific characters or digits.

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.

Select a Baseline in the 'Baseline Browser' tab, then click on
the 'Contents' tab to display the contents of that Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Review Baseline Contents
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Option Detail

Content Type Click on this button to toggle between
listing the Baseline diagrams first and
listing the Baseline elements first.

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

(filter bar
fields)

Type in the appropriate characters to list
only elements and diagrams that have that
string of characters in the values in the
corresponding column.

Content
Type:
Diagram
Content
Type:
Element

These are the headers for the two types of
object listed in this tab.
Click on the appropriate white or black
arrow head to hide or show the list of
diagrams or elements under the heading.

Name Displays the name of the element or
diagram available in the Baseline.

Type Displays the type of the element or
diagram, such as Use Case or Use Case
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diagram.

GUID Displays the Global Unique Identifier of
the element or diagram.

Content Type Displays the object type of the item -
Element or Diagram.

Find in
Project
Browser

Right-click on an element or diagram line
and select this option to see if the element
or diagram also exists in your model and,
if it does, to highlight it in the Browser
window.

View
Diagram

Right-click on a diagram name and select
this option to display the diagram within
a labeled frame, as an image.
Alternatively, double-click on the
diagram name.
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Baseline Dependencies
When you select a Baseline on the 'Baseline Browser' tab,
the three tabs in the lower half of the 'Reusable Asset
Service - Baseline' view are updated with information from
the Baseline. A Package might contain elements and
diagrams that have relationships with objects in other
Packages. When you generate a Baseline for that Package,
the name and Global Unique Identifier (GUID) of each
Package containing these 'external' objects will be stored
along with the Baseline and displayed in the 'Dependency'
tab.

Note that Package A depends on Package B if any of these
constructs (or their Tagged Values) in Package A reference
elements in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.

Select a Baseline on the 'Baseline Browser' tab, then click
on the 'Dependency' tab to display a list of dependencies for
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that Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Check Baseline Dependencies

Option Detail

Package Displays the name of the related Package.

GUID Displays the Global Unique Identifier of
the related Package.

Find in
Registry

Right-click on the 'Package' line and
select this option to see if the Package
exists in the Registry.
Selecting this option will :

Open the 'Reusable Asset Service' view·

Connect to the Registry and load the·

Storage that is currently selected in the
'Reusable Asset Service - Baseline'
view
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Open the 'Search Registry' dialog·

Search for the selected Package using·

its GUID and display the results of the
search, if any

Find in
Project
Browser

Right-click on the 'Package' line and
select this option to see if the Package
also exists in your model and, if it does,
to highlight it in the Browser window.

Copy
Package
Name to
Clipboard

Right-click on the 'Package' line and
select this option to copy the Package
name to the clipboard.

Copy
Package
GUID to
Clipboard

Right-click on the 'Package' line and
select this option to copy the Package
GUID to the clipboard.

Notes

The Name and Global Unique Identifier (GUID) of a·

Package containing 'external' objects will not be stored
with the Baselines if the option 'Check Package
dependency when creating Baseline' is disabled on the
'Baseline' page of the 'Manage Model Options' dialog
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Add Review Comments
When you select a Baseline on the 'Baseline Browser' tab,
the three tabs in the lower half of the 'Reusable Asset
Service - Baseline' view are updated with information from
the Baseline. For any Baseline, you can add individual
review comments on any aspect of the Baseline. These
comments provide a permanent record on the Baseline -
once they have been saved they cannot be edited or deleted.
Each comment is attributed to the ID of the user who
entered it, and is date stamped.

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.

Select a Baseline on the 'Baseline Browser' tab, then click
on the 'Review' tab to display the review comments of that
Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Actions
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Action Detail

Review
Existing
Comments

If there appears to be a longer comment
than can be shown in the 'Review' tab,
click on it. The full text displays in the
'Comments' field in the lower panel.

Create
Comments

Click on the New button and start typing
your comment on the Package in the
'Comments' field. You can delete and edit
text as you type.
When you have finished writing your
comment, click on the Save button. Your
comment, preceded by your user ID and
the current date, is displayed in the
'Review' panel.
Once you have saved your comment, you
cannot edit or delete it.
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More Information
Baselines in Enterprise Architect serve as snapshots of
specific parts of the repository at a particular moment in
time. They are used for later comparison and restoration if
needed.

When a Baseline is created, it captures a snapshot of a
model Package and its contents at that specific point in time.
This allows users to compare the current state of the model
with the baseline snapshot and revert to the previous
(baselined) state if necessary. Baselines can be created at the
Package level and can include child Packages. Users can
baseline any number of Packages, and a Package can be
baselined multiple times, typically at significant project
milestones.

By default, Baselines are conveniently stored within the
repository, accessible to users with the necessary security
privileges. Alternatively, Baselines can be stored in a
Cloud-based Reusable Asset Service for broader
accessibility and collaboration.

Edition Information

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect

The Compare utility (used to compare an exported·
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Package with a model Package) is available in the
Professional Edition of Enterprise Architect, as well as in
the Corporate, Unified and Ultimate Editions

The Enterprise Architect Corporate, Unified and Ultimate·

Editions provide another facility, Auditing, which you can
switch on to perform continuous monitoring of changes
across the project; you can dovetail your use of each
facility to meet the range of your change management
requirements

Considerations

Baselines are based on the Global Unique Identifier (GUID)
of a particular Package:

Enterprise Architect checks for that GUID as the root·

element within the XML document being used as a
Baseline

When you export a Package to XML, the Package you·

export is the root element; likewise when you create a
Baseline, the current Package is the root Package of the
XML Baseline

When you save information in a Version Control system,·

the current Version Controlled Package is again the root
Package of the document

It is not useful to create a Baseline by importing an XMI·

Package file created by Version Controlling a Package
that itself contains Version Controlled child Packages;
that type of XMI Package file contains stubs for the child
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Packages, not full information on the child Packages and
elements

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package

XML files must be in the same format used by the Baseline
engine - currently the UML 1.3 XMI 1.1 format (plus
Enterprise Architect extensions), which contains all the
information necessary to reconstruct a UML model, even a
UML 2.x model.

Notes

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package

You can also obtain a snapshot of selected items in the·

model, using the Model Views facility; this facility
enables you to automatically generate the snapshot at
intervals and, if there are changes in the items collected
by the defined search, to trigger a notification to you of
such changes, which enables you to monitor workflow
and other events of concern to you

If security is enabled you must have 'Baselines - Manage'·

permission to create, import and delete Baselines, and
'Baselines - Restore' permission to merge data from a
Baseline; security permissions are not required to select

(c) Sparx Systems 2025 Page 105 of 417



Manage Model Change 2 September, 2025

an existing Baseline and perform a comparison with the
model
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Reuseable Asset Service (RAS)
Within a large organization, groups of users can be
separated by geographical distance and be on different
networks. This can make it difficult to share common data,
standards and modeling structures, without the complexity
of using external Version Control tools or manually
distributing XMI files between projects. Enterprise
Architect supports a Reusable Asset Service (RAS) that
provides a simple and convenient mechanism for modelers
to distribute or download reusable model structures,
information, as well as corporate directives and standards.
The shared repository is accessible via a Pro Cloud Server
connection, making it accessible for distributed teams. The
person who sets up the reusable data can retain governance
of the resource or asset, whilst users of the service can easily
review the currency of the information and download the
latest versions into their models or file folders.

The RAS gives distributed teams convenient access to a
single 'source of truth' for shared data, including project
milestones, architectural frameworks and industry standards.

Reusable Assets

A Reusable Asset Storage is contained in a Pro Cloud
Server repository.

Reusable Assets can consist of:

Packages containing elements, diagrams and structures (as·

drawn from any point within the Browser window), and
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Learning Center topics·

Files in a range of text, code and graphic formats,·

including .qea and .eap files

An asset can be, for example:

A common Class library or framework·

The Baselines for a set of Packages or of the whole model·

A set of common Requirements or Use Cases·

A draft specification document·

Marketing collateral·

Storage Structure and Use

A Reusable Assets registry contains any number of
Storages, which can either be left unprotected for any user
to create, or change-restricted by an Administrator
password. Each Storage can contain any number of Asset
Packages holding modeling structures, and files containing
textual or graphical information and data. When a user
creates a Storage, they can protect the contents from being
updated in the Registry or downloaded into a model, using
password protection defined by that user.

For each Package, the RAS automatically identifies the:

Version of the Package held in the registry·

Diagrams and elements (including child Package·

elements) contained by the Asset Package

Dependencies on parent Packages of any external·

elements that the Asset Package references
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Dependencies on MDG Technologies·

Features

Here is an overview of the features available in the RAS.

Feature Description

Register
Assets

The assets that can be created include:
Packages - including diagrams and·

subordinate Packages
Baseline Packages·

Files·

Learning Center contents.·

Browse
Assets

Any user, regardless of password
protection, can freely browse and identify
the contents of a Package held in a
Storage - including displaying the
diagrams - without importing the material
into a model.

Import
Content

Any user with access to the Pro Cloud
Server repository and a password (if
required), can import an Asset into their
repository.

Dependencie
s

Any dependencies within a stored
Package are viewable, providing a quick
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means to visually see what the Asset
requires.

View
Diagrams

Any diagrams set in an Asset are logged
and can be viewed providing a quick
means to check and visually compare the
Asset diagrams against updates to
diagrams in the current model.

Compare Where a user that has imported an Asset
Package into their model, they can
compare their model Package against any
version of the Asset Package, to check for
and assess any differences between them.

Required
Technologies

For a Package Asset that has specific
Technologies these are displayed for
clarification of what is required on
importing the Asset.

Reviews Reviews and comments can be posted
against a Package.
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Set Up the Asset Service
The process of setting up assets and files in the Reusable
Asset Service has a number of simple stages, typically:

Identify the Registry·

Create the Storages, including copying an existing Storage·

as a template for a new one

Set password protection on each Storage·

Register the Asset Packages and Storage Files, and update·

them as necessary

Prerequisites

As a Reusable Asset Service is stored in a Pro Cloud Server
repository, there must be a Pro Cloud Server (PCS)
operating and a repository configured and enabled on this
PCS.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Identify the Repository
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A Reusable Asset Registry is contained in a PCS based
repository that is typically configured by a System
Administrator. If you have access to an existing PCS
repository then the connection details for that can used for
creating Reusable Asset Storage. Otherwise, if a new
repository needs to be created by a System Administrator,
they will provide the repository connection details for you to
use.

Ste
p

Action

1 If a new repository is required, then the System
Administrator creates a PCS based Repository to act
as the Reusable Asset Registry and then provides
you with the connection details like server and
model name.
If a PCS repository already exists and you have
access to it, then proceed to step 2.

2 In the Reusable Asset Service view, click on the 
button to the right of the 'Registry' field.
The 'Cloud Connection' dialog displays.
In the Cloud Connection dialog, type in the
connection details of the PCS repository:
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3 Click on the OK button.
The 'Registry' field now shows the Cloud
Connection name.

4 If required for security, set up a Registry Password.

Toolbar Options

Option Description

Option for creating a new storage as a
container within the Registry for holding
related assets and files.

Used for copying a Storage as the basis
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for creating another Storage.

Option for updating the Storage details.

Option for deleting a storage's entire
contents.
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Set Up Registry Password
As a System Administrator, you can password-protect the
Registry to prevent users from modifying the Registry; that
is, restrict users from performing top-level activities such as
creating, modifying and deleting Storages. Once you have
set password protection, only those users who have a valid
Administrator password can modify the Registry.

You can also change the password at regular intervals, for
added security.

Access

In order to set the Registry Administrator password:

In Enterprise Architect, open the Cloud model that is·

designated as the RAS Registry

Open the RAS window (Publish > Model Exchange >·

Reusable Assets)

The Set Administrator Password button is displayed next·

to the 'Registry' field
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Click on this button to display the 'Set Administrator·

Password' dialog

Set the Administrator Password

Option Detail

Enter old Disabled if no password exists for the
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password Registry.
If Registry has a current password, type it
in to this field.

New
password

Type in the new Administrator password.

Retype new Type in the new Administrator password,
for confirmation.

OK Click on this button to set the password
and close the dialog.

Cancel Click on this button to abort the changes
and close the dialog.

Notes

To remove password protection from the Registry,·

complete the 'Enter old password' field but leave the 'New
password' and 'Retype new' fields blank

If a Storage has a 'Complete Access' password, then you·

can use either the Administrator password or the
'Complete Access' password to modify the Storage
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Creating Asset Storages
A Storage is a container within the Registry, holding related
assets and files. There can be several Storages in the
Registry, to support the different areas of work or purposes
that your organization might define.

Create Storages

When creating a new Storage you have the option to set
what type of storage this is to be. The Storage types
available include:

Model Package -  contains Asset Packages and/or Files·

Learning Center Library - Learning Center Library·

content

Reference Data Library -  Enterprise Architect Reference·

Data Library

Source Code Library -  can be populated with any zipped·

files.

Ste
p

Action

1 Click on the  icon in the Reusable Asset Service
toolbar.

2 If necessary, enter the Administration password that
enables update access to the Registry. Click on the
OK button.
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The 'New Storage' dialog displays.

3 In the 'Name' field, type a name that indicates the
purpose or content of the Storage.

4 In the 'Content' field, select:
'Model Package' if the Storage should contain·

Asset Packages and/or Files
'Learning Center Library' if the Storage should·

contain only Enterprise Architect Learning Center
Library files - this Storage can be populated only
with Library files and not with Asset Packages
'Reference Data Library' if the Storage should·

contain only Enterprise Architect Reference Data
Library files - this Storage can be populated only
with Library files and not with Asset Packages
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'Source Code Library' if the Storage should·

contain only Source Code Library files - this
Storage can be populated only with Library files
and not with Asset Packages

5 If you have selected 'Model Package' in the 'Content'
field, then in the 'Status' field select:

'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can also overwrite
existing Packages or files in the Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in the
Storage, although you can delete Packages and
files and add new ones

You can modify a 'Model Package' Storage at a later
time, and change this 'Status' setting (see the Change
Storage Details section in this topic).
Storage whose Content is 'Learning Center Library',
'Reference Data Library' or 'Source Code Library'
will always be of 'Draft' Status - you can overwrite
existing Library files in these Storages.

6 If you want to set Storage Access passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
'Complete Access' and/or 'Read-Only Access'
passwords.
For more details, see the Storage Access Passwords
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section in this topic.

7 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK
button.
The name of the new Storage displays in the
'Storage' field.

Storage Access Passwords

The Registry can be protected by a Registry password, so
that only the Administrator can create and modify Storages.
If no Registry password is set, a second level of password
protection can be applied.

The owner of a Storage can apply password protection to
restrict users in processing and modifying the contents of
the Storage either intentionally or unintentionally. Password
protection can be applied at two levels:

Complete Access - users enter their password and can·

modify or delete the Storage itself, and within the Storage
can register, update and delete Packages and files in the
Registry, view Packages and import assets into their
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models

Read-Only Access - users enter their password and can·

import assets into their models

You set the 'Complete Access' password before you set the
'Read-Only Access' password.

If password protection is set and a user has no password,
they can only view the contents of the Storage. If no
password protection is set, all users can freely access and
modify the Storage and its contents.

You set the passwords on each Storage as you create that
Storage, using the 'New Storage' dialog. Once the Storage
has been created, you can change or remove an existing
password using the 'Modify Storage Access' dialog, but you
cannot add a password.

If a Storage is password protected, the system displays a
prompt for the password when the user begins to:

Change or delete a password on the Storage·

Copy the Storage to create a new Storage·

Delete the Storage·

Register a Package or file in the Storage·

Import a Package, file or Technology from the Storage·

Delete a Package or file from the Storage·

Compare an Asset Package with a Package in the model·

The system displays the password prompt when any of those
operations is performed for the first time after the user:

Connects to a Registry·

Reloads the Registry Browser·
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Selects a Storage in the 'Storage' field in the Reusable·

Asset Services view

If the user enters the correct password and therefore
establishes their credentials, the system does not display a
password prompt again for any valid operation that user
performs until they:

Select a different Storage in the 'Storage' field in the·

Reusable Asset Services view or

Reload the Registry Browser from the Registry·

Register Assets and Files

Whilst a Storage exists and, if the Storage is under password
protection, and you have the 'Complete Access' password,
you can register Packages from a model and files from your
system as assets in that Storage. If the Asset Package was
developed using one or more MDG Technologies, you can
optionally register those technologies in the Storage as well.

See the Register New Assets Help topic.
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Copying Asset Storages
It is possible to copy a Storage as the basis for creating
another Storage, for example if you want to use the same set
of assets in the context of a larger set for a different
department, work area or development phase.

Note: It is not possible to change the 'Content' of a Storage
nor is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code Library'
Storage.

Copy Storages

To copy a Storage, follow these steps.

Ste
p

Action

1 In the 'Storage' field, select the Storage to be copied.

2 Click on the  icon in the Reusable Asset Service
toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Save Storage As' dialog displays.
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4 In the 'Name' field, type a name that indicates the
purpose or content of the new Storage.

5 If 'Model Package' is selected in the 'Content' field,
then in the 'Status' field select:

'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing
Packages or files in the Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in the
Storage, although you can delete Packages and
files and add new ones

You can modify a 'Model Package' Storage at a later
time, and change this 'Status' setting (see the Change
Storage Details section in this topic).

6 If you want to set Storage Access Passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
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'Complete Access' and/or 'Read-Only Access'
passwords.

7 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK
button.
The name of the new Storage displays in the
'Storage' field.
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Change Storage Details
After you have set up a Storage, you can update it at a later
stage to:

Change the status of a 'Model Package' Storage·

Change one or both of the existing 'Complete Access' and·

'Read-Only' Access passwords

Delete one or both of the passwords·

Note: there are restrictions in that:

It is not possible to add a password where one has not·

previously been set.

You cannot change or delete passwords unless you have·

the 'Complete Access' password yourself.

It is not possible to change the 'Content' of a Storage nor·

is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code
Library' Storage.

Process

Ste
p

Action

1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to update.
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2 Click on the  icon in the Reusable Asset Service
view toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Modify Storage Access' dialog displays.

4 If 'Model Package' is selected in the 'Content' field,
then in the 'Status' field select:

'Complete' if the Storage has now been set up and·

is ready for use; you cannot overwrite any
Packages or files in the Storage, although you can
delete them and add new Packages and files
'Draft' if you intend to make significant changes to·

the content of the Storage; you can overwrite
existing Packages or files

5 The 'Action' field defaults to 'None', to indicate no
changes to the passwords. If you are changing or
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deleting the passwords, click on the drop-down field
and select:

'Change Password' to enable both password type·

fields ready for editing
'Remove Storage Access Password' to simply·

delete the 'Complete Access' password altogether
'Remove Read-Only Access Password' to simply·

delete the 'Read-Only Access' password altogether

6 If you have selected the 'Change Password' option,
select the appropriate password checkbox or both
checkboxes, and type in the new password(s).
Re-type the password(s) in the 'Confirm Password'
field(s).

7 Click on the OK button to save your changes and

(c) Sparx Systems 2025 Page 129 of 417



Manage Model Change 2 September, 2025

close the 'Modify Storage Access' dialog.
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Delete a Storage
If a Storage has been created by mistake, or is no longer
necessary in the Registry, you can delete it and its entire
contents of Package and files in one action.

Process

Ste
p

Action

1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to delete.

2 Click on the  icon in the Reusable Asset Service
view toolbar.
A prompt displays to confirm the deletion.

3 Click on the Yes button.
If necessary, enter the Adminstrator password or
your 'Complete Access' password and click on the
OK button.
A message displays to confirm that the Storage has
been deleted.

4 Click on the OK button to clear the message.
The Storage and its contents are cleared from the
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Registry.
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Connect to the Asset Service
The Reusable Asset Service provides model structures and
documents to you from one or more registries on remote
systems. You access these registries through a Pro Cloud
Server connection to the appropriate server. The connection
details should be provided to you by your System
Administrator or Reusable Asset Service Administrator.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Connect to Assets
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Option Detail

Registry This field normally defaults to the
last-used registry name. If the field is
empty, or if you want to switch to a
different registry, click on the  button
to the right of the field.
The 'Cloud Connection' dialog displays.
Using the information provided by your
administrator, type in the Protocol, the
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server name, the Port and the name of the
model hosting the registry data.

For example, if you wanted to download
the UBL Frameworks into your model,
you would specify the server
'sparxcloud.com' and the model name
'modelpatterns'.

If advised by your Administrator, type in
the user name and password for the
server.
Click on the OK button; the 'Registry'
field now shows the server name.
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Note:
If no Registry is available,·

Administrator can create a Cloud-based
Repository to act as the Reusable Asset
Registry

Storage If there is more than one Storage
available in the Registry, this field
defaults to the first listed in the Registry.
To check for or select other Storages,
click on the drop-down arrow at the right
of the field. Click on the Storage to
review. For example, if you were
downloading UBL frameworks, you
would select 'UBL' in the list.
The 'Registry Browser' tab displays the
Packages registered in the selected
Storage.

Notes

The Reusable Asset Service is available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Browse Assets
When you select a Storage in the Reusable Asset Service,
the 'Registry Browser' tab immediately displays a list of the
Packages registered in that Storage. You can review and use
these Packages using the context menu and buttons on the
tab.

You can review the properties and contents of the selected
Package in the Storage, and access any files in the Storage,
using the tabs in the lower half of the Reusable Asset
Service view, underneath the 'Registry Browser' tab.

If you have left the Registry Browser open for a while and
there is a possibility that the Registry has been changed, you
can click on the  icon in the Reusable Asset Service
toolbar to refresh the Browser with the latest contents of the
Registry.

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Review Assets

Option Detail
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Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

(filter bar
fields)

Type in the appropriate characters to list
only Packages that have that string of
characters in the values in the
corresponding column.

Package This column shows the name of the
Packages held in the selected Storage.

Version This column defaults to the most recent
version of each Package held in the
selected Storage.
You can click on the drop-down arrow at
the end of a field and select a different
version of the corresponding Package, if
any have been registered.

Last
Registered

This column shows the date and time at
which the currently-listed version of each
Package was registered.

Registered
By

This column shows the user name of the
person who registered the currently-listed
version of each Package.
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Import Click on a Package name and click on
this button to begin to import either the
Package alone or the Package and its
dependent structures into your model.
You can perform the same action by
right-clicking on the Package name and
selecting the 'Import from Registry' menu
option.
If the Package from the Registry already
exists in your model, it is deleted and
replaced by this import.
For a:

'Learning Center Library' Storage, the·

'Download Library' dialog displays
'Reference Data Library' Storage, the·

'Import Reference Data' dialog displays
'Source Code Library' Storage, the·

'Save As' dialog displays

Compare
with Package
in Model

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the 'Registry Browser'
tab and select this option to compare the
imported Package with the Registry
version, and show any differences.
The system automatically selects the
model Package from the Browser
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window.

Find in
Project
Browser

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the Registry Browser
and select this option to highlight the
corresponding Package in the Browser
window.

Notes

Some of the other options available on the Registry·

Browser are used to set up assets in the Registry

If the Storage is password-protected, a prompt for you to·

enter a password displays when you select to perform an
operation on the data; in this situation, you need the
'Read-only' password to process the information from the
Storage, and the 'All-access' password to change the
information in the Storage

The 'Registry Browser' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage - the contents of these types of
Storage will be available in the 'Storage Files' tab of the
Reusable Asset Service view
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Asset Properties
When you select a Storage and a Package in the 'Registry
Browser' tab, the first four tabs in the lower half of the
Reusable Asset Service view are updated with information
from the Package. The 'Asset Properties' tab is a read-only
view of the properties of the selected Package itself.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Asset Properties' tab to
display properties for that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Properties

Field Detail

Package Displays the name of the selected
Package.

GUID Displays the Global Unique Identifier of
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the Package.

Version Displays the version reference (such as
1.1 or Beta) of the Package.

Author Displays the user ID of the person who
created the Package (the Package
Author).

Created Displays the date and time at which the
selected version of the Package was
created (that is, registered) in the
Registry.

Modified Displays the date and time at which the
selected version of the Package was last
modified (that is, re-registered) in the
Registry.

Comments Displays any comment recorded against
the Package when it was registered in the
Storage.

Notes Displays the notes recorded against the
Package when it was registered in the
Storage.
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Notes

The 'Asset Properties' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' and 'Source
Code Library' type Storage
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Package Contents
When you select a Storage and a Package in the 'Registry
Browser', the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the
Package. The 'Contents' tab lists the diagrams and elements
(including child Packages) held in the selected Package,
listing the two types of object separately. You can organize
the information within a column into alphabetical or
reverse-alphabetical order for ease of reference, and use the
Filter bar to filter the display to show only items with values
containing specific characters or digits.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Contents' tab, to display
the contents of that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Contents

Option Detail
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Content Type Click on this button to toggle between
listing the Package diagrams first and
listing the Package elements first.

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

<filter bar
fields>

Type in the appropriate characters to list
only elements and diagrams that have that
string of characters in the values in the
corresponding column.

Content
Type:
Diagram
Content
Type:
Element

These are the headers for the two types of
object listed in this tab.
Click on the appropriate expansion box to
hide or show the list of diagrams or
elements under the heading.

Name Displays the name of the element or
diagram available in the Package.

Type Displays the type of the element or
diagram, such as UseCase or Use Case
diagram.

GUID Displays the Global Unique Identifier of
the element or diagram.
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Content Type Displays the object type of the item -
Element or Diagram.

Find in
Project
Browser

Right-click on an element or diagram line
and select this option to see if the element
or diagram also exists in your model and,
if it does, to highlight it in the Browser
window.

View
Diagram

Right-click on a diagram name and select
this option to display the diagram within
a labeled frame, as an image in a separate
window. The image is displayed at the
default zoom level for the model.
Alternatively, to view the diagram,
double-click on the diagram name.

Notes

The 'Contents' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Dependencies
A Package held as an asset in the Reusable Asset Service
registry might contain elements and diagrams that have
relationships with objects in other Packages. The Packages
containing these 'external' objects will also have been added
to the Registry to support the first Package, and will be
listed in the 'Registry Browser' tab along with other
(unrelated) Packages. You can establish whether the
selected Package in the 'Registry Browser' tab has links to
other Packages in the Registry, and which they are, by
reviewing the 'Dependency' tab.

Package A depends on Package B if any of these constructs
(or their Tagged Values) in Package A references elements
in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Dependency' tab, to
display a list of Dependencies for that Package.
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Ribbon Publish > Model Exchange > Reusable
Assets

Check Package Dependencies

Option Detail

Package Displays the name of the related Package.

Version Displays the latest registered version of
the related Package that has links to the
selected Package.

GUID Displays the Global Unique Identifier of
the related Package.

Find in
Project
Browser

Right-click on the 'Package' line and
select this option to see if the Package
also exists in your model and, if it does,
to highlight it in the Browser window.

Notes

If one Package depends on another, and that second·
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Package itself depends on another Package, both the
second and third Packages are shown in the 'Dependency'
tab

The 'Dependency' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Technologies
It is possible that the asset Package in the Registry is
associated with one or more Technologies, especially if the
Package comes from a model developed as an extension or
customization of the UML. You can check whether an asset
Package has any associated Technologies, and what they
are, by viewing the 'Technology' tab of the Reusable Asset
Service view.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Technology' tab, to
display a list of Technologies required to support that
Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Technologies

Option Detail

Name Displays the name of the Technology as
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recorded in the Registry.

Version Displays the required version of the
Technology to support the asset Package,
available through the Registry.

ID Displays the unique identifier of the
Technology.

Type Identifies whether the Technology is
system-supplied and built in to Enterprise
Architect (such as BPMN 2.0 or ArcGIS),
or user-defined.
A user-defined technology can be
introduced from an external source or
developed by a user within the system.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable:·

     -  The Technology file is not
registered in the Storage, or
     -  The Technology is a built-in
Technology and is already integrated
         with your system, or must be
purchased under license, or
     -  The Technology is available from
a URL and can be downloaded
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         from that URL

Import
Technology

If your local system does not have one of
the Available Technologies, you can
quickly import it from the Registry.

Right-click on the Technology name1.
and select the 'Import Technology'
option.
A prompt displays for you to confirm2.
the import to your system; click on the
Yes button.
A message displays to confirm that the3.
Technology has been imported; click
on the OK button.

You might have to restart Enterprise
Architect to activate the Technology.
Other than the remote Technologies, you
cannot import a Technology flagged as
'Unavailable'. You can import a remote
Technology from its URL site.

Notes

You can also import Available Technologies from the·

registry as part of the process of importing the asset
Package

If the Storage is password protected, a prompt to enter·
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your password displays (this can be a Read-Only or a
Complete Access password) after you confirm that you
want to import the Technology; you cannot import the
Technology without this password

The 'Technology' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Storage Files
The 'Storage Files' tab of the Reusable Asset Service view
simply lists the files that have been uploaded to the specified
Storage. The files can be of any type, uploaded from any
directory on any system connected to the registry. Typically
they would be document or graphics files that provide
standards, guidelines or design information on a model
structure. The tab displays the file name and extension, and
a comment on the nature or purpose of the file.

Files held in the Registry are compressed, so to view the
contents you download them onto your local system.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Storage Files' tab to
display a list of files associated with the Package, that are
available for download.

Ribbon Publish > Model Exchange > Reusable
Assets

Review files in Model Package type Storage

On the 'Storage Files' tab, check the 'Comments' field
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against each file that interests you.

To view the contents of a file, right-click on the file name
and select the 'Import From Registry' option. The 'Save As'
browser displays, through which you select the directory
into which to copy the file.

Click on the Open button. The file is copied into the selected
location, from which you can open it.

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin importing a file
from the Storage; in this case you require either a
'Read-Only' or a 'Complete Access' password
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Add Review Comments
For any Model Package in the Storage, you can add
individual review comments on any aspect of the Package.
These comments provide a permanent record on the Package
- once they have been saved they cannot be edited or
deleted.  Each comment is attributed to the ID of the user
who entered it, and is date stamped.

Note that the Review tab is present for a Learning Center
Library Storage, Reference Data Library Storage, and
Source Code Library Storage; however, the tab and panel
are disabled and review comments cannot be entered for
these storage types

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Registry, Model Storage and Package, then click on
the 'Review' tab to display a list of comments associated
with the Package, and a panel for entering further
comments.

Ribbon Publish > Model Exchange > Reusable
Assets

Actions
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Action Description

Review
Existing
Comments

If there appears to be a longer comment
than can be shown in the 'Review' tab,
click on it. The full text displays in the
'Comments' field in the lower panel.

Add a New
Comment

Click on the New button and start typing
your comment on the Package in the
'Comments' field. You can delete and edit
text as you type.
When you have finished writing your
comment, click on the Save button. Your
comment, preceded by your user ID and
the current date, is displayed in the
'Review' panel.
Once you have saved your comment, you
cannot edit or delete it.
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Compare an Asset to the Model
If you are developing a Package in your model against a
standard structure, or using common elements from the
Reusable Asset Service, you can check that your model
conforms to the standard or incorporates any changes to the
common elements, by performing a comparison between the
Asset Package and your model.

Access

Open the Reusable Asset Service view using one of the
methods outlined here.

Select a Package, then right-click on the Package and
choose 'Compare with Package in Model'.

Ribbon Publish > Model Exchange > Reusable
Assets

Compare Asset Package and Model

A prompt displays for you to confirm the comparison. Click
on the Yes button.

The Baseline Comparison view displays, showing the
element hierarchy in which differences have been detected
between the Package in the model and the asset Package in
the Registry (as the Baseline).
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All facilities of the standard Baseline Comparison are
available, including the ability to 'roll back' differences so
that the element or Package in the model matches the
Registry.

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin comparing
information in the Storage and in the model; in this case
you require either a Read-Only or a Complete Access
password
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Register Assets
After you have set up your Storages in the Reusable Asset
Service Registry, you can register assets in them. The assets
include:

Packages of modeling structures of your model, shown in·

the Browser window; these Packages can include
diagrams and subordinate Packages

Any Packages containing model components on which the·

primary Asset Packages depend

Any MDG Technologies that you used in developing the·

Asset Packages, and that you decide to register with the
Packages

Any text or graphics files you want to make available to·

your corporate community; these files are compressed
before being added to the Storage

You register the first three items together. You can register
files in the Storage during that same process, or separately.

You can register separate versions of the same Package. If
you register a Package that already exists in the Registry
under the same version reference, and the Storage has 'Draft'
status, the existing version is overwritten. If you register the
same Package with a different version number or reference,
it is registered separately and users can access both versions
of the Package from the Registry.

'Learning Center Library', 'Reference Data Library' and
'Source Code Library' type Storages cannot contain
Packages of modeling structures - they can contain only
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Library files, which will appear in the 'Storage Files' tab. A
Library file is:

A zipped file containing Enterprise Architect-specific·

Learning Center files for the 'Learning Center Library'
Storage type

An XML file containing Enterprise Architect-specific·

reference data XML files for the 'Reference Data Library'
Storage type

A zipped file containing source code files for the 'Source·

Code Library' Storage type

Once registered, the Library file will be available in the
'Storage Files' tab of the Reusable Asset Service view.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Storage Types

Option Description

Register
Packages and
Files as

Registering Package-trees including
diagrams, as well as files.
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Assets

Register
Learning
Center
Library

Register Learning Center files for use in
other repositories.

Register
Reference
Data Library

Register the current model's  Reference
Data Library for use in other repositories.

 Register
Source Code
Library

Register Zipped files of source code
libraries for distribution.
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Register Packages and Files as Assets
Having set up your Storages in the Reusable Asset Service
Registry, you can register Packages of modeling structures
as selected in the Browser window in your current model.
These Packages can include diagrams and subordinate
Packages, as well as files.

You can also create an Asset that purely contains files, by
not selecting a Package, but just selecting a file. See the
section Register File as Asset in this topic.

Register Packages and Files as Assets

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 In the Browser window, click on the Package to
register as an Asset.

3 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
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4 The 'Register Package(s)' dialog displays, showing
the:

Name and type of the Storage·

Name and status of the selected Package (the·

status at this point being 'Pending')
The name, GUID and current version of the·

selected Package; you can type a different version
number or text string if necessary

If there is a version of the Package already in the
Registry, and the Storage has 'Draft' status, you can
either:

Overwrite the registered Package with an update·

of that version, or
Add the updated Package as another Asset under a·

different version number; in this case, the
'Packages to Register' panel shows the version
number, registration date and comments on the
latest version of the Asset Package

You cannot overwrite an existing Package if the
Storage has 'Complete' status. In this case, add the
Package under a different version number.

5 In the 'Comments' field type a short comment and, in
the 'Notes' field, a longer explanation of the Package
being registered.

6 Click on the Check Dependency button and resolve
the dependencies of the Package.

(c) Sparx Systems 2025 Page 164 of 417



Manage Model Change 2 September, 2025

At the end of this process, the selected Package has
the status 'Ready' (for registration).

7 You can, at this point, also register files as assets of
the Storage. See Step 4 of the next table, Register
File as Asset.
However, if you prefer you can follow the complete
procedure separate from registering Packages.

8 Click on the Register button.
A prompt displays to confirm registering the
Package. Click on the Yes button.
If the same version of the selected Package already
exists in the Registry (if the Storage is a 'Draft') a
prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays. If the Package does not
have any associated MDG Technologies, a message
displays confirming that Package registration is
complete. Go to step 10.

9 If the Package has one or more associated MDG
Technologies, the 'Register MDG Technology'
dialog displays, listing the Technologies and
prompting you to register (OK) or ignore all of them.
If you want to register some Technologies but not
others, click on those you do not want to register,
and click on the Remove button for each one in turn.
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Click on the OK button or Ignore button.
A message displays confirming that Package and
Technology registration is complete.
Notes:

If a remote Technology is removed from·

registration (that is, the Technology is not
registered along with the Package), the registered
Package will refer to this Technology at its URL
When importing the Package from Registry, the
system will import this remote Technology from
its URL (if the remote Technology is not already
available in the importing model)
If a remote Technology is registered with the·

Package being registered, the system will store a
copy of the Technology file in the Registry
When importing the Package from Registry, the
system will import the Technology stored in the
Registry and will not import it from its URL (if the
remote Technology is not already available in the
importing model)

10 Click on the OK button.
The 'Registry Browser' tab is updated with the
newly-added details of the Package and any
dependent Packages. You can review the details on
the tabs on the lower half of the Reusable Asset
Service view.
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Register File as Asset

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password-protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
The 'Register Package(s)' dialog displays.

3 If any Packages are listed in the 'Packages to
Register' panel, and you do not want to re-register
them, clear the checkbox against each Package
name.

4 Click on the Additional Files button.
The 'Select Additional Files' dialog displays.

5 Click on the Add button.
A 'Select' screen displays, on which you browse for
and click on the required file. You can only select
one file at a time on this browser.
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6 Click on the Open button.
The 'Add Comment' dialog displays.

7 Type a brief comment on the nature or purpose of
the file in the Registry, and click on the OK button.
Focus returns to the 'Select Additional Files' dialog,
which now lists the selected file.

8 Repeat steps 5-7 for each Asset file to register.
When you have finished, click on the OK button.
The 'Register Package(s)' dialog redisplays.

9 Click on the Register button.
A prompt displays to confirm registration of the
files.

10 Click on the Yes button.
A 'Progress' dialog displays while the files are
registered, followed by a message confirming that
the (Package and) File registration is complete.

11 Click on the OK button to clear the message, and to
return focus to the Reusable Asset Service view.
You can review the files on the 'Storage Files' tab in
the lower half of the view.
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Register Learning Center Library
Here is a walk through for registering a  Learning Center
Library file. This Storage can be populated only with
Library files, not with Asset Packages.

Register Learning Center Library

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Learning Center Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Learning Center Library' dialog
displays.
Click on the  button next to the 'File' field and
select the Library file.
Type in a short comment on the Library being
registered, in the 'Comments' field.
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4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Register Reference Data Library
When you have a complete project set up, with fully defined
reference data, it is possible to transfer the reference data via
the RAS by setting an Asset that you can import into
another repository. The exported data includes all instances
of the selected data type in the project; for example, all
defined cardinality values, or all Document Style Templates.

Process

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Reference Data Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Reference Data Library' dialog
displays.
Press the  button next to the 'File' field and select :

From File System – to select an existing Reference·
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Data XML file from the file system
From Model – to open the 'Export Reference Data'·

dialog for selecting categories that will be
registered as the Reference Data Library once the
Register button is clicked and a name is entered in
the 'Enter Reference Data File Name 'dialog

Type in a short comment for the Library being
registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Register Source Code Library
These steps outline the process for registering a source code
library.

Process

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Source Code Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Source Code Library' dialog displays.
Select the Library file by pressing the  button next
to the 'File' field.
Type in a short comment for the Library being
registered, in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
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file. Click on the Yes button.
If the same Library file already exists in the Registry
a prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays, followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Check Package Dependencies
As you register a Package in the Reusable Asset Service, the
system provides a check on whether that Package is
dependent on any external content; that is, whether it links
to any modeling component held in Packages other than its
own child Packages. You can perform three types of
dependency check:

Complete, which will consider Package A to be dependent·

on Package B if Package A contains any element,
attribute, operation, operation parameter, diagram or
connector (or their Tagged Values) that references
elements in Package B

Normative, which is the same as a Complete Dependency·

Check except that it will not treat as a dependency for
Package A any element from Package B that is added as a
link on a diagram in Package A

Package Dependency/Import, where only those Packages·

that are the target of a Dependency/Package Import
connector from Package A will be treated as dependent
Packages for Package A

You perform this dependency check as an integral part of
the Asset Registration process (specifically, at step 6 of the
Register Package as Asset process). The check
automatically identifies, firstly, the Packages directly
needed by the Asset Package, and then any Packages needed
by those initial Packages, and so on until the needed
Packages are not dependent on any other.
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In practice, such dependency chains are likely to be quite
short. If you know that the original Asset Package is
dependent on two other Packages, one of which is
subordinate to the other, you can simplify the process
further by selecting the Parent or Ancestor Package first and
thus avoid the extra steps of selecting the two Packages
separately.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

Ribbon Publish > Model Exchange > Reusable
Assets : Register

Check Package Dependencies

Ste
p

Action

1 Select the appropriate Registry, Storage and version
of the model Package to register, and provide any
appropriate comments or notes.

2 Click on the Check Dependency button.
If there are no Packages on which the Asset Package
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depends, the system sets that Package to 'Ready'. Go
to step 6.
The 'Select Needed Package: <dependent package
name>' dialog displays, showing the model hierarchy
containing the Packages needed by the Asset
Package. Each needed Package has a selected
checkbox against it.
If you know that a needed Package is a child or
grandchild of another needed Package, click on the
checkbox next to the 'higher' Package name so that
the child is validated as part of the parent. In this
example, if the Asset Package has dependencies on
both External factors and Location, click on the
'External factors' checkbox to register both
dependencies as External factors.

If the needed Package is already registered in the
Registry, it is indicated by a globe icon:

In this case, select the 'Use latest version of selected
package in Registry (if available)' checkbox to link
to the registered version. For such Packages, no
further dependency check is performed and, on the
'Register Package(s)' dialog, the Package's Status is
set to 'Ready'.

3 Click on the OK button.
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The 'Register Package(s)' dialog updates to show the
initial 'Asset Package status' as 'Ready', and to list
the needed Packages each with the status of
'Pending'.

4 Click on the Check Dependency button again.
If there are no Packages on which the needed
Package depends, the system sets that Package to
'Ready' and sets the focus on the next Pending
Package. If there are no more Pending Packages, go
to step 6.
If the needed Package is dependent on other
Packages, the 'Select Needed Package: <dependent
package name>' dialog displays again, showing the
model hierarchy containing those Packages, each
with a selected checkbox next to it. As in step 2, you
can select a 'higher' Package if appropriate.

5 Click on the OK button.
The 'Register Package(s)' dialog updates to show the
first needed Package status as 'Ready', and to list any
further needed Packages with the status of 'Pending.

6 If there are further needed Packages in the chain,
repeat step 4. The system automatically identifies
them and lists them for validation as in step 5.
Otherwise the system sets the final needed Package
status to 'Ready' and you can continue to register
files and MDG Technologies.
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Notes

A Package with status 'Pending' cannot be registered; only·

Packages with status 'Ready' can be registered

If you are certain that there are no parent-child·

relationships between the needed Packages, you can work
through these steps quickly by just clicking on the Check
Dependency button and OK button alternately until all
Packages in the Package to Register list have the status
Ready

The system does not allow you to register an Asset·

Package that has dependencies on its own parent or
grandparent Package; such dependencies would cause the
Asset Package to be registered twice - by itself and as part
of the parent Package - creating the risk of differences
developing between the two instances
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Update an Asset
Over time, you might need to revise the contents of the
Registry. Such updates can include:

Registering additional Asset Packages and files·

Registering a new version of an Asset Package·

Registering a new edition of a Storage file·

Registering new Libraries·

Deleting an Asset Package·

Deleting a Storage file·

Deleting a Library·

Changing the details of a Storage·

Deleting an entire Storage and the assets and files within·

it

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Update Tasks

Task Detail
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Register new
Asset
Packages and
Storage files

You can add further Asset Packages and
files to a Storage at any time.

Register a
new version
of an Asset
Package

You register a new version of an Asset
Package as if it were a new Asset. In the
'Current Version' field on the 'Register
Package(s)' dialog, you type a different
number or reference to that assigned to
the currently-registered Asset.
You can overwrite an existing Asset
Package under the same version number
only if the Storage has 'Draft' status. If
the Storage has 'Complete' status, you
cannot overwrite the existing Asset
Package under the same version number.
To replace the current version, you must
delete the Asset from the Storage and
register the Package again.

Delete Asset
Package from
Storage

Click on the Package name in the
'Registry Browser' tab and either:

Click on the Delete button or·

Right-click and select the 'Delete From·

Registry' menu option
In either case a short submenu displays,
prompting you to select to delete:
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The Asset Package only, or·

The Asset Package and the Packages·

on which it is directly or indirectly
dependant

When you select the appropriate option, a
prompt displays for you to confirm the
deletion.
Click on the Yes button. A message
displays to confirm that the Package has
been deleted from the Registry, and the
name of the Package is removed from the
'Registry Browser' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Package(s).
If any of the registered Packages depend
on the Package being deleted, the system
displays the names of these Packages and
prompts for confirmation before deleting
each Package.

Register a
new version
of a Storage
File

You register a new version of a Storage
file as if it were a new file under a
different file name.
You can overwrite an existing file under
the same file name only if the Storage has
'Draft' status. If the Storage has
'Complete' status, you cannot overwrite
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the existing file. To replace the current
version, you must delete the file from the
Storage and register the file again.

Delete
Storage Files
from Storage

On the 'Storage Files' tab, right-click on
the file name and select the 'Delete From
Registry' option. A prompt displays for
you to confirm the deletion.
Click on the Yes button. A status
message confirms the deletion, the file is
removed from the Registry and the file
name is removed from the 'Storage Files'
tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the file.

Register a
new Library
File

You can add further Library files to a
Storage at any time.
When you register a Library file, the file
name and location will be used as the
unique identifier for the file. You can
overwrite this Library file in the Registry
by registering a file with the same name
and from the same file system location.

Delete
Library Files

To delete all Library files in Storage,
click on the Delete button in the 'Registry
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from Storage Browser' tab.
To delete a particular Library file,
right-click on the Library file name in the
'Storage Files' tab and select the 'Delete
From Registry' option.
A prompt displays for you to confirm the
deletion. Click on the Yes button. A
status message confirms the deletion,
each Library file is removed from the
Registry and each Library file name is
removed from the 'Storage Files' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Library file(s).

Change
Storage
Details

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.

Delete a
Storage and
its contents

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.

Refresh If there is a possibility that another user
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Registry
Browser

has updated the Registry while you have
had it open, click on the  icon in the
Reusable Asset Service toolbar to refresh
your display from the latest updates to the
Registry.
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Import an Asset into the Model
The Reusable Asset Service provides common or standard
information and data that you can import into your local
model. The unit that you import is a selected version of the
Asset Package; you can also, optionally, import:

Other Packages on which the selected Asset Package·

depends, and/or

Available Technologies that support full use of the model·

structures in the Asset Package

The Asset Package (with, if selected, any needed Packages)
is imported into the currently-selected model Package in the
Browser window, unless the Asset Package already exists
anywhere else in the Project. In this case, the system locates
the existing Package and overwrites it with the imported
Asset Package.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

On the 'Registry Browser' tab, either;

Select an Asset Package and click on the Import button, or·

Right-click on an Asset Package and select the 'Import·

from Registry' option

Ribbon Publish > Model Exchange > Reusable
Assets
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Import Asset Package

Before selecting an Asset Package to import into your
model, click on the 'Version' drop-down arrow and select
the appropriate version of the Package to import.

When you select to import an Asset Package into your
model, a short menu displays from which you select to
import:

The Package alone or·

The Package with the related Packages on which it is·

dependent

A prompt then displays for you to confirm the import, and to
warn you that if the Package already exists in the model, it
will be overwritten by the import. Click on the Yes button to
continue, or the No button to cancel the import.

If the Storage is password protected, after you confirm the
import a prompt displays for your 'Read-Only' or
'Complete-Access' password; enter this and click on the OK
button.

The 'Import from Registry' dialog displays, followed by
confirmation that the import of the Package or Packages is
complete. Click on the OK button.

If the Package depends on Technologies

If the Technologies associated with an Asset Package are
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not already on your system and/or enabled in your model,
during the display of the 'Import from Registry' dialog the
'Import Technology From Registry' dialog also displays.
Process this dialog as described.

Option Detail

Name Displays the name of the Technology as
recorded in the Registry.
The checkbox against each name is
selected by default. If you want to import
one technology but not another, deselect
the checkbox of the technology to ignore.

Version Displays the required version of the
Technology to support the Asset Package,
available through the Registry.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable - for one of these reasons:·

     -  The Technology file is not
registered in the Storage, or
     -  The Technology is a built-in
Technology and is already integrated
with your system, or must
         be purchased under license, or
     -  The Technology is available from
a URL and can be downloaded from
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that URL

Model Status Indicates whether the Technology is
already in your model and disabled.
(If the Technology is in your model and
enabled, there is no need to import it and
it is not listed in the dialog.)

OK Click on this button to import and/or
enable the selected Technology or
Technologies in your system.
A status message displays to indicate that
the Package and Technologies have been
imported and the Technologies enabled.
You might have to restart Enterprise
Architect for the Technologies to take full
effect.
Click on the OK button to clear the
message.
In the Browser window, the Package has
been added to the model with (if selected)
the Packages on which it is dependent.

Notes

You can also import Technologies separately from the·

Package that is dependent on them, using the 'Technology'
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tab of the Reusable Asset Service view

'Learning Center Library', 'Reference Data Library' and·

'Source Code Library' type Storages do not contain any
Asset Packages
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Search Registry
After you have set up your Storages in the Reusable Asset
Service Registry and registered Asset Packages in them, you
can search the Registry to locate modeling items such as
Packages, elements and diagrams using their names or
Global Unique Identifiers (GUIDs).

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Search Registry for Asset Package Contents

Ste
p

Action

1 Click on the  icon in the Reusable Asset Service
toolbar.
The 'Search Registry' dialog displays.
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2 In the 'Property' field, select:
'GUID' if you intend to search the Registry for a·

modeling item based on its Global Unique
Identifier
'Name' if you intend to search the Registry for a·

modeling item based on its name

3 In the 'Term' field, type in the GUID or name of the
modeling item.
Note the interpretation of this field is case-sensitive.

4 In the 'Item' section, select the modeling item to
search for; that is, Package, element and/or diagram.

5 Click on the Search button to search the Registry for
the selected modeling item(s) and to display the
results, if any, in the 'Results' section.

6 The 'Results' section displays the results of the
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search, showing these details:
Storage - the name of the Storage in the Registry·

that has the modeling item
Owner - the name of the Asset Package that·

contains the modeling item
Name - the name of the modeling item·

Type - the Enterprise Architect type of the·

modeling item
GUID - the Global Unique Identifier of the·

modeling item
Notes :

The search results will be grouped by modeling·

item
The group Nested Package represents all those·

Packages (that satisfy the search criteria and) that
are a part of another registered Package

7 Select an entry in the 'Results' section and click on
the OK button to open the Storage (containing the
modeling item) in the Registry Browser and close
this dialog.
You will be prompted for a password if the Storage
is password protected; enter the 'Complete Access' or
'Read-Only Access' password and click on the OK
button to view the Storage contents.
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Auditing
Enable a Transcript of Model Changes Over Time

Auditing records model changes, including when the change
occurred and who made it. It records changes to Packages,
elements, features, connectors and diagrams, detailing the
creation, modification and deletion of these items. A
Repository Administrator or Librarian typically enables
auditing during selected project phases, or continuously
during the lifetime of the repository. An Enterprise
Architect repository contains important organization
information and ensuring that changes to the models are
consistent with an organization's intention and governance
principles is critical to the success of this important
information asset.

Audit View window showing the creation and change of a
'Driver' Actor element and its properties.

Audits are a practical model management mechanism
ensuring that changes to models are well understood and
governed. In this topic You will learn how to enable
auditing, and using the Settings window define the level of
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detail to record in the audit, the elements to be audited and
how batch imports are handled. You can simply enable
auditing and it will silently record the changes the users
make to the model. You will also learn how to manage audit
logs to ensure there are minimal impacts to performance as
logs are stored. Auditing can be used for a variety purposes
beyond governance for example arresting sub-standard
modeling practices by identifying the user and providing
them with training and guidance of how to model in a given
context.
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Brief Introduction
The Auditing facility in Enterprise Architect allows changes
to the repository to be recorded to an Audit log. This
governance tool can be profoundly useful in finding out who
changed a model and when it was changed. It is also useful
to see the complete list of changes made by a given user or
the list of changes made to a given element. The Audit View
is a dashboard that allows you to display the before and after
values of item properties and to drill down from Package
level through elements, features and connectors to diagram
objects.

Audit View showing the creation of, and two subsequent
changes to, the Diagram Object for a Driver Actor.

The basic steps to record Audit logs of the changes to a
repository are:

Enable Auditing - this initiates the process of changes1.
being written to the Audit log.

Configure Audit Settings - set the Audit Level and the2.
Audit Options that define which elements will be audited,
and set options for importing and reverse engineering.
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Allow models to be changed - users perform their normal3.
modeling, creating, modifying, and deleting  elements,
features and diagrams.

View the Audit log - to visualize the changes that have4.
been made since the last log clearance.

Save and Clear logs - logs can be cleared to increase5.
performance that degrades as the logs fill up.

Disable Auditing - optionally Auditing can be disabled if6.
no longer required, and re-enabled when required.

Audit View showing changes made to a Requirement's
'Status' property, from 'In Progress' to 'Approved'.

It is important to point out a fundamental difference
between Auditing and Baselines and Version Control. While
all three of these facilities are concerned with changes to a
repository over time, with Auditing it is not possible to
revert the model to a previous state, which is possible with
Version Control and Baselines. In contrast with a Baseline
Compare, which only displays the original value and the

(c) Sparx Systems 2025 Page 197 of 417



Manage Model Change 2 September, 2025

current values of an item property, the Auditing View can
display all the incremental changes over time, including
when they were made and who made them.

Setting up Auditing is a simple process, and once set up it
will begin recording information about what is changed in
the repository based on the settings that you have specified.
The next few sections provide the basic steps so that you
and your teams can get started with Auditing and controlling
changes to your repository.

Enabling Auditing

You can, as a Librarian or Administrator, enable Auditing,
which initiates the process of model changes being written
to the Audit log. You might choose to only enable Auditing
for a period of time, such as when a new modeler joins the
team or when contractors have access to the model, or in the
final stages of a sprint or iteration.

Audit Settings window, allowing Auditing to be enabled or
disabled.

Auditing can be disabled at any time and enabled again at a
later time. The logs, if not cleared, will simply be added to
once Auditing is re-enabled.

Configuring Settings
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The configuration of the Audit facility is an important step
in setting up the tool, to ensure that the changes that you
want to be able to visualize will be recorded in the Audit log
and will be available when the time comes to view them.
There are three main parts to the configuration:

Audit Settings window, showing Auditing Level, Options,
and Batch import and Log settings.

Import and Reverse Engineering options - allow you to·

specify whether these bulk items should be recorded in
the Audit log

Auditing Level - You can specify the extent of the·

information recorded

Auditing Options - You can specify which elements will·

be audited

Viewing Audits

As a Librarian or Administrator, you can view the content of
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the Audit either through the View Audit window or in the
System Output window. The Audit View provides a number
of options for changing the display and provides a
convenient Tree View control for navigating through the
changes.

Audit View window showing the tree of items and their
changes.

Changes are listed in time order, with an icon that indicates
if the change was a creation, modification or deletion. A
panel on the right displays the change itself, while the
header section at the top describes who made the change,
when it was made and the nature of the changes.

Audit View window showing changes to a Requirement's
properties
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Disabling Auditing

As a Librarian or Administrator your can disable auditing,
which terminates the process of model changes being
written to the audit log.

Audit Settings window allowing Auditing to be enabled or
disabled.

Auditing can be enabled again at any point in time when
required. The logs, if not cleared, will simply be added to
once auditing is re-enabled.

Managing Logs

When Auditing has been enabled, changes to the elements
specified in the audit options are recorded in an audit log.
The management of logs is critical to the performance of the
Auditing facility. When the logs fill up, the time it takes to
write a change will increase, subtly degrading the
performance experienced by modelers as they work in the
repository. The management of logs can ensure that users
don't notice any perceivable change in their save times.  As
the Administrator or Librarian you can save the logs to a
network file and then clear the logs. It is recommended that
this process is managed to ensure an optimal user
experience. The logs can be managed from the left hand
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panel of the Audit Settings window.

Audit Settings options to Clear, Save and Load Logs.
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Audit Settings
The Audit Settings window allows you to enable or disable
auditing, but in addition there are a number of options that
you can use to manage what is recorded by the Auditing
facility. These can be altered during different sessions of
auditing; for example, you might only want to record limited
information about requirements during a phase of the
project. Subsequently you might require detailed
information about all element types, and you could adjust
the settings to specify this. The important options are
summarized here:

Define whether bulk operations should be included in the·

audit

Administer your audit records such as saving and clearing·

logs

Specify the detail of the recorded audit by specifying the·

audit level

Specify the types of object to be included in the audit·

Access

Ribbon Settings > Model > Auditing : Audit
Settings
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Configure Settings

Option Action

Enable
Auditing

Select this checkbox to turn the Auditing
facility on. (Clear the checkbox to turn
Auditing off again.)

Audit XMI
Import

Select this checkbox to audit changes
arising from XMI importing.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit XMI
Export

Select this checkbox to audit changes
arising from XMI exporting.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit
Reverse
Engineering

Select this checkbox to audit changes
arising from reverse engineering.

Use Database
Timestamp

Select this checkbox to use the database
server's timestamp instead of each user's
local timestamp; this improves security.
This option is not available for file-based
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repositories.

Clear Logs Click on this button to permanently delete
all log data from the current project; use
the Save Logs button first, to save the
audit records outside the project.
The system prompts you to specify
whether to clear items logged over a
specific period of time.

Click on the No button to clear all log·

items currently held in the database
Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.

Save Logs Click on this button to save a copy of the
logged audit items currently held in the
project. These items remain in the
project; you can use the Clear Logs
button to remove them.
The system prompts you to specify
whether to save items logged over a
specific period of time.

Click on the No button to save all log·

items currently held in the database
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Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.

Load Logs Click on this button to load a previously
saved set of logs back into the project. A
browser displays through which you
select the log file to reload.
If the same record exists in both project
and log file, that record is not reloaded.

Core Select this radio button to record changes
to elements (including attributes and
operations), Packages, connectors and
some model-level information.

Standard Select this radio button to record the
same changes as for the Core option, plus
changes to some of the 'housekeeping'
data for diagrams - Name, Author,
Version, Stereotype, Notes and Date
Modified.
You can check for changes to diagram
content and structure using the Baseline
facility for reviewing visual changes to
diagrams.
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Extended Select this radio button to record the
same changes as for the 'Standard' option,
plus changes to project security.

Debug Select this radio button to record the
same changes as for the 'Extended' option
plus changes to any database tables.
Some of the auditing information will not
be visible unless the Audit View mode is
set to 'Raw'.

Maintenance Select this radio button to audit changes
to maintenance elements only; that is:

Package (element)·

Requirement·

Feature·

Use Case·

Actor·

Note·

Issue and·

Change·

Core
Structural

Select this radio button to audit changes
to maintenance elements plus certain
structural elements; that is:

Package (structure)·

Class·
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Interface·

Signal·

Node·

Component·

Artifact·

Part·

Port and·

Device·

All Select this radio button to audit changes
to all types of element.

Custom Select this radio button to audit changes
to element types that you specify.
The Customize button is made available;
click on this button to display a list of
element types, and select the checkbox
against each element type to include in
the audit (or click on the Select All button
to select every element type).
Click on the OK button to save the
selection.

Notes

As the number of records increases, the performance of·

(c) Sparx Systems 2025 Page 208 of 417



Manage Model Change 2 September, 2025

the Audit View reduces; it is recommended that audit
records that are not regularly required are saved to file,
then cleared from the project, to help ensure high
performance

Connectors are audited when they are connected to an·

element that is included under the Audit Options

If security is enabled, you must have 'Audit View'·

permission to turn Auditing on, and 'Audit Settings'
permission to change the audit settings
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View the Audits
As an Administrator or Librarian you can view the changes
that have been made to the items in the repository. The
changes that are recorded depend on three main settings:

Import and Reverse Engineering options - allow you to·

specify whether these bulk items should be recorded in
the audit log

Auditing Level - You can specify the extent of the·

information recorded

Auditing Options - You can specify which elements will·

be audited

There are two different views of the changes that are
available to you:

The Audit View - a fully featured window that allows you·

to navigate through the changes and change the display

The System Output window, 'Audit History' tab - a textual·

display that changes as the element context changes
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Audit View
The Audit View provides a convenient dashboard of
information that allows an administrator or librarian to view
and manage the changes to the information that have been
recorded by Auditing. A tree view control provides a quick
way to navigate through a branch of the repository, showing
all the items that have been changed. Colored icons provide
a quick visual queue as to whether a particular item has been
created, changed or deleted. When a change is selected in
the tree view, the panel to the right displays the properties
that have been created, modified or deleted, and the top
panel shows the user responsible, the time and date of the
change and a summary of the change.

Access

Ribbon Settings > Model > Audit

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description

View
controls

The view controls provide a variety of
settings for controlling auditing and the
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display of audit records.

Audit tree The audit tree displays the log items that
have been recorded by auditing.
What is displayed in the tree is affected
by the view controls, such as:

Sorting·

Filter (by time)·

Mode·

Auditing settings (what was actually·

recorded)
If synchronizing with the Browser
window, it is also affected by the
Package, diagram or element you have
selected.

In the audit tree:
The green tick indicates a creation·

The yellow pencil indicates an edit·

The red cross indicates a deletion·

Right-clicking an element in the audit
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tree (such as ObjectB) displays a context
menu that enables you to locate the
selected element in:

The Browser window·

Any diagrams in which it exists·

Record
display

The record display is in two parts: the
identity of the selected change, and the
actual change made.
The data in the record display is
determined by the view controls and
mode and, if synchronizing with the
Browser window, by the Package,
diagram or element you have selected.
Identity

The identity of a change consists of:
The Windows username of the user·

who made the change; if security is
enabled, the name is of the format
WindowsUsername(SecurityUser)
When the change was made·

The path of the change; for example:·

Class Class1 - Attribute Att1 - Attribute
Constraint Constraint
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Changes
Changes are displayed in a table format,
showing the:

Property (or data item) name·

Its original value before the change and·

Its value after the change·

If you double-click on an item in the list
of changes (or right-click and select the
'Show Differences' option) the Difference
window displays:

This shows the specific changes that have
been made, highlighting the edited,
created, deleted or formatted characters.
Changes to the format of text in the
element, made through the element
'Properties' dialog, are not apparent in the
initial table; they are visible in the
Difference window, identified by HTML
formatting tags.

Notes

If security is enabled, you must have 'Audit View'·
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permission to display data in the Audit View
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Audit View Controls
The Audit View controls provide a variety of settings for
controlling auditing and the display of audit records.

Options

Option Action

Configure Click to open the 'Audit Settings' dialog.

Load Click to reload the Audit Tree, updated
with any new audit results.

Mode Click to display a menu of options to
change the mode of the Audit View.
Select:

'Default View' - to load large sets of·

log items independent of the Browser
window; in this mode, a special Audit
Settings group can be displayed in the
Audit Tree, which records:
     -  When Auditing has been enabled
and disabled
     -  Who made the change
     -  The date and time of the change
     -  Changes to the Audit Settings
     -  When Audit Operations are
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executed
     -  Security changes (which can be
browsed in the same way as
        other changes)
'Filtered to Browser' - to automatically·

synchronize with the Browser window;
where changes have been made, the
Audit View reflects your selection
from the Browser window - if you click
on:
     -  An element, the Audit View
displays the history for that element
     -  A Package, the Audit View
displays the history for that Package
        and its immediate children (but
not the contents of nested Packages)
     -  A diagram, the Audit View
displays the history for that diagram
and
        its contents (which could be
drawn from a wide area of the Browser
        window)
'Sequential Event Log' - to display all·

audit records in chronological order
without sorting, enabling you to see a
progression of changes; this can be
especially useful in determining
date-time inconsistencies
Any search and filtering you define still
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apply, enabling you to view all of
today’s changes in order, or all changes
for a particular element in order, or
both
Additional database information is
displayed; this additional information
might be insignificant or only in
machine-readable format
'Deleted' - to display only deleted·

records, but otherwise data is shown as
in 'Default' mode; records can be sorted
by element type or by user as required

Search Click to search through log items for a
particular area - you can search by Name,
Type or GUID.
The items are loaded and filtered with the
current Group By, Time Period and Mode
settings.
If you refresh the Audit View, you must
run the search again.

Time Period Click to display the 'Time Filter' dialog,
to set the filter time period:

Today - to display changes occurring·

today
Previous Hour - to display changes·

occurring in the last 60 minutes
Previous 24 Hours - to display changes·
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occurring in the last 24 hours
Previous Week - to display changes·

occurring in the last 7 days
Previous 30 Days - to display changes·

occurring in the last 30 days
Previous Year - to display changes·

occurring in the last 365 days
Custom - to define your own time·

period, using the From and To fields
The six pre-configured time periods
automatically update when you click on
the Refresh button; custom periods are
static and do not automatically update.

Group By Select the appropriate radio button for the
required display setting:

Type - changes are grouped under·

element type (such as Class or
Requirement), and then grouped under
the changed element
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User - changes are grouped under user·

name, each with the number of changes
for that user
Under each user name, changes are
grouped as for the Type sort

Status Text (Displayed to the right of the 'Group By'
panel) Read to see which:

Mode has been selected and·

Time filter is being applied to the data·
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System Output - Audit History
When Auditing is turned on, an 'Audit History' tab is added
to the System Output window. The tab shows a history of
changes to whichever element or connector you have
selected in the:

Current diagram·

Browser window·

Audit View, or·

Package Browser·

System Output window 'Audit History' tab showing changes
to the elements in the repository.

As you select different elements or connectors, the 'Audit
History' tab automatically updates to reflect your current
selection. For each change made to the element or
connector, the tab shows:

Who made the change·

When the change was made·

Where the change was made·

The value of the characteristic before the change·

The value of the characteristic after the change·
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Access

Ribbon Start > All Windows > Design > Explore
> System > Audit History

Notes

To see this tab, you must first have the Audit View open;·

the tab continues to display if you subsequently close the
Audit View

If security is enabled, you must have 'Audit View'·

permission to display data on the 'Audit History' tab
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Performance Considerations
Auditing is a tool for determining who made changes to the
model and when the changes were made. When auditing has
been enabled, every time a change is made to the model the
Enterprise Architect auditing engine records the change.
These changes will naturally, as for any transaction system,
take some to be written to the audit log. When the logs are
small this write time will be imperceptible but when the logs
grow in size the time taken to write to the log will increase
and could delay the saving of changes. The tool provides a
number of ways to reduce theses delays in saving changes.
The delays can be experienced in two different parts of the
auditing process:

When making changes to the repository - As described·

earlier, saving model changes could be delayed, affecting
you or any other user who is updating an aspect of the
model that is being audited; for example, a change to an
element's name, changing the position of an object on a
diagram or - if configured - the creation of tables or code
classes resulting from reverse engineering a database or
code package, will all result in a write to the audit logs

When accessing the Audit View - The Audit View that is·

typically accessed by a Librarian or Administrator can
become slow due to the volume of audit records that have
to be sorted and displayed

The performance of both these aspects of the auditing
process is discussed in these topics:
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Auditing Performance·

Audit View Performance·
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Auditing Performance
Enabling auditing on a project increases the time taken for
many actions, such as insertion, change and deletion of
objects and changes to properties of elements, connectors
and diagrams, including moving objects in diagrams. When
auditing is initially enabled, the time required to write to the
audit logs will be almost imperceptible, but as the logs grow
in size the log write time will become longer and could
cause some frustration to you or your colleagues, whose
main focus is creating useful models. Fortunately there are
some simple housekeeping and administration procedures
that can reduce this time, typically performed by a Librarian
or Administrator.

Operation Delays

Operation Detail

Large
Deletions

Deleting large Packages or Package
structures, or large numbers of elements,
takes significantly longer with auditing
on.
You might disable auditing before
performing such a deletion.

XMI Imports Importing XMI takes longer with auditing
enabled.
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A project-level option is provided for
disabling auditing of XMI Imports.

Reverse
Engineering

Reverse engineering code takes longer
with auditing enabled.
A project-level option is provided for
disabling auditing of reverse engineering.

Replication You cannot remove replication from a
model with Auditing enabled.
If you have to remove replication, disable
Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the
database version; you can then remove
replication.
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Audit View Performance
As the logs become larger, the Audit View can exhibit slow
performance simply because of the volume of records it has
to process to create the visualizations used by the Librarian
or Administrator. Fortunately there are ways to reduce the
delay in the presentation of changed items, and these only
require a small amount of housekeeping.

Considerations and Responses

Consideratio
n

Detail

Navigating
the Browser
Window
Within
Auditing is
Slow

Try setting the time period to a period in
the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week';
this time period updates each time you
open or refresh the Audit View.
Save log items outside the project with
the Save Logs button; if you then clear
the logs you have just saved, the load
time of the Audit View is reduced.
You can reload logs into the project at
any time, using the Load Logs button.

The Audit
View is Slow

As for 'Navigating the Browser Window
Within Auditing is Slow'.
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in Loading
and
Changing
Modes

Navigating
the Audit
Tree is Slow

Close the 'Audit History' tab in the
System Output window.
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More Information
Enterprise Architect's Auditing facility is a valuable
governance tool that records repository changes in an Audit
log. This functionality is immensely beneficial for tracking
model modifications, identifying the user responsible for a
change, and pinpointing when the change occurred.
Additionally, the Audit log provides insights into a user's
complete list of changes or the alterations made to a specific
element. The Audit View serves as a dashboard, showcasing
before and after values of item properties and enabling users
to navigate from Package level down to diagram objects
through elements, features, and connector

Edition Information

The Auditing facility is available in the Corporate,·

Unified and Ultimate editions

Warning - If your site uses the Professional edition of·

Enterprise Architect (in which Auditing is not available)
as well as the Corporate, Unified and/or Ultimate editions,
when Auditing is turned on in a project any users of the
Professional edition are locked out of that project; to
restore access, turn Auditing off

Related Tools

Version Control·

Baselines·

(c) Sparx Systems 2025 Page 229 of 417

https://sparxsystems.com/enterprise_architect_user_guide/17.1/versioncontrol.htm
https://sparxsystems.com/enterprise_architect_user_guide/17.1/baselinesanddifferences.htm


Manage Model Change 2 September, 2025

The Compare Utility (Diff)·
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Version Control
Stores Versions of parts of a Repository for Comparison
and Rollback

Version Control provides a mechanism to store previous
versions of any section of a model and later compare them
to a current state. Version Control is a useful team feature
that allows models to be developed in a coordinated way
within a team environment.  Sections of the model can be
placed under Version Control  and you can manage changes
to and revisions of your model content by placing individual
model Packages, view nodes or root nodes under Version
Control. The information stored within the repository is a
valuable corporate asset and needs to be managed as such.

Browser window showing one Checked-Out Package
(Context) and four Checked-In Packages under Version
Control.

Version Control provides a safeguard against losing
previous model changes. In this topic you as the Librarian
will learn how to configure a Version Control product for
use within Enterprise Architect and to apply the
configuration to control Packages, individually or in groups.
You will also learn how to use Version Control to
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Check-Out and Check-In Packages, how to view previous
versions, and compare a current version to a previous
version.
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Brief Introduction
The Version Control feature allows you to check-out a
Package, which then locks it so that no other user can
modify it until you have checked it back in again. You can
then modify the Package, adding new elements and
diagrams, changing others and deleting still others.  When
you have completed your changes and are ready for other
modelers to see your work, you can check-in the Package.
Other modelers would then need to do a Get Latest to pull
the new changes down from the Version Control Server.

Enterprise Architect does not version the Packages
internally; instead it integrates with industry standard
Version Control servers, which an administrator must install
and configure for use by Enterprise Architect. The files that
Enterprise Architect uses are industry standard XMI files,
which are best seen as 'binary' from the point of view of
Version Control. This means that it is not possible for two
modelers to be working on the same file, as it would not be
possible to merge the files as is possible with source code or
text files.

The basic steps to use Version Control are:

Select and set up a Version Control Server and Client side1.
Software.

Place the required Packages under Version Control.2.

Check Out a Package.3.

Make modifications to the contents of the Checked Out4.
Package.
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Check In the Package, entering comments that describe5.
the changes.

Compare the Repository Package with the Version6.
Controlled Package.

Retrieve (rollback to) a previous version.7.

Enterprise Architect's Version Control integration provides
several key facilities, including:

Saving a history of changes made to your model's·

Packages

Retrieving previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team·

members

Commissioning a Version Control System

You apply Version Control through a third-party
source-code control application that manages access to and
stores revisions of the controlled Packages. Once the
Version Control software has been installed and configured,
you or a librarian must define a Version Control
Configuration within your project. You can then use
Version Control to manage changes to the Packages of your
model.

Configuring Packages
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Before you can Check Out a Package and begin making
changes, you or the librarian must first configure the
Package for Version Control. You simply select the 'Add
Branch to Version Control' option and choose an existing
configuration. This adds the Package to the Version Control
System and places it in a Checked-In state.

Context menu showing the 'Add Branch to Version Control'
option.

Packages under Version Control are identified in the
Browser window by icons that indicate the current status of
the Package. When a Package is initially added to the
Version Control System it will have a locked icon, as shown
in this diagram.

Browser Window showing the Design Package with a Lock
icon after Check-In.
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Checking Out Packages

Once Version Control has been set up and configured you
can start checking out Packages. When you want to work on
a Package that is Version Controlled, you need first to
Check Out that Package. This will change the Package icon
in the Browser window from locked to unlocked. While you
have the Package checked-out no other user will be able to
work on the Package and they will in turn see a locked
Package icon.

Context menu showing the Check Out option.

Make Modifications to Package Content

Once a Package has been checked out you are free to make
modification to the content, just as you would in a
repository that doesn't have any Version Control
implemented. You will be the only one able to edit the
content, as other users that attempt this will receive a
message saying the Package is checked out.
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Browser window showing the Context Package that has
been checked out, with the Checked-Out Package icon

Checking In Packages

Once you have finished making changes to the contents of a
Checked-Out Package, you can Check In that Package. This
will change the Package icon in the Browser window from
unlocked to locked. As soon as you Check-In the Package it
will display a locked Package icon and the Version Control
system will be updated. You can also enter a comment that
describes the changes that you made while the Package was
under your control, which will be useful when looking back
at version changes. Once the Check-In is complete, other
users will be able to Check-Out the Package.

Context menu showing the Check In option.
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Getting Latest Changes

If you are working in a single shared model any changes
that your colleagues have made will be available by simply
reloading the Package. If, however, you are working in
private models then you will need to periodically get the
latest changes that your colleagues have checked in to the
Version Control system. You can use 'Get Latest' for a
single Package or for the entire model depending on
whether you are interested in just one change or all of the
changes.

Context menu showing the 'Get Latest' option.

Comparing to Previous Version

At any stage of a model's evolution you can compare the
current version of a Package to the version stored in the
Version Control system. This option launches the
Comparison window that displays the differences between
the model's current state and the latest revision held in the
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Version Control system.

Context menu showing the 'Compare with Controlled
Version' option.

Reverting to a Prior Version

As your model evolves you might want to revert to a
previous version of a Package. By using the 'File History'
dialog you can select any prior version. By viewing the
Check-In comments and the Date and Time of the Check-In
the required version can be selected. The Retrieve option
will restore the current model to the selected version without
the need to check-out the Package.

File Version History window showing a number of versions
(revisions) with Comments.
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Setup Options
There are a number of options that can be chosen when
setting up Version Control for one or more teams in your
organization. There are also some fundamentals about the
way that Enterprise Architect integrates with the Version
Control software with respect to locking that you should
review before setting up Version Control.
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Version Control Locking Overview
Enterprise Architect implements Version Control of your
model by exporting Package data from the project database
to XMI Package files, which are placed under Version
Control in the source-code control application. The XMI file
format cannot be merged in the same way as ordinary text
files can be merged, which is why Enterprise Architect must
enforce serialized editing of Version Controlled Packages,
as discussed here.

The Lock-Modify-Unlock Solution

Many Version Control systems use a lock-modify-unlock
model to address the problem of different authors in a
shared source overwriting each other's work. In this model,
the Version Control repository allows only one person to
change a file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes
to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can
do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can
take her turn in locking and editing the file.

The Copy-Modify-Merge Solution

Subversion, CVS and a number of other Version Control
systems use a copy-modify-merge model as an alternative to
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locking. In this model, each user's client contacts the project
repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then
work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged
together into a new, final version. The Version Control
system often assists with the merging, but ultimately a
person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally
considered a hindrance to collaboration, there are still times
when locking is necessary.

The copy-modify-merge model is based on the assumption
that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program
source code). However, for files with binary formats, such
as artwork or sound, it is often impossible to merge
conflicting changes. In these situations, it really is necessary
for users to take strict turns in changing the file. Without
serialized access, some users end up wasting time on
changes that are ultimately overwritten.
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Repository Options
The Version Control facility can be used in many different
ways, although these roughly fall into one of four types of
use as discussed in this table.

Usage

Type Details

Single
Shared model

Users share a model stored in a central
project file or DBMS repository. In this
configuration you can view changes to
other users' Packages without explicitly
having to check them out, by simply
refreshing your view of the model.
Version Control is used to:

Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'Undo'
facility
Regulate access to Packages·

Multiple
Private

One model is created by a single user
who configures it for Version Control.
The model file is then distributed to other
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models users, with each user storing their own
private copy of the model.
Version Control is used to:

Propagate changes to the model,·

throughout the team
Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'undo'
facility
Regulate access to Packages·

Shared
Packages

Individual users create separate models
but share one or more Packages:

Users share Packages through Version·

Control

Standard
Packages

A company might have a standard set of
read-only Packages that are broadly
shared:

Individual users retrieve Packages with·

the Get Package menu option

Factors to consider
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Factor Detail

System
Requirements
and
Configuratio
n

You apply Version Control through a
third-party source-code control
application that manages access to and
stores revisions of the controlled
Packages.
Typically the configuration consists of:

A server component that manages a·

Version Control repository, and
Client components on the workstations,·

that manage local working copies of
controlled files

Enterprise Architect uses the client
component to communicate with the
server. A Version Control client must be
installed on every machine where you run
Enterprise Architect and want to access
your Version Control system.

Version
Control
Usage

There are two main ways in which
projects can be deployed:

Centralized Shared Model·

Distributed Private Models·

Version Control is employed in the same
way for both scenarios; however, when
using Private Model deployment you
have the additional facility of propagating

(c) Sparx Systems 2025 Page 246 of 417



Manage Model Change 2 September, 2025

model updates throughout the team.
Version Control can also be used to share
standard Packages between different
projects.

Team
Deployment

Consider the process of setting up a
Version Control environment and
applying Version Control to a project to
be accessed by a number of users.

Version
Control
Basics

Enterprise Architect enforces serialized
editing of Version Controlled Packages,
using the lock-modify-unlock mode of
operation.

Applying
Version
Control to
Models

Using Version Control consists of placing
individual model Packages under Version
Control, rather than Version Controlling
the project as a whole.

Version
Control and
Project
Reference
Data

To share changes in reference data
between users in a version-controlled
project deployed as multiple private
models, you periodically export the
reference data from the model where the
changes were made, and import it into the
other models maintained by the team.

Offline You can prevent the system from
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Version
Control

attempting to make any Version Control
connections by choosing to Work Offline
before loading a model.
If Enterprise Architect is unable to
connect a Version Control Configuration
for any reason, it displays warning
messages to notify you and provides
'offline' Version Control functionality for
all Packages associated with the failed
connection.
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Version Control of Model Data
When applying Version Control in Enterprise Architect, you
place individual model Packages under Version Control, and
not the project as a whole.

All Enterprise Architect models are stored in databases -
even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary
data, the project file would require the use of the
lock-modify-unlock model of Version Control, which would
mean that only a single user at a time could work on any
given (Version Controlled) model. Therefore, it is not
practical to apply Version Control to the database (.eap file)
as a whole; this can also create problems for you in that:

Most Version Control systems mark their controlled files·

as read only, unless they are specifically checked-out to
you

The .eap file is an MS Jet database, and Enterprise·

Architect must be able to open this file for read/write
access when you load your model; if the model is
read-only, the system displays an error message and fails
to load the model

Version Controlling Packages in your Model

To overcome these limitations, Enterprise Architect exports
discrete units of the model - the Packages - as XMI Package
files, and it is these XMI files, not the project file, that are
placed under Version Control. The XMI file format used by
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Enterprise Architect dictates that they too be treated as
binary files - therefore it is not possible to merge the XMI
files either; however, by splitting the model into much
smaller parts, many users can work on separate parts of the
model simultaneously.

Version Controlled Nested Packages

Version Controlled nested Packages result in much smaller
XMI files being exported, as the parent Packages' XMI files
do not contain any content for the Version Controlled child
Packages.

Version Control of nested Packages, together with a model
structure of small individual Packages, provides greater
scope for multiple users to work concurrently, as individual
users are locking much smaller parts of the model.
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Version Control Nested Packages
When you save a Package to the Version Control system,
only stub information is exported for any nested Packages.
This protects information in a nested Package from being
inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking
Out

When you check out a Package, you do
not modify or delete nested Packages;
only the top level Package is modified.
As a consequence of this behavior, if you
check out or get a Version Controlled
Package with nested Packages that are
not already in your model, you see stubs
in the model for the nested Packages
only.

Get All
Latest

If you select the 'Get All Latest' option
from the Version Control menu, any new
stubs are populated from the Version
Control system.

Importing
Models

You can populate a large and complex
model, by 'getting' only the root
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Packages, then using 'Get All Latest' to
recursively iterate through the attached
and nested Packages.
This is a practical and efficient means of
managing your project and simplifies
handling very large models, even in a
distributed environment.
The 'Import a Model Branch' option
combines the procedure steps into a
single operation.

Notes

It is recommended that, when sharing a Version·

Controlled model, you do not mix versions of Enterprise
Architect later than version 4.5 with earlier versions; if
this is necessary it is best to go to the 'Version Control
Settings' dialog and deselect the 'Save nested version
controlled packages to stubs only' checkbox, setting
Enterprise Architect to the pre-version 4.5 behavior (for
the current model only)
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Version Control and Reference Data
Reference data is data that is used across a model or project;
it is not Package-specific. Version Control operates at
Package level, and therefore does not capture changes in
reference data. Where Version Control is used in a multiple
private model set up, changes in reference data are not
brought into the model when Packages are updated from
Version Control.

In a Shared Model environment, all users are accessing the
same project reference data. Changes in reference data can
be shared between users in a Version Controlled project
deployed as multiple private models, by periodically
exporting the reference data from the model where the
changes were made, and importing it into the other models
maintained by the team.

Reference data is exported and imported as an XMI file,
which contains whatever types of reference data you want to
transfer. You can place your project reference data under
Version Control by exporting the data as an XMI file and
apply Version Control to that file using your Version
Control software external to Enterprise Architect.
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Version Control and Teams
This is a summary of the process of setting up a Version
Control environment and applying Version Control to a
project to be accessed by a number of users.

Version Control - Process Overview

Ste
p

Action

1 Install your Version Control product.

2 Create a Version Control repository.

3 Create a Version Control project to be used with
your Enterprise Architect project.

4 Check-out a working copy of the Version Control
project (a module, project or folder within the
Version Control system) into a local folder.
You must do this for every team member that is
accessing the Version Controlled Packages, whether
you are using a single shared model or each team
member stores his own private copy of the model.

5 Before attempting to access the new Version Control
environment from within Enterprise Architect, you
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should first verify that it functions correctly when
used outside of Enterprise Architect.

6 Within Enterprise Architect, define a Version
Control configuration to provide access to the
working copy files.
The name of the Version Control configuration must
be the same across all machines throughout a team.
That is, all Version Control access to a given
Package must be through Version Control
configurations with the same name, across all
models and all users.
The easiest way to perform this step (throughout the
team) is to have one user set up Version Control on
the model and then share that model with the rest of
the team.

In Shared Model deployment, all users connect to·

a single instance of the model database, so the
model is shared automatically
In Private Model deployment, it is easiest to·

distribute copies of the original model (after
Version Control has been set up) to all other
members of the team

Whenever you open a model (Private or Shared) that
uses a Version Control configuration that is not yet
defined on your workstation, a prompt displays to
complete the definition for that configuration. This
typically means specifying the local working copy
directory and perhaps choosing the Version Control
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project associated with this Enterprise Architect
project.
Once this has been done, the Version Controlled
Packages that already exist in the model are ready
for use.

7 Configure Packages within the Enterprise Architect
model for Version Control. That is, apply Version
Control to individual Packages.

8 Check-out and check-in Packages as required.

Notes

It is possible to use multiple Version Control·

Configurations within the same model; different Packages
can still use different Version Control Configurations
within the model, as long as any given Package is always
accessed via the same Version Control Configuration
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Offline Version Control
When loading a model that uses Version Control, Enterprise
Architect normally initializes a connection to the Version
Control system for each Version Control configuration
defined in the model. If Enterprise Architect is unable to
connect a Version Control configuration for any reason, it
displays warning messages to notify you and provides
offline Version Control functionality for all Packages
associated with the failed connection.

You can prevent Enterprise Architect from starting to make
any Version Control connections, by selecting to work
offline before loading your model.

Access

Ribbon Settings > Version Control > Work
Offline

Working Offline

Concept Discussion

Choosing to
Work Offline

Selecting to work offline is useful if you
know beforehand that Enterprise
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Architect cannot connect to your Version
Control system. For example: If you are
working on a laptop computer that is
disconnected from your network, on an
Enterprise Architect model that uses a
large number of Version Control
configurations, you can select to work
offline before you load the model to
avoid all the error messages that the
system would normally display as each
Version Control connection attempt
failed.
You can switch between working offline
and working online at any time, either
before or after a model is loaded, by
toggling the 'Work Offline' menu option.
Enterprise Architect disconnects or
reconnects Version Control (depending
on the connection availability) according
to your selection.

Using
Version
Control
Whilst
Disconnected
From the
Version
Control

Enterprise Architect 'remembers' the
status of a model’s Version Controlled
Packages. Packages that were checked
out to you prior to disconnecting from the
server are still shown as checked out to
you, even though you are no longer
connected to the server. You can still edit
these Packages as you normally would.
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Server Packages that were not checked out to
you prior to disconnecting from the
server are shown as Version Controlled
and locked. You cannot edit these
Packages until you check them out.

Offline
Check Out

You can 'check-out' and edit a Version
Controlled Package even when your
machine is disconnected from the
Version Control server. In this example,
the colored 'figure 8' icon for DFD
indicates that you have checked it out
whilst off line.

(The gray 'figure 8' icon shown against
Logical View indicates that you have
checked out a Version Controlled
Package on line.)
You should be aware that the Version
Control system, and therefore other users,
have no way of knowing that you have
'checked-out' a Package whilst offline. It
is not possible to merge changes to an
XMI file that result from two users
editing the same Package at the same
time. If an offline checkout leads to two
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people editing the same Package at the
same time, when the changes are brought
back online the first-saved set of changes
is lost.

Checking In
a Package
That Was
Checked Out
Offline

Once you reconnect your system to the
Version Control server, if the Package
you checked out offline is not currently
checked out by another user, you can
check in that Package. However, before
Enterprise Architect checks in the
Package, it compares the local working
copy of the Package file with the latest
revision in the repository. (These Package
files remain unchanged in your work area
until Enterprise Architect exports the
Package again before checking in.) If the
repository version remains unchanged
from when you last updated your local
copy, Enterprise Architect exports and
checks in your Package without further
prompting.
On the other hand, if the repository now
contains a file that has changed since you
last updated your local copy, checking in
your Package would overwrite those
changes. Enterprise Architect displays a
message warning you of the pending data
loss and giving you the opportunity to
abort the check in. At this point, you must
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decide whether to discard your own
changes, using the 'Undo Check Out'
command, or continue with your check in
and overwrite the changes that have been
committed to the repository since you last
updated your local copy from the
repository.
You can use the 'File Properties'
command to determine who checked in
the last changes to this Package. This
might help you to discover what changes
have been uploaded and decide whose
changes take precedence.

Update
Before You
Disconnect

Whenever you are connected to the
Version Control server, you are always
working with the latest version of a
Package. This is because you cannot
modify a Package until you check it out
from Version Control, and checking it out
loads the latest revision from the
repository into your model.
This cannot happen when you are
disconnected from the Version Control
server. You are working on whatever
versions you have on your machine,
dating back to the last time you updated
your local copy of each Version
Controlled Package. So, if you are
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planning to work on a model whilst
disconnected from Version Control, it is a
very good idea to make sure that you
have the latest versions of all Packages
before you disconnect. The 'Get All
Latest' option makes this a simple task.
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Version Control Branching
Currently, Enterprise Architect does not support Version
Control Branching.

Work-arounds to achieve similar results might be possible
for certain version-control products; contact Sparx Support
for advice.

Contacts

User Type Contact via

Registered
users

https://sparxsystems.com/registered/reg_s
upport.html

Trial users support@sparxsystems.com
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Version Control Product Setup
To control and maintain the different revisions of your
project Packages, Enterprise Architect uses third-party
Version Control products. Once your Version Control
product is installed and a suitable environment has been
created, Enterprise Architect can use that environment to
control your project's Packages.

Typically, Version Control products consist of:

A server component·

A client component·

Enterprise Architect integrates with the Version Control
client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for
products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version
Control
Server

The server component maintains the
controlled files in their many revisions, in
a central repository.
The server component is usually located
on a server machine that is accessible to
all team members who are using Version
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Control.

Server
Configuratio
n

The steps for configuring a Version
Control server are, broadly:

Install the software·

Create a repository·

Create Version Control projects (or·

modules or folders for use with specific
projects)
Configure user IDs and passwords·

For details on configuring any particular
Version Control server, consult the
appropriate documentation provided with
the Version Control product.

Version
Control
Client

The client component manages the
working copies of the controlled files,
submitting files to or retrieving files from
the server as required.
A Version Control client must be
installed on every machine on which you
run Enterprise Architect and want to
access your Version Control system.

Client
Configuratio
n

The steps for configuring a Version
Control client are, broadly:

Install the software·

Create a new directory for use as a·
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local working copy folder
Log in to the Version Control server·

Associate the working copy folder with·

its corresponding server repository
folder

For details on setting up a
product-specific Version Control
environment for use with Enterprise
Architect, click on the appropriate link in
the next column.
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System Requirements
Enterprise Architect is a Windows-based application and
requires a Windows-based Version Control client for
integration. It is independent of the Version Control server
component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.
Subversion server components are
available to run on a wide range of
different hardware and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires Subversion's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with Subversion,
such as TortoiseSVN; this type of client
cannot be used directly for integration
with Enterprise Architect, but can be very
useful in preparing a working Subversion
environment for use by Enterprise
Architect.
Binary Packages are available for
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download from:
http://subversion.apache.org/packages.·

html
Subversion documentation is available
from:

http://svnbook.red-bean.com/nightly/en·

/index.html

Concurrent
Versions
System
(CVS)

CVS is free, open source software.
CVS server components are available to
run on a wide range of different hardware
and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires CVS's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with CVS, such
as TortoiseCVS; this type of client cannot
be used directly for integration with
Enterprise Architect, but can be very
useful in preparing a working CVS
environment for use by Enterprise
Architect.
The software is available for download
from:

http://www.nongnu.org/cvs/·

CVS documentation is available from:
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http://cvsbook.red-bean.com/cvsbook.h·

tml

Microsoft
Team
Foundation
Server

Enterprise Architect is able to use either
the:

Command line client for TFS, or·

MS TFS-SCC client·

Your choice of client affects how you
specify your Version Control
Configuration.
MS TFS-SCC clients are available for
download from Microsoft's web pages.
(Run an Internet search for 'TFS
MSSCCI'.)

Common
Source Code
Control
(SCC)-compa
tible products

Any Version Control product that
provides a client that complies with the
Microsoft Common Source Code Control
standard, version 1.1 or higher, can be
integrated with Enterprise Architect.
These products are SCC-compatible and
are known to successfully integrate with
Enterprise Architect:

Accurev·

ClearCase·

MS Visual Source Safe·

MS TFS-SCC·

MKS Source Integrity·

(c) Sparx Systems 2025 Page 269 of 417

http://cvsbook.red-bean.com/cvsbook.html
http://cvsbook.red-bean.com/cvsbook.html


Manage Model Change 2 September, 2025

Perforce·

Source Offsite·

Snapshot CM·

Products that do not appear in this list
should still integrate successfully with
Enterprise Architect, if there is a client
available for that product that complies
with the MS SCC API specification.
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Create a Subversion Environment
You can use Subversion as a Version Control provider for
Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the
appropriate software. A number of basic tasks are performed
in creating an operational Subversion environment, and
useful tools are available for performing some of these
tasks.

Tasks in Creating a Subversion Environment

Task Detail

Install server
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.
Subversion server components are
available to run on a wide range of
different hardware and operating systems;
Enterprise Architect is not affected by
your choice of server components.
VisualSVN is an application that can
greatly simplify the installation,
configuration and management of your
Subversion server.

Create a Please consult the official Subversion
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repository documentation.

Create
Subversion
users

Please consult the official Subversion
documentation.

Create a new
repository
sub-tree

It is good practice to create a new
repository sub-tree in Subversion for each
new Enterprise Architect model being
added to Version Control with
Subversion. Users should create a new
local working copy from the sub-tree to
be used with that model.
TortoiseSVN can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
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where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In
Subversion, to create a local working
copy you perform an initial check-out of
a folder from the Subversion repository;
this downloads a copy of the folder and
its contents, to create your local working
copy.
TortoiseSVN can greatly simplify the
initial check out of a working copy
folder.

Setting up
Subversion
under
Wine/CrossO
ver

The process of setting up and using
Subversion with Enterprise Architect
under Wine is almost identical to the
process when running natively under
Windows, apart from minor differences
in installing the Subversion client and
performing the initial check out of the
working copy folder.

Notes

Enterprise Architect relies on exclusive file locking when·

applying Version Control to its Packages; file locking was
not introduced into Subversion until version 1.2, therefore
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Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe

(c) Sparx Systems 2025 Page 274 of 417



Manage Model Change 2 September, 2025

Create a new Repository Sub-tree
When you set up Subversion as your Version Control tool, it
is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The
sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion
Repository

Ste
p

Action

1 Use Windows Explorer to create a temporary
directory on your PC file system, to be imported into
the Subversion repository as a new repository
sub-tree. The directory would have this structure:
-    tempDir
          myEAModelName

2 Open a Windows command prompt, navigate to
tempDir and issue the Subversion command import.
For example:
     C:\Documents and Settings\user> cd \tempDir
     C:\tempDir> svn import .
https://host.example.com:8443/repos/
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     --message "Repository Initialization"

3 On your PC, delete the temporary directory structure
(tempDir) and all its contents.

Notes

After the import is finished, the original tree is not·

converted into a Subversion working copy; you should
delete the temporary structure and check out a fresh
working copy of the tree

The process can also be performed using TortoiseSVN's·

Repository Browser, which provides commands for
simply creating new folders directly in the repository
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Create a Local Working Copy
In order to use Subversion to provide Version Control of the
Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Create a Subversion working copy folder

Ste
p

Action

1 Choose or create a suitable directory on your system
in which to create your Subversion working copy.

2 Open a command prompt window and navigate to
the directory you have selected. For example:
     C:\> mkdir mySVNWorkSpace
     C:\> mkdir
mySVNWorkSpace/myEAModelName
     C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion
repository, specifying the repository folder and local
working copy folder, as well as your user name and
password. For example:
     C:\> svn checkout
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"https://myserver:8443/svn/repos_folder
     "C:\mySVNWorkSpace/myEAModelName"
     --username myUserName
     --password myPassword
(By specifying your Subversion username and
password, you ensure that they are correctly cached
by Subversion and available for use by Enterprise
Architect.)
If you specify the HTTPS protocol when performing
the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder.
Any files already existing in the repository folder are
downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions
correctly.

Notes

It is important that Subversion caches your username and·

password, so that it never has to prompt for user input; a
check-out operation might not request authentication, and
if it does not you should perform an action that does
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request authentication, such as adding and committing a
dummy test file

The process can also be performed using TortoiseSVN's·

Checkout command (which provides options to browse
when specifying both your repository folder and your
local folder); when prompted for authentication details by
TortoiseSVN, make sure you place a check against the
'Save Authentication Data' option

(c) Sparx Systems 2025 Page 279 of 417



Manage Model Change 2 September, 2025

Verify the SVN Workspace
After creating the Subversion local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
Subversion, lock the files and commit changes to those files.

Verify correct operation of a Subversion
working copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy, in the Subversion checkout command when
preparing the SVN workspace. For example:
     C:\> cd mySVNWorkSpace

3 Create a test file, such as Test.txt, containing the text
Subversion Test. For example:
     C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:
svn add Test.txt·
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svn commit -m"Commit comment" Test.txt·

svn update Test.txt·

svn lock Test.txt·

Use your preferred editor to modify the file and·

save the changes
svn commit -m"Second commit comment" Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
user ID or password; for further information, please see
the Caching Client Credentials topic in the official
Subversion documentation
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Subversion Under Wine-Crossover
If you want to set up and use Subversion with Enterprise
Architect under Wine, the process is almost identical to the
process for setting up and using the systems under
Windows. When running Enterprise Architect under Wine
or CrossOver, you still use a Windows-based Subversion
command line client.

There are some minor differences in the way you prepare
the Subversion working environment, specifically in the
way you install your Subversion client and the way you
check out a working copy folder from the Subversion
repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect
with Subversion under Wine 1.2, on macOS 10.4 and
10.6.2, and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx
Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https:
protocol.

Installing a Subversion Client

Wine is able to install applications from either a Windows
.exe file, or a .msi installer file.
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Place the installer for your Windows Subversion client in a
convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and
run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive
and folders that Enterprise Architect is accessing.
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Preparing a Subversion Environment
Under Wine
Under Wine, you can install Subversion from either a
Windows .exe file, or a .msi file. By performing your
Subversion installation and initial check out from a Wine
console window opened from within Enterprise Architect,
you have access to the same C: drive and folders that
Enterprise Architect is accessing.

Set up Subversion for use with Enterprise
Architect, running under Wine

Ste
p

Action

1 Start Enterprise Architect.
You do not have to load a project at this point.

2 From the 'Start' ribbon, select 'Appearance >
Preferences > Toolbars...
The 'Customize' dialog is opened.
Select the 'Tools' tab, then click on the  icon.
A new, blank entry is opened on the 'Tools' tab of
the 'Customize' dialog.

3 Define the new menu item entry:
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In the newly-opened 'Menu contents' field, type·

the name 'Wine Console'
In the 'Command' field, type 'wineconsole'·

In the 'Arguments' field, type 'cmd'·

Leave the 'Initial directory' field blank·

4 Click on the Close button.
The 'Customize' dialog closes.

5 Select the ribbon option: 'Settings > User Tools >
Wine Console'.
A Wine console window opens.

6 Type 'C:' and press the Enter key.
The Wine console switches to the C: drive.

7 Issue the command to install your Subversion client.
For example:
     C:\>/Installers/Subversion-client-1.9.5.win32.exe
To install from a .msi file, use Wine's msiexec
utility. For example:
     C:\>msiexec /i
"Installers\Slik-Subversion-1.9.7-win32.msi"
Installation of the Subversion command line client
begins.

8 Create a folder to serve as the working copy folder to
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be used by Enterprise Architect. For example:
     C:\>mkdir C:\VC_workspaces\SVN_workcopy

9 Issue the command to perform the initial checkout
from the Subversion repository, specifying the
repository folder, working copy folder, username
and password. For example:
     C:\>svn checkout
"https://myServer:8443/svn/repos_folder"
            "C:\VC_workspaces\SVN_workcopy "
            --username myUserName
            --password myPassword
(After you specify your Subversion username and
password, they are correctly cached by Subversion
and are available for use by Enterprise Architect.)
If the HTTPS protocol is specified when performing
the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder. Any files already
existing in the repository folder are downloaded to
the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.
The Wine console window closes.
You are now ready to load a project in Enterprise
Architect and apply Version Control to it, using the
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normal Windows-based procedures.

Notes

You should copy the installer for your Windows·

Subversion client to a convenient location on the native
file system, so that you can easily refer to it from within
the Wine console window in step 7
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TortoiseSVN
TortoiseSVN is a Windows shell extension for Subversion;
it provides icon overlays in Windows Explorer that are
useful as a tool for observing the status of your Subversion
controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within
Windows Explorer, using simple menu commands.

You can download TortoiseSVN from
http://tortoisesvn.net/downloads.html.

Notes

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe
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Create a TFS Environment
You can use Microsoft Team Foundation Server (TFS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and
configure the TFS server and client applications. A number
of basic tasks are performed in creating an operational TFS
environment.

Tasks in Creating a TFS Environment

Task Detail

Obtain and
install TFS

Enterprise Architect uses the TFS
command line client to integrate TFS
Version Control.
The TFS command line client is normally
available as part of your Visual Studio
installation.

Choose a
TFS project

It is good practice to create a new TFS
project, or least a new Source Control
Folder within a project, for each
Enterprise Architect project being added
to Version Control with TFS.
If you have a single Enterprise Architect
project that contains many different
models (for example, a DBMS hosted
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project with multiple model root nodes),
you might choose to create a new TFS
project for each separate model.
For further information, please consult
your TFS product documentation.

Create a TFS
workspace

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In TFS,
the TFS workspace is used to map a local
working folder on your PC to a Source
Control Folder within a TFS project.
TFS 2012 and VS 2012 (and later
versions) feature a new type of
workspace called 'local' workspaces. Do
not attempt to use TFS 'local' workspaces
with Enterprise Architect. You must use
only 'server' workspaces for Enterprise
Architect Version Control, as 'local'
workspaces do not support the

(c) Sparx Systems 2025 Page 290 of 417



Manage Model Change 2 September, 2025

application of checkout locks to files.
Enterprise Architect relies on the
presence of checkout locks to ensure that
Packages can only be checked out
exclusively and that a given Package is
not already checked-out in some other
project (for instance, in a Private Model
deployment). This is necessary because it
is not practical to merge the XMI
Package files that Enterprise Architect
uses for Version Control.
A single TFS workspace can map many
different local folders, each one to a
separate Source Control Folder. In this
case, TFS can take a long time to work
through and update the files in all of
those folders, and the system might
appear to 'freeze' whilst it waits for TFS
to hand back program control.
You can avoid this if you keep your
Version Controlled Package files in a
folder that is separate from other
Artifacts, such as source code files,
creating a separate work space to use just
for your Package files, or creating and
mapping a separate folder for Package
files within an existing workspace.

Configure The XMI format files used for the
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exclusive
check-outs

Version Control of Enterprise Architect's
Packages can not be merged as if they
were ordinary text files. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that TFS is configured to
use 'exclusive checkouts' for XML files.

Verify the
TFS
Workspace

Enterprise Architect uses the TFS
command line client to checkin and
checkout files from the TFS repository.
After creating the TFS workspace, it is
important to verify that the command line
client can be used to add, check-in and
check-out files residing in the working
copy folder that is mapped through this
workspace.

Notes

TFS can also be used with an SCC client; the MS·

TFS-SCC client is available for download from
Microsoft's web site

MDG Integration for Visual Studio 2005 or 2008·

enhances TFS support by providing access to, for
example, work items and bugs within both Enterprise
Architect and the MDG Integration product
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TFS Workspaces
In order to use TFS to provide Version Control of the
Packages in a model, you prepare a functional TFS
workspace that can be accessed through an Enterprise
Architect Version Control configuration within that model.
You use the TFS workspace to map a local working folder
on your PC to a Source Control Folder within a TFS project
repository.

It is assumed that have TFS 2013 open and a TFS Team
Project already exists for you to use in Version Control of
the Packages of your Enterprise Architect project. You can
create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local
workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx
Systems strongly advises against the use of Local
workspaces when Version Controlling your Enterprise
Architect Package files. Using Local workspaces carries a
high risk of merge conflicts when checking in, which would
almost certainly result in loss of data or a corrupted model
database.

Map a local folder to a TFS Source Control
Folder

Ste
p

Action
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1 Connect to your TFS server.
From the TFS main menu, choose 'View | Team
Explorer'.
In the Team Explorer toolbar, click on the Connect
to Team Projects button (fourth from left, with a
power plug icon).
The 'Team Explorer Connect' page displays.

2 Click on the link 'Select Team Projects...'
The 'Connect to Team Foundation Server' dialog
displays.

3 Click on the appropriate Team Foundation Server,
Team Project Collection and Team Project, then
click on the Connect button.

4 Click on the Home page of the Team Explorer, and
then on the Source Control Explorer button.
The Source Control Explorer view displays.

5 In the Source Control Explorer, click on the
drop-down arrow in the 'Workspace' field in the
toolbar, then click on 'Workspaces' at the bottom of
the list.
The 'Manage Workspaces' dialog displays.

6 Click on the Add button.
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The 'Add Workspace' dialog displays.

7 Click on the Advanced button.
A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace
and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is
important.
This setting is not available in TFS 2010 and earlier
releases, where all workspaces are Server based.

10 Click in the Source Control Folder column, then
click on the Browse button to select a Source
Control Folder.
Select the Source Control folder (in the Team
Project) to use for controlling Enterprise Architect
Packages.

11 Click on the Browse button in the 'Local Folder'
column and create a new local folder.
This is the working copy folder into which
Enterprise Architect exports the Package files.

12 Click on the OK button.
The new workspace is created and saved.
The 'Add Workspace' dialog closes.
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13 Click on the OK button.
The 'Manage Workspaces' dialog closes.

Notes

The local folder referenced in step 11 is the Working·

Copy Path that should be specified when defining an
Enterprise Architect Version Control Configuration to use
this TFS workspace
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TFS Exclusive Check Outs
The XMI format files used for the Version Control of
Enterprise Architect's Packages can not be merged as
ordinary text files can. Therefore Enterprise Architect must
enforce serialized editing of its Version Controlled
Packages, and it is important that Team Foundation Server
is configured to use 'exclusive checkouts' for XML files.
Otherwise, TFS can return file statuses that make it look as
if the Package file is not checked-out by another user when
indeed it is.

You set exclusive checkouts in the TFS workspace through
MS Visual Studio.

Configure TFS to enforce exclusive check
outs for XML files

Ste
p

Action

1 Using Visual Studio, from the main menu select
'View | Team Explorer'.

2 In the 'Team Explorer' pane, right-click on the TFS
Server name that is controlling the Enterprise
Architect Package files, then from the context menu
select 'Team Foundation Server Settings | Source
Control File Types'.
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3 Select the entry for XML files (or create an entry if
necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check
out' checkbox.
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Verify the TFS Workspace
Enterprise Architect will be using the TFS command line
client to commit file updates from the local working copy
folder into the TFS repository. After creating the TFS
workspace that maps your local working copy folder to a
TFS repository folder, it is good practice to verify that the
TFS workspace functions correctly before attempting to use
it with Enterprise Architect. You need to be able to add files
to TFS, place a check-out lock on the files and check-in
changes to those files.

Verify correct operation of a TFS Workspace

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the local
working copy folder when creating the TFS
workspace.
For example:
     C:\> cd  myTFSWorkingCopyFolder

3 Create a test file, such as Test.xml, containing the
text 'my TFS Test'. For example:
     C:\> echo my TFS Test > Test.xml
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(The filename extension '.xml' is used because the
TFS server should have been configured to allow
exclusive checkouts for XML files.)

4 Using the command line client, execute each of these
TFS commands:

tf.exe add Test.xml·

tf.exe checkin Test.xml /override:"Manual check·

in." /comment:"a message"
tf.exe checkout /lock:checkout Test.xml·

Use your preferred editor to modify the file and save
the changes.

tf.exe checkin Test.xml /override:"Manual check·

in."  /comment:"a message"
tf.exe get . /recursive·

Notes

All of the commands in step 4 should execute without any·

errors; in particular, you should be able to apply a
checkout lock when checking out the file

If the checkout command reports any errors, you might·

have to reconfigure the TFS workspace as a server based
workspace, or you might have to configure the TFS
Server to use 'exclusive checkouts' for XML files
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Create a CVS Environment
You can use Concurrent Versions System (CVS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a CVS administrator to install and
configure the appropriate software. A number of basic tasks
are performed in creating an operational CVS environment,
and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server
components

Executable files for CVS can be obtained
from March Hare Software.
CVS server components are available to
run on a wide range of different hardware
and operating systems; Enterprise
Architect is not affected by your choice
of server components.

Create a
repository

Please consult the official CVS
documentation.

Create CVS
users

Please consult the official CVS
documentation.
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Create a new
repository
module

It is recommended good practice to create
a new repository module in CVS for each
new Enterprise Architect model being
added to Version Control with CVS.
Users should create a new local working
copy folder from the module to be used
with that model.
A repository module represents a project,
or a set of related files in the repository.
TortoiseCVS can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for CVS can be obtained
from March Hare Software.
Enterprise Architect is a Windows based
application - it requires a Windows based
CVS command line client for integration.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
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associated with a folder that exists within
the Version Control repository. In CVS,
to create a local working copy you
perform an initial check-out of a folder
from the CVS repository; this downloads
a copy of the folder and its contents, to
create your local working copy.
TortoiseCVS can greatly simplify the
initial check out of a working copy
folder.

Setting up
CVS under
Wine/CrossO
ver

The process of setting up and using CVS
with Enterprise Architect under Wine is
almost identical to the process when
running natively under Windows, apart
from minor differences in installing the
CVS client and performing the initial
checkout of the working copy folder.

Notes

If you do not already use CVS for Version Control, you·

should consider using Subversion instead; Subversion's
client-server protocols provide a broader range of
possibilities for connecting to remote servers, with easier
set up of secure connections

TortoiseCVS is a Windows shell extension; Enterprise·

Architect cannot use TortoiseCVS as its client, it must use
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the CVS command line client
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Prepare a CVS Local Workspace
In order to use CVS to provide Version Control of the
Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Prepare a CVS Working Copy Folder

Ste
p

Action

1 Ask your System Administrator to install CVS and
create a remote repository, with a module that you
can use to control your Enterprise Architect Package
files.
Your administrator must create a username and
password for you before you can make a connection.

2 Select or create a suitable directory to use as your
CVS working copy directory.

3 Open a command prompt window and navigate to
your CVS working copy directory. For example:
     C:\> mkdir myCVSWorkSpace
     C:\> cd myCVSWorkSpace
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4 Log in to the remote CVS repository. For example:
     C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath login
Replace myUserID with your CVS username,
replace ServerName with the name of your CVS
server and replace reposPath with the path to the
repository on the server.
A prompt for a password displays.

5 Enter your password.
You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository
module, into the local working copy directory. For
example:
     C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath
checkout moduleName
(Replace moduleName with the name of the
repository module that you want to check out.)
A subdirectory is created in your current working
directory, with the same name as the module being
checked out.
Any files already existing in the repository module
are downloaded to the working copy folder as
working copy files.

7 Verify that your CVS environment functions
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correctly.

Notes

Much of the process can also be performed (more simply)·

using the TortoiseCVS command 'Make New Module'
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Verify the CVS Workspace
After creating the CVS local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
CVS, and commit changes to those files. You also need to
be able to register as an editor of the file and retrieve the list
of currently registered editors.

Verify correct operation of a CVS working
copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy in the cvs checkout command, when preparing
the CVS workspace. For example:
     C:\> cd myCVSWorkSpace

3 Create a test file, such as Test.txt, containing the text
CVS Test. For example:
     C:\> echo CVS Test > Test.txt
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4 Execute these CVS commands:
cvs add Test.txt·

cvs commit -m"Commit comment" Test.txt·

cvs update Test.txt·

cvs edit Test.txt·

cvs editors Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.
The editors command should produce output that
resembles this:
     Test1.txt myUserID Tue Aug 9 10:08:43 2009
GMT myComputer
     C:\myCVSWorkSpace\moduleName

5 Take note of the userID that follows the filename.
Enterprise Architect must find and use this user ID
when you create your Version Control configuration.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
input, such as user ID or password
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TortoiseCVS
TortoiseCVS is a Windows shell extension for CVS; it
provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your CVS controlled
files. You can also use it to create your repository modules
and check out local working copies from within Windows
Explorer using simple menu commands.

You can download TortoiseCVS from:
http://www.tortoisecvs.org.

Notes

Enterprise Architect must use the CVS command line·

client to communicate with the CVS server; it cannot use
TortoiseCVS
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Create an SCC Environment
You can use a Microsoft Common Source Code Control
(SCC) compatible product as a Version Control provider for
Enterprise Architect. The first step in doing this is for an
administrator to install and configure the server and client
applications. A number of basic tasks are performed in
creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail

Install and
configure
your chosen
Version
Control
product

A Version Control server component is
typically installed on a dedicated server
machine. All Enterprise Architect users
who require access to Version Control
must be able to connect to the server
machine.
After installing the Version Control
software, the administrator should also
create Version Control user IDs for all
users who require access to Version
Control.
For further information, consult the
product documentation for your particular
Version Control product.
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Create a new
SCC project

It is good practice to create a new SCC
Version Control project, or least a new
folder within a project, for each
Enterprise Architect project being added
to Version Control with SCC.
If you have a single Enterprise Architect
project that contains many different
models (for example, a DBMS hosted
project with multiple model root nodes),
you might choose to create a new SCC
Version Control project for each separate
model.
For further information, consult the
product documentation for your particular
Version Control product.

Configure
your SCC
project to
support
exclusive
check-outs
for .XML
files

The XMI-format files used for the
Version Control of Enterprise Architect
Packages can not be merged in the same
way as ordinary text files can. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that your Version Control
application is configured to use 'exclusive
checkouts' for XML files.

Create a local
working copy

A working copy folder must exist on each
users' machine, for Enterprise Architect

(c) Sparx Systems 2025 Page 313 of 417



Manage Model Change 2 September, 2025

folder to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. Your
Version Control product provides some
means by which you associate a working
copy folder with a repository folder.
For further information, consult the
documentation for your particular
Version Control product.

Notes

When installing the client component software on users'·

PCs, check that the SCC client is also installed, as it might
not be a part of the default installation
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Upgrade at Enterprise Architect
Version 4.5, Under SCC Version Control
If you are working in Enterprise Architect release 4.5 or
later and you open an SCC Version Controlled project that
was created under a release earlier than 4.5, you must
identify the SCC connection with a new unique ID. You can
assign a name to the existing SCC configuration or associate
the project with another configuration that has previously
been assigned a unique ID.

By having a unique ID for each Version Control
configuration, you can assign a configuration quickly and
efficiently using configurations that have been created
previously for other Version Controlled repositories. This
enables you to configure the many Packages to use an
existing Version Control repository; this can apply to
Packages created for more than just one model enabling a
great deal of flexibility.

Upgrade an existing SCC Version Controlled
project created before release 4.5, in
Enterprise Architect release 4.5 or later

Ste
p

Action

1 Open the project that has an SCC Version Control
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configuration created in Enterprise Architect earlier
than version 4.5.
The 'Select or Create Unique ID for Version Control'
dialog automatically displays.

2 On the dialog, either create an ID for an existing
configuration or choose a previously created one
from the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value,
represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended
that the configuration be given a meaningful name.

4 You can associate the Version Controlled Package
with a previously-defined configuration by selecting
an existing configuration from the 'Unique ID'
drop-down list (if one exists).

5 After you have assigned the unique ID, click on the
OK button to load the model.
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Version Control Configuration
Once you or an Administrator have installed and configured
the Version Control product software, to start using Version
Control you must first define a Version Control
configuration within your project in Enterprise Architect, to
be used to control the Packages in the project. You can
define any number of Version Control configurations in a
single model, but any given Package is associated with only
one configuration.  Typically, a single Version Control
configuration is used to control all of the packages within a
model.

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings

Define Version Control Configuration

Ste
p

Action
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1 On the 'Version Control Settings' dialog, click on the
New button.

2 In the 'Unique ID' field, type a suitable configuration
name.

3 Select the Type of Version Control product you are
connecting to, by clicking on the corresponding
radio button.

4 At this point, the middle section of the dialog
changes to display a collection of fields specific to
the type of Version Control configuration you are
defining.
Enter details relating to the Version Control
workspace that this configuration is to use.

5 Click on the Save button. The new configuration is
added to the Defined Configurations list.

6 If you want to create another Version Control
configuration, return to step 1.
When you have finished defining your Version
Control configurations, click on the Close button.

Notes
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Version Control Configuration details are stored in the·

user's Windows Registry settings, but each project stores a
list of the configurations it uses, so that Version Control
connections can be initialized as the project is being
loaded

If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, the
administrator must also set up access permissions to
configure and use Version Control
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Version Control Settings
Defining Version Control settings within Enterprise
Architect should only be performed after you have
successfully created the Version Control environment that
you intend to use to control your Package files. If you have
not yet done so, please refer to the Help topic Applying
Version Control in a Team Environment for a summary of
what is required.

To set up a Version Control configuration on your model, or
update an existing Version Control configuration, you
define a number of settings that control how the status of
your model is communicated to your Version Control
system. You define these settings using the 'Version Control
Settings' dialog.

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings

Configuration Options
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Option Action

This model is
private

Select to specify that this model database
is to be accessed by just a single user
(Private Model).
Leave unselected (the default) or deselect
to specify that the database is to be
accessed by multiple concurrent users
(Shared Model).
If in doubt, use the default setting.

Save nested
Version
Controlled
Packages to
stubs only

Select to specify that the exported XMI
file for a Version Controlled Package will
contain Package stubs (place holders) for
nested Version Controlled child Packages
(recommended).
Deselect to specify that the exported XMI
file will contain the full content of nested
Version Controlled child Packages.

For all
Packages,
create
placeholders
for external
references

Select to force all XMI 1.1 imports across
the model to exclude incoming
relationships and instead create external
references.
If the 'Create placeholders for missing
External References during XMI 1.1/2.1
and Native File Import' checkbox is not
selected in the XML Specifications
options for a user, this field overrides that
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setting.
The XML Specifications Help topic
provides an example of the benefits of
selecting this option.

Unique ID Specify a name that uniquely identifies
the configuration. Either:

Type a name to identify a new·

configuration, or
Click on the drop-down arrow and·

select the name of a configuration
previously defined in a different project
(if any exist)

Type Click on the appropriate radio button for
the type of Version Control system you
are associating with this configuration.
The middle section of the dialog changes
to display a collection of fields relating to
the type of Version Control configuration
you are defining.
Set the type to SCC for:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

For any other product that you are using,
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select the type that matches the product -
CVS, Subversion or TFS.

New Click on this button to clear the fields and
create a new Version Control
configuration.

Save Click on this button to save the details of
a new or updated configuration.

Delete Click on an entry in the Defined
Configurations list and click this button
to remove the definition of the selected
configuration from this model.

Defined
Configuratio
ns

Review a list of configurations that are in
use in the current model.

In future, do
not prompt
for
incomplete
configuration
s

Select to specify that the user is not
prompted to complete the definition of
configurations that are not fully specified
(the default).
Deselect to prompt the user to complete
configurations that are not fully defined.

Close Close the 'Version Control Settings'
dialog.
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Help Display this Help topic.

Notes

It is important that, for any given Version Controlled·

Package file, any user accessing that file from any model
uses Version Control configurations having the same
Unique ID

When you first open a model that was created by another·

user and that uses Version Control, the Version Control
configuration(s) used by that model do not yet exist in
your Windows registry settings; you have to complete the
definitions of those configurations before you can use
Version Control in that project

If User Security is enabled, you must have 'Configure·

Version Control' permission to set up Version Control
options for the current model

It is possible to use multiple Version Control·

configurations in the same model
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SCC Settings
When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'SCC', the dialog presents a
set of fields specific to SCC-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The details necessary to connect to the SCC Version·

Control system

You set the Version Control configuration type to SCC for
version Control providers such as:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

Access

Ribbon Settings > Version Control > Project-VC
: Type: SCC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: SCC

(c) Sparx Systems 2025 Page 325 of 417



Manage Model Change 2 September, 2025

Settings

Option Action

Local Project
Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the Local
Project Path, by opening a file browser
dialog and navigating through the file
system to the appropriate folder.

After you choose the appropriate folder·

path, the 'Select SCC Provider' dialog
displays, listing all SCC providers that
are installed on the current workstation;
choose the SCC provider to use and
click on the OK button
At this point, the SCC client opens its·

own dialog to prompt you for
information; SCC products implement
this functionality in varied ways, but
typically you are prompted to log in to
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the Version Control system, then
prompted to choose the SCC project to
use and possibly a (server) folder
contained within that project
At the conclusion of this process, all of·

the SCC details should be filled in; you
can then save the definition by clicking
on the Save button on the 'Version
Control Settings' dialog

Current User Displays the user name used to log on to
the Version Control system that is
accessed through this configuration.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC
Provider

Displays the name of the SCC provider.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project
that this configuration attaches to.
This field is read-only; the value it
displays is retrieved from the SCC client.

Notes
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You define the SCC-specific details as part of the broader·

process of setting up a Version Control Configuration on
the 'Version Control Settings' dialog
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CVS Settings
When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to CVS, the dialog presents a
set of fields specific to CVS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The path to the CVS command line client·

Access

Ribbon Settings > Version Control > Project-VC
: Type: CVS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: CVS

Settings

Option Action

Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the

(c) Sparx Systems 2025 Page 329 of 417



Manage Model Change 2 September, 2025

XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
working copy path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Current User This field is read-only; its value is
retrieved from a file named CVS\Root,
located in the folder selected using the
Select Path button.

CVS Exe
Path

Displays the full path of the CVS
command line client executable file.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to specify the path to
the CVS command line client, by opening
a file browser dialog and navigating
through the file system to locate the
appropriate file.

VC
Time-Out

Specify the amount of time that
Enterprise Architect waits for a CVS
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Value command to complete; if the command
does not complete within the allowed
time, the system displays a Time-out
error message, detailing the command
that failed to complete.
This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

When connecting to a remote CVS repository, the·

'Current User' field should display the user name used to
log into that repository; if this does not happen, it
indicates that Enterprise Architect cannot extract the user
name from the file ...\WorkingCopyPath\CVS\Root and
the configuration does not work correctly

You define the CVS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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SVN Settings
When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'Subversion', the dialog
presents a set of fields specific to Subversion-based
configurations. You can then define details such as:

The working copy folder to be used with the configuration·

The path to the Subversion command line client·

Access

Ribbon Settings > Version Control > Project-VC
: Type: Subversion

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: Subversion

Settings

Option Action

Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
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XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
Working Copy Path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Subversion
Exe Path

Displays the full path of the Subversion
command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the Subversion command line client, by
opening a file browser dialog and
navigating through the file system to
locate the appropriate file.

VC
Time-Out
Value

Specify the amount of time that
Enterprise Architect should wait for a
Subversion command to complete; if the
command does not complete within the
allowed time, the system displays a
Time-out error message, detailing the
command that failed to complete.
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This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

You define the Subversion-specific details as part of the·

broader process of setting up a Version Control
configuration on the 'Version Control Settings' dialog
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TFS Settings
When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'TFS', the dialog presents a
set of fields specific to TFS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The user name and password to log in to the TFS server·

The path to the TFS command line client·

Access

Ribbon Settings > Version Control > Project-VC:
Type: TFS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: TFS

Settings

Option Action

Working Displays the full path of the folder that
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Copy Path contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to choose the
Working Copy Path. The file browser
dialog opens, through which you navigate
through the file system to the appropriate
folder.

Server Name Displays the name of the TFS Server that
is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.

Workspace
Name

Displays the name of the TFS Workspace
that is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.

User Name Type in the user name with which to log
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into the TFS Server.

Password Type in the password with which to log
into the TFS Server.

Display
Name

TFS 2013 and later releases use a Display
Name to report on who owns a checkout
lock on a file. TFS 2010 uses AccountID
when reporting lock owners and so does
not require a Display Name.
If using TFS 2013, type in your TFS
Display Name as shown in the User
column of the Visual Studio Source
Control Explorer when you checkout a
file.

Checkout
Locks
Required

This checkbox defaults to selected.
TFS 2013 supports the use of Local
workspaces, but these do not support
checkout locks. If you want to use TFS
Local workspaces (not recommended),
you must deselect this checkbox.
Otherwise, leave the checkbox selected.
It is recommended that all workspaces
used for Version Controlling Enterprise
Architect Package files are set as 'Server'
workspaces.

TFS Exe Path Displays the full path of the TFS
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command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the TFS command line client.
The file browser dialog opens, through
which you navigate through the file
system to the appropriate folder.

VC
Time-Out
Value

Type in the number of seconds that
Enterprise Architect should wait for a
TFS command to complete; if a
command does not complete within this
allowed time, the system displays a
Time-out error message, detailing the
command that failed to complete.
This single time-out value is applied to
all Version Control configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

If you automatically log in to TFS through a path external·

to Enterprise Architect (for example, through MS
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Integrated Security), you can leave the 'User Name' and
'Password' fields blank

If the 'Password' field is blank, Enterprise Architect·

retrieves your Windows username and uses that value
when determining whether a Package file is checked out
to you or to another user

TFS Version Control can also be accessed using the TFS·

MSSCCI client; to make use of the TFS MSSCCI client,
please define an SCC based Version Control
configuration

You define the TFS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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Re-use an Existing Configuration
Once a Version Control configuration has been defined for
use in one project, it is possible to re-use that configuration
in other projects to provide access to:

An already existing Version Control environment (a·

working copy directory and its associated repository that
is already in use)

Version Controlled Packages that were created (and·

Version Controlled) in another project

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Browser window | right-click on Package
| Package Control | Version Control
Settings

Select existing configuration

Ste
p

Action

1 On the 'Version Control Settings' dialog, click on the
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New button.
The various fields on the dialog are cleared, ready
for data entry.

2 In the 'Unique ID' field, click on the drop-down
arrow and select one of the previously-defined
Version Control configurations.
The details of the selected configuration are
displayed in the dialog.

3 Click on the Save button.
The configuration details are saved and are ready for
use in the current project.
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Applying to Packages
Version Control in Enterprise Architect operates at a
Package level. Any Package in the repository can be put
under Version Control and assigned to any Version Control
Configuration. This means that different Packages can be
controlled by different Version Control systems.  However,
in typical usage, all packages in a model will be controlled
by just one Version Control configuration.

The Package Control Options window showing the setting
for the selected Package.
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Configure Controlled Package
Once your Version Control application is set up and you
have Version Control configurations in place, you can place
the individual Packages in your model under Version
Control. To put a Package under Version Control, you:

Flag the Package as a controlled Package·

Specify the Version Control configuration to control it·

and

Associate an XMI file with the Package·

You can then export and import the Package data to and
from the file and issue commands to the Version Control
system.

Access

Ribbon Settings > Version Control >
Package-VC

Keyboard
Shortcuts

Ctrl+Alt+P

Apply Version Control to a single Package
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Ste
p

Action

1 Click on the 'Control Package' checkbox to select it,
indicating that this Package is to be controlled.

2 Click on the 'Version Control' drop-down arrow and
select the Version Control configuration to be used
to control this Package.

3 The 'XMI Filename' field displays a default filename
for the Package export file, based on the Package
name.
Optionally, modify the filename. Either:

Type a new name, or·

Click on the  button to open a file selection·

dialog
The target file must be located within the working
copy folder of the selected Version Control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.
Optionally, change this to a different version
number.

5 The 'Owner' field defaults to your user name.
Optionally, type or select the name of the user who
actually owns the Package.
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6 Click on the OK button.
The 'Add Package to Version Control' dialog
displays.

7 Optionally, clear the 'Keep checked out' checkbox.
After applying Version Control, the Package either
remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.
The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default
comment.
Enterprise Architect provides a default comment that
includes the current date & time.

10 Click on the OK button.
The current Package is exported to the nominated
XMI file, which is then committed to Version
Control. The Package icon in the Browser window is
updated to reflect the Package's Version Control
status.

Notes
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If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, these features
are only available to users who have been granted
permission to configure and use Version Control
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Browser Window Indicators
Packages under Version Control are identified in the
Browser window by icons that indicate the current status of
the Package.

Indicators

Icon Indicates that

This Package is Version Controlled and
not checked out to you.
You cannot edit the Package (until you
check out the Package yourself).

This Package is Version Controlled and
checked out to you.
You can edit the Package.

This Package is Version Controlled, but
you checked it out whilst not connected
to the Version Control server.
You can edit the Package but there could
be version conflicts when you check the
Package in again.

This Package is controlled and is
represented by an XMI file in the file
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management system, but it is not under
Version Control.
You can edit this Package.
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Apply Version Control To Branches
It is possible to apply Version Control to all Packages within
a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently
selected in the Browser window, and all of the Packages
contained within it.

Access

Context
Menu

Browser window | right-click on Package
| Package Control | Add Branch to
Version Control

Apply Version Control to all Packages within
a selected model branch

Ste
p

Action

1 On the 'Apply VC to Branch' dialog, click on the
drop-down arrow in the 'Version Control
Configuration' field and select the configuration to
use.
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2 Optionally, tick the checkbox 'Export as Model
Branch'.
Once the Version Control operation is complete a
Model Branch file (.EAB file) is created for this
branch.

3 Click on the OK button.
The system creates a number of sub-folders within
the Version Control working copy folder, then
exports all of the Packages within the selected model
branch. The system generates filenames for the XMI
files, based on the Package GUIDs.

Notes

The Version Control configuration to be used in this·

operation must be defined within the model before
selecting this command

When invoked on the model root node, this command·

applies Version Control to every Package within the
model
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Fundamental Usage
Once your Version Control product is installed and you
have created a suitable environment, Enterprise Architect
can make use of that environment to control the Packages in
your project. The fundamental Version Control functions are
outlined in this table.

Fundamental Functions

Facility Detail

Define
Version
Control
Settings

Version Control Configurations are used
by Enterprise Architect to communicate
with your Version Control system.
You define one or more Version Control
configurations in your project and then
use those configurations to control the
Packages in your project.

Configure a
Package

To put a Package under Version Control
you mark the Package as a controlled
Package, specify the Version Control
configuration to control it, and associate
an XMI file with the Package.

Check Out a
Package

Checks out the Version Controlled
Package currently selected in the Browser
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window, so that you can update modeling
objects within it.

Undo Check
Out of a
Package

Reverses the check-out of a Package,
discarding any modifications that have
been made by restoring the Package
content to the latest revision held in
Version Control.

Check In a
Package

Checks in the Package currently selected
in the Browser window.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check In a
Model
Branch

Checks in all Packages involved in a
particular unit of work, as a single
operation.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check Out a
Model
Branch

Checks out all Packages within a selected
model branch as a single operation, so
that you can update modeling objects
within them.

Import a
Package

Retrieves Packages from Version Control
that have been created by other users, or
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From
Version
Control

by you in another model, and imports
them into your current model.

Apply
Version
Control to a
Model
Branch

Applies Version Control to all Packages
within the selected model branch, in a
single operation.
In this context, a model branch is a
Package in the Browser window, and all
of the Packages contained within it.

View
Package
Revision
History

Displays the change history of Version
Controlled Packages.
You can also check out a prior revision of
the Package for editing, effectively
rolling-back to a prior revision of the
Package.
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Package Version Control Options
When you have set up a Package for Version Control, you
gain access to a range of Version Control operations that can
be performed on that Package, such as:

Open the dialog for working with baselines of the·

Package

Check-in and check-out single Packages or a selected·

hierarchy of Packages

Update Packages to the latest revision from the Version·

Control repository

Inspect the revision history or properties of the XMI file·

associated with a Package

Revert a Package to a previous revision·

Compare the current model content of a Package, against·

the latest revision of the Package in Version Control

Import and export hierarchies of Packages (model·

branches) to and from the model, through the Version
Control system

Synchronize the status of a Package, with the Version·

Control system

Access

Context
Menu

Right-click on Version Controlled
Package > Package Control
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Options

Option Action

Check In
Branch

Check-in Packages contained in the
currently selected model branch (that is,
the selected Package and all of its child
Packages).
The 'Select Packages to Check In' dialog
lists all Version Controlled Packages
within that branch that are checked out to
you; you can then select Packages in the
displayed list, to be submitted for
check-in.
You can also choose to keep the
Packages checked-out after committing a
new revision to Version Control.

Check Out
Branch

Recursively check out all Packages
contained within the currently selected
model branch (that is, the selected
Package and all of its child Packages)
that are Version Controlled and
checked-in.

Check In Commit a new revision of the currently
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selected Package to the Version Control
repository and lock the Package against
further editing.
Only available for Packages that you
have checked-out yourself.

Check Out Synchronize the currently selected
Package with the latest revision from the
Version Control repository and unlock
the Package to allow editing.
Only available for Packages that are not
already checked-out (and whose
associated Package file is not
checked-out).

Undo Check
Out

Restore the selected Package to the latest
revision in the Version Control repository
and lock the Package against further
editing.

Put Latest Commit a new revision of the currently
selected Package to the Version Control
system, while keeping the Package
checked-out.
This is equivalent to checking a Package
in and immediately checking it back out
again.
Only available for Packages that you
have checked-out yourself.
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Get Latest Synchronize the currently selected
Package with the latest revision from the
Version Control repository.
Available only for Packages that are
checked in.

Get All
Latest

Updates all of the Version Controlled
Packages in the project, to the latest
revision retrieved from Version Control.
Only updates Packages that are currently
checked in.
Once the latest revisions are retrieved, the
system scans all the controlled Packages
and fixes any missing cross-references by
comparing the Package with its XMI 1.1
file.
If the cross-reference information in the
XMI does not match the model, the
system updates the model with the
information from the XMI and records
this update in the System Output window.
You can roll back such updates by
selecting the entry in the System Output
window and using the context menu
option 'Rollback Update' (or 'Rollback
Selected Updates' if multiple entries are
selected).

Closing the model clears the entries in·
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the System Output window
An entry in the System Output window·

is also cleared as and when you
roll-back the update for it

Scan XMI
and
Reconcile
Model

Scan the Package XMI files associated
with each of the project's controlled
Packages and restore any diagram objects
or cross-references that are detected as
missing from the project.
This function is useful in team
environments where each user maintains
their own private copy of the model
database (that is, multiple private project
files) and model updates are propagated
through the use of controlled Packages. It
provides no benefit when the model is
hosted in a single shared database that is
accessed by all team members.
Each controlled Package is compared
with its associated XMI file and, if the
cross-reference information in the model
does not match the XMI, the system
updates the model with the information
from the XMI and records the update in
the System Output window.
You can roll back such updates by
right-clicking on the entry in the System
Output window and selecting the
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'Rollback Update' option (or 'Rollback
Selected Updates' if multiple entries are
selected).
Closing the model clears the entries in the
System Output window; an entry in the
window is also cleared as and when you
roll-back the update for it.
This functionality is invoked
automatically as part of the 'Get All
Latest' operation.
When working in an environment that
uses a Private Model deployment and
your model contains a significant number
of cross-Package references, it is
recommended that you invoke 'Scan XMI
and Reconcile Model' from time to time,
following the re-importation of controlled
Packages - for example, after using 'Get
Latest' to update a number of Packages -
or after performing a number of Package
check-outs.
As a general rule, avoid running 'Scan
XMI and Reconcile Model' while you
have uncommitted changes in your
model; generally, you:

Check-out a number of Packages·

Invoke 'Scan XMI and Reconcile·

Model'
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Make your modifications·

Commit any outstanding changes·

before you check-out more Packages
and run 'Scan XMI and Reconcile
Model' again

File
Properties

Display Version Control properties
pertaining to the XMI export file
associated with the currently selected
Package; this also identifies who has
checked out the Package.

File History Display change history information for
the currently selected Package.
Revert to or check-out a prior revision of
the Package.

Compare
with
Controlled
Version

Compare the currently selected Package
with the latest revision of its associated
XMI file retrieved from Version Control.

Add Branch
to Version
Control

Apply Version Control to all Packages
within a selected model branch, in a
single operation.
In this context, a model branch is a
Package that is currently selected in the
Browser window, and all of the Packages
contained within it.
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Export as
Model
Branch

Export a newly created model branch
from your own private copy of a model.

Import a
Model
Branch

Retrieve a model branch and import it
into either the source model or another
model.

Get Package Access Packages in the Version Control
repository that are not currently available
in your model.

Re-synch
Status With
VC Provider

Update the Version Control status value
recorded for the selected Package in the
project to match the value reported by the
Version Control provider, without
performing an XMI import or export.
Use this function when the Package's
Version Control status recorded in your
project is out of synchrony with the
Version Control status reported by your
Version Control provider.

Version
Control
Settings

Display the 'Version Control Settings'
dialog.
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Notes

You set up Version Control using options from the project·

'Version Control' submenu

If the selected Package is not under Version Control, a·

different set of options is available

If a Version Control configuration has not been defined·

for the model, no options for using Version Control are
available, only the options for configuring Version
Control
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Check Out a Package
When you need to work on a Version Controlled Package,
you check it out. The local XMI file associated with the
Package is then checked-out from Version Control. No other
user can check out the Package to make changes to it until it
has been checked in again.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out

Keyboard
Shortcuts

Ctrl+Alt+L

Check out a single Package

The Package file is imported into your model, and the
'Package' icon is updated to reflect the change in the
Package's Version Control status.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version
Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.
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These options are available:

Force Reload From XMI - reload the Package from XMI·

regardless of whether it is up to date or not

Accept current Package - select to skip the process of·

re-importing the Package from XMI

Refresh model view - select to refresh the Browser·

window and diagrams, by reloading the Package content
from the project database

Always use these settings - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

If you check out a Version Controlled Package whilst·

offline, the 'Package' icon has a red figure 8 in front of it

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
Package' dialog, press the Ctrl key whilst you select the
'Package Control | Check Out' context menu option; the
dialog displays and you can change the settings
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Undo Check Out of a Package
If you check out a Package and then decide not to proceed,
you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the
latest revision held in Version Control. The Package returns
to a checked-in state and subsequently can be checked out
by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out
and starting again.

Access

Context
Menu

Right-click on Package > Package
Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from Version
Control and re-imported into your model. The icon against
the Package in the Browser window is updated to reflect the
change in the Package's Version Control status.
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Check In a Package
When you have finished working on the contents of a
Package under Version Control, and you want to return it to
the model for other users to see, you check it in.

Access

Context
Menu

Right-click on Package > Package
Control > Check In

Keyboard
Shortcuts

Ctrl+Alt+S

Check in a single Package

Ste
p

Action

1 The selected Package is exported and the 'Add
Comment' dialog displays. A default comment is
provided that contains the current date and time.
Optionally, modify the default check-in comment

2 Click OK.
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The Package file is checked-in to Version Control
and the Package icon is updated to reflect the change
in Version Control status.
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Check Out a Model Branch
If you need to check out a number of related Packages
involved in a particular unit of work, to update the contents,
you can do so in a single operation by checking out the
whole model branch that contains them.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out Branch

Check out a sub-tree of model Packages

Ste
p

Action

1 The selected root-node Package and all of its
contained sub-Packages are recursively checked out.
Any Packages that cannot be checked-out are listed
in a message box, with a brief description of the
problem; for example: The Package is already
checked out by user 'Fred'.

2 When Project Security is enabled in Lock to Edit
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mode, Enterprise Architect prompts you to apply a
User Lock throughout the selected model branch
before proceeding.
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Check In a Model Branch
If you need to check in a number of related Packages
involved in a particular unit of work, and that you have
updated, you can do so in a single operation by checking in
the whole model branch that contains them. You can also
commit new revisions of the affected Packages as you
complete milestones, whilst keeping the Packages
checked-out for further editing.

Access

Context
Menu

Right-click on Package > Package
Control > Check In Branch

Check in Packages from within a model
branch

Ste
p

Action

1 The 'Select Packages to Check-in' dialog lists all
Version Controlled and checked-out Packages within
the selected model branch. By default, the entire list
is selected.
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Optionally:
Click an individual Package to select just that·

Package
Ctrl+click on an individual Package to add or·

remove it from the selection
Shift+click on a range of Packages to select them·

Click on the All button to select all listed Packages·

Click on the None button to clear the selection·

2 Optionally, you can commit into Version Control a
new revision of all selected Packages, while keeping
those Packages checked out for further editing. To
do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.
The 'Add Comment' dialog displays. A default
comment is provided that contains the current date
and time. This comment is applied to all Packages
that are checked in.

4 Optionally, modify the default check-in comment.

5 Click on the OK button.
The selected Packages are exported and checked-in.
The Package icons are updated to reflect any change
in Version Control status. If you opted to keep
Packages checked out, there is no change in status.
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Update to the Latest Revision of
Selected Package
When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates from Version Control into the selected
Package in the Browser window.

Access

Context
Menu

Right-click on Package > Package
Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to
the latest revision from Version Control. The XMI file is
imported into your model database, updating the Package in
your model.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version
Control, then the 'Import Package' dialog displays first. This
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dialog is not displayed for a Shared Model.

These options are available:

'Force Reload From XMI' - reload the Package from XMI·

regardless of whether it is up to date or not

'Accept current Package' - select to skip the process of·

re-importing the Package from XMI

'Refresh model view' - select to refresh the Browser·

window and diagrams, by reloading the Package content
from the project database

'Always use these settings' - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

The 'Get Latest' command is disabled for any Package that·

is checked-out (to anybody) in the currently loaded
project

When using a Shared Model environment, where all users·

are connected to a single model database, you should
reload the Package from the database, rather than using
the 'Get Latest' command

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
Package' dialog, press the Ctrl key whilst you select the
'Package Control | Get Latest' context menu option; the
dialog displays and you can change the settings
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Update to the Latest Revision of All
Packages
When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates to all Version Controlled Packages into the
currently loaded project.

Access

Context
Menu

Right-click on Package > Package
Control > Get All Latest

Update all Packages in project to latest
revision retrieved from Version Control

All the local XMI files for all the Version Control
configurations used in the project are updated to the latest
revision from Version Control. The system then scans the
Packages in the model, to determine which ones are up to
date and which are not, compared to the latest revisions of
the associated Package files.

A prompt displays, providing these import options for
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Packages that are up to date:

Import changed files only·

Always import·

Prompt for each file·

Click on the OK button. The Version Controlled Packages
in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a
prompt displays to confirm import of each file.

Notes

There is no need to re-import Packages that are already up·

to date - re-importing Packages first deletes them from the
project and then re-imports them from the XMI file,
which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import
changed files only'

The 'Get All Latest' command does not update any·

Package that is checked-out (to anybody) in the currently
loaded project; otherwise, any changes not yet committed
to Version Control would be discarded

When using a Shared Model environment, where all users·

are connected to a single model database, the information
in the model database is always the same as, or ahead of,
what is committed into Version Control; in this situation,
the Get All Latest command will simply refresh your view
of the model database, by reloading diagrams or reloading
Package content in the Browser window
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Review Package History
It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package

Ste
p

Action

1 For Version Control environments using Subversion,
CVS or TFS command line clients, the 'File Version
History' dialog displays.
Click on a revision number in the 'Revisions' field, to
select that revision and view its log entry.
For Version Control environments using SCC based
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clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can
optionally click on either:

Check Out - the selected revision of the Package·

file is retrieved from Version Control and
imported into your model as a Package that is
checked out for editing; you can subsequently
check in this revision as a new HEAD revision,
effectively allowing you to revert the Package to a
prior revision
or
Retrieve - the selected revision of the Package file·

is retrieved from Version Control and imported
into your model, but the Package remains flagged
as checked-in and cannot be modified;
subsequently checking out the Package updates it
to the latest revision before it is unlocked for
editing

Notes

If the selected Package was already checked out in the·

current model, the Retrieve and Check Out buttons are
disabled

If the selected Package contains any sub-Package that is·

already checked-out in the current model, a warning will
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be displayed and the retrieval or check-out will not go
ahead

If you check out a prior revision of a Package, but do not·

want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client
It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package. The process for reviewing the
change history of Packages configured for Version Control
with an SCC client (including products such as Visual
Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and
MKS Source Integrity) differs from that for Subversion,
CVS or TFS command line clients.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package (SCC client)

Ste
p

Action

1 The change history mechanism offered by the third
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party SCC provider displays.
To import a prior revision of the Package into your
model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a
different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the
prior revision.

3 Optionally, click on either:
Yes, to check out the prior revision - the selected·

revision of the Package file is retrieved from
Version Control and imported into your model as a
Package that is checked out for editing; you can
subsequently check in this revision as a new
HEAD revision, effectively reverting the Package
to the prior revision
OR
No, to import the prior revision as read-only - the·

selected revision of the Package file is retrieved
from Version Control and imported into your
model, but the Package remains flagged as
checked-in and cannot be modified; subsequently
checking out the Package updates it to the latest
revision before it is unlocked for editing
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Notes

If the selected Package was already checked out in the·

current model, the system does not proceed with
retrieving a prior revision

If you check out a prior revision of the Package, but do·

not want to commit it as a new revision, right-click on the
Package and select 'Package Control | Undo Check Out'
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Retrieve Prior Revision - SCC Client
Depending on your Version Control product, retrieving a
prior revision of a controlled Package can involve a number
of prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a
TFS-SCC Version Control configuration.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Example Procedure - retrieve prior revision,
TFS-SCC client

Ste
p

Action

1 Display the 'TFS File History' dialog.

2 Click on the Get button.
The TFS-SCC client displays the 'Resolve Conflicts'
dialog.
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This dialog offers the 'Automerge All XML Package
files' option. DO NOT select this option.
It is important to prevent any merging of Enterprise
Architect's XML Package files.

3 Click on the Resolve button.
The TFS-SCC client displays the 'Resolve writeable
file conflict' dialog.

4 Select the 'Overwrite local file/folder' option.
The existing working copy of the Package file is
overwritten by the prior revision retrieved from
Version Control.

5 Click the OK button.
The TFS-SCC client redisplays the 'Resolve
writeable file conflict' dialog; it should now show no
conflicts.

6 Click on the Close button.
The TFS-SCC client redisplays the 'File History'
dialog.

7 Click on the Close button.
Enterprise Architect displays a prompt, asking
whether to check-out the prior revision.

8 Click on the:
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Yes button to check-out the prior revision·

No button to retrieve a read-only version of the·

Package, that is NOT checked-out and is NOT
editable
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Advanced Usage
Once you get familiar with using the fundamental functions
of Version Control there are a number of more advanced
functions that you might want to use in working with your
models. The advanced Version Control functions are
outlined in this table.

Advanced Functions

Export a
Version
Controlled
Model
Branch

Exports Version Control information
about the root Package of a model
Branch, that is used to simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

Include Other
Users'
Packages

Other users might be developing
Packages in their own models that you
could use in your model, or you might
have other models containing Packages
that you want to use in the current model.

Import a
Model
Branch From

Uses Enterprise Architect's Model Branch
files, of which there are few, to retrieve
information about the root Package file
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Version
Control

and to import the model branch.
Model branch files can simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

Add
Connectors
To Locked
Elements

Generally, when working in a diagram
containing locked elements, you cannot
add a connector to a locked element.
There are scenarios in which a connector
can be created on a locked element
depending on the locking status of the
parent Packages.

Validate
Package
Configuratio
ns

You can test the validity of the Version
Control settings associated with each
Version Controlled Package within your
current model.

Resynchroniz
e the Status
of Version
Controlled
Packages

Re-synchronizes the Version Control
status of Packages within your project
with the status reported by your Version
Control provider.
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Include Other Users' Packages
Other users might be developing Packages in their own
models that you could use in your model, or you might have
other models containing Packages that you want to use in
the current model. Unless you are sharing an SQL database
or project file, those Packages are not automatically
available to you. However, if the Packages have been placed
into Version Control, you can import them into your model
as children of one of your model's Packages.

Access

Context
Menu

Right-click on Package > Package
Control > Get Package

Import Packages from Version Control into
current model

Ste
p

Action

1 On the 'Get Shared File' dialog, click on the
drop-down arrow of the 'Version Control
Configuration' field and select the Version Control
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configuration associated with the Package to
retrieve.
The file list is populated with the names of files
available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model
and click on the OK button.
The Package file is imported as a new child Package,
under the parent Package you selected.

Notes

You must have access to the Package files through the·

Version Control system and you must define a Version
Control configuration through which to access those files

The Version Control configuration must use the same·

unique ID that was originally used to add the Package to
Version Control

XMI Package files associated with Packages that are·

already part of your project, are NOT included in the list
of files available for import
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Export Controlled Model Branch
Applying Version Control to a model can result in many
XMI files being placed under Version Control. It might then
be hard to locate and import the file corresponding to the
root of a particular model branch. Using Model Branch Files
(.eab files) overcomes this problem by making it easier to
export and import Package hierarchies from one model to
another.

You could export a newly created model branch from your
own private copy of a model so that, for example:

Another user can import that branch into their own private·

copy of the same model

It can be imported for inclusion as a common branch in a·

number of different models

Access

Context
Menu

Right-click on Package > Package
Control > Export as Model Branch

Create a Model Branch File to represent a
Package hierarchy stored in Version Control
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Ste
p

Action

1 On the 'Export as Model Branch' dialog, in the 'EAB
Filename' field, type a name for your Model Branch
File.
Alternatively, click on the  button and browse for
the file location.
Note that the Package name is supplied as a default.

2 Click on the OK button.
A branch file is created to represent the selected
Package. The branch file is committed to Version
Control using the same Version Control
configuration that controls the Package you selected.

Notes

You can specify any file name, including sub-folder·

names, as long as the file is contained in or below the
working folder of your Version Control configuration

The facility is only enabled for Packages that are already·

under Version Control
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Import Controlled Model Branch
Applying Version Control to a model can result in many
XMI files being placed under Version Control. It could then
be hard to locate and import the file corresponding to the
root of a particular model branch, if you want to:

Retrieve a model branch created by another user in a·

private copy of a model, to import it into your own private
copy of the same model

Retrieve a model branch that is common in many models,·

for inclusion in a new model

Model Branch Files overcome this problem by simplifying
the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of
which there are few, to retrieve information about the root
Package file - such as the name and type of the Version
Control configuration for the selected Package, and the
relative filename of the Version Controlled XMI file
associated with the Package. The system then uses this
information to import the branch into your model.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·

branch file associated with the model branch to import, in
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a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch

Import a Model Branch

Ste
p

Action

1 On the 'Import VC Model Branch' dialog, either:
Use the lower portion of the dialog to select a·

model branch file (this is the simpler option if the
associated Version Control configuration has
already been saved in the current model; continue
to step 2)
OR
Click on the Find a Model Branch (.EAB) file·

button (this option is useful when you have not yet
defined the Version Control configuration that is
associated with the model branch to be imported;
see the Manually Locating Model Branch Files
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topic)

2 Click on the drop-down arrow in the 'Select a
Version Control Configuration' field and select a
configuration.
A list of .eab files controlled by that configuration is
displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on
the OK button.
The system imports the root Package specified in the
Model Branch File and recursively imports and
populates all the sub-Packages contained in the root
Package.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Manually Locating Model Branch Files
When importing a Model Branch File from Version Control,
you might not have the associated Version Control
configuration saved in the model that is receiving the
import. In this situation, it is simpler to manually browse the
file system to locate the Model Branch File (.eab) and let
Enterprise Architect derive the details of the configuration
from the branch file you select.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·

branch file associated with the model branch to import, in
a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch : Find a Model Branch (.EAB)
file
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Locate the Model Branch File

Ste
p

Action

1 Access the 'Import VC Model Branch' dialog, then
browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.
If the Version Control configuration referenced by
the file is fully defined within the current model, the
import commences at this point.
Otherwise, Enterprise Architect displays a dialog
prompting you to complete the required
configuration.

3 Click 'Yes' to proceed with completing the definition
of the Version Control configuration.
The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.
(Typically this involves simply specifying the
working copy folder.)

5 Click on the Save button.
The configuration details are saved.
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The import of the model branch proceeds.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Add Connectors To Locked Elements
Generally, when working in a diagram containing locked
elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and
target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the
source and target element are held in different Packages).
There are scenarios in which a connector can be created on a
locked element.

Lock Scenarios

Element
Status

Add Connectors

Source
unlocked,
target
unlocked

Yes, any kind of connector can be added

Source
unlocked,
target locked

Yes, except for Composition connectors

Source
locked, target
unlocked

No, except for Composition connectors
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Source
locked, target
locked

No, prohibited for all connectors

Notes

A connector can be added if its source is unlocked - you·

are modifying what the source can see

The exception is Composition connectors, where the·

target (the parent) must be unlocked - you are modifying
the parent by adding children

(c) Sparx Systems 2025 Page 401 of 417



Manage Model Change 2 September, 2025

Validate Package Configurations
Having defined the Version Control settings for your current
model, you can test the validity of those settings associated
with each Version Controlled Package within the model.

Access

Ribbon Settings > Version Control > Check
Configuration

Validate Version Control settings

Ste
p

Action

1 The validation process scans the model database and
verifies that the Version Control configuration
associated with each Version Controlled Package is
fully specified in the current model. It also queries
the corresponding Version Control provider to find
the status of the Package file associated with each
Version Controlled Package.
The results of the validation process are sent to the
System Output window.
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2 Open the 'Version Control Settings' dialog to
complete the definition of any invalid or missing
Version Control configurations.

3 Click on an error message in the System Output
window to highlight the corresponding Package in
the Browser window.

4 Right-click a Package node and select 'Package
Control | Configure Package' to open the 'Package
Control Options' dialog.
Correct any problems with the Version Control
details for the Package.
Correct any problems with the Package's associated
XMI file.

(c) Sparx Systems 2025 Page 403 of 417



Manage Model Change 2 September, 2025

Resynchronize the Status of Version
Controlled Packages
It is possible to update the Version Control status of
Packages within your project to re-synchronize with the
status reported by your Version Control provider. This can
be useful if you are creating copies of your project, where
checking in a Package from one copy of the model leaves
the Package in the second copy of the model with an
out-of-date Version Control status.

For a given Package, the re-synchronization process queries
the corresponding Version Control provider to find the
status of the Package file associated with the Version
Controlled Package. If necessary, the process then updates
the Package flags within the model database, to synchronize
the Package status recorded in the model with the value
reported by the Version Control provider.

Access

Ribbon Settings > Version Control > Re-Synch
Status (applies to all Packages in model)

Context
Menu

Right-click on Package > Package
Control > Re-synch Status With VC
Provider (applies to single Package only)
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Resynchronize Version Control status

Ste
p

Action

1 The results of the re-synchronization process are sent
to the System Output window.

2 Double-click on any result message to select, in the
Browser window, the corresponding Package.

Notes

This process does not cause any Package data to be either·

exported from your model to the associated Package file,
or imported from a Package file into your model's
Package data

If a Package has been checked-out and modified with·

Enterprise Architect, but your Version Control provider
reports the Package file as checked-in, running this
process marks the Package within Enterprise Architect as
being checked-in, without exporting and committing the
pending changes; subsequently checking-out the Package
imports the latest revision of the Package file from
Version Control, effectively discarding the uncommitted
modifications from the model
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Similarly, if a Package file is checked-out to you in your·

local working copy folder, but not in the Enterprise
Architect model, running this process marks the Package
within the model as checked-out, but it does not import
the associated Package file from the Version Control
system; consequently, it is possible to check-in a Package
from Enterprise Architect that is potentially out of date,
compared to the latest revision of the Package file within
the Version Control system
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Performance Considerations
This topic presents a few 'best practices' for version control
that improve model performance, along with a short
explanation of how that benefit is realized.

Apply Version Control to All Packages

Apply Version Control to each and every package within
your model.  This is easily acheived using the convenience
function "Add Branch to Version Control".

Version Control performance can be dramatically improved
by following this practice.

The mechanism used for applying Version Control in
Enterprise Architect is to export the information describing
a package and its contents, from the model database to an
XMI file, which is then added to the version control
repository.  If version control is applied only to the top-level
package, then the entire model is exported and saved to a
single XMI file.  Every time you update the package from
version control, for either a "Check Out" or a "Get Latest",
the package and its contents are first deleted from the model
database, before being re-imported from the associated
XML file.  In this case, the entire model would be deleted
from the database, before being re-imported from XML.  By
contrast, if all packages are version controlled, then only a
tiny portion of the model is exported to each XML file and
only a tiny portion of the model is deleted and re-imported
when checking-out or updating a package.
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Concurrent access for editing the model is also vastly
improved by following this practice.

When a version controlled package is checked-out, that
package and its contents are locked to other users - only the
user who has checked-out the package can edit it.  If version
control was applied only at the top-level package, when one
user checks out that package, then the entire model would
be locked, preventing any other team members from making
modifications until the top-level package is checked in by
the first user and subsequently checked out by the other.  If,
on the other hand, version control is applied at multiple
levels within a package hierarchy, independently controlled
sub-packages remain unaffected when the parent package is
checked out.  So, if one user checks out a package to make
modifications, a second user can still check out a separate
package at the same time and make modifications to that
package.

Select "Import Changed Files Only" for Get
All Latest

The performance of the "Get All Latest" function, is
dramatically reduced by re-importing package files that
have not changed.  So, for best performance do not
re-import unchanged package files.  When the "Get All
Latest" command is invoked, you will be prompted to select
which files to import. You should always choose the option
"Import Changed Files Only".
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For Shared Model environments, when the option "Import
Changed Files Only" is used, the Get All Latest command
will simply refresh your view of the model, by reloading
diagrams and Browser window content, from the model
database.  If you select "Always import" or "Prompt for
each file", you are forcing Enterprise Architect to delete the
package from the model database, then re-import exactly the
same information back into the model.

When using a Shared Model environment, where all users
are connected to a single model database, there is never any
need to re-import package files from version control.  The
information in the model database is always the same as, or
ahead of, what is committed into Version Control.  In this
situation, the information in version control has been
exported from the model database before being committed
into version control.  You simply cannot import new
information into the model from the version control
repository.  When using a Private Model environment,
where each user connects to a private copy of the model
database, there is still no benefit in re-importing package
files that have not changed since your last update.  It only
extends the time taken for the operation to complete.

Use a Single Version Control Configuration to
Control All Packages in Model

Minimising the number of Version Control configurations in
your model will result in a faster model loading time.  Using
multiple Version Control configurations in a single
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Enterprise Architect model will extend the time taken to
load the model.

While it is possible to use many different Version Control
Configurations to control different packages in your model,
unless you have a specific reason to this, then you should
use just one configuration for all packages in the model.
When Enterprise Architect loads a model that uses version
control, it verifies that it can communicate properly with
each of the Version Control configurations as the model is
loaded.  Depending on the version control provider, EA
issues a command such as "status" in the working copy
folder associated with the Version Control configuration,
which verifies that the working copy folder exists and can
be accessed and that the version control client can
communicate with the version control server.  All of this
takes time.  When there are many Version Control
configurations in one model, this can have a significant
impact on the time it takes to load your model.
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More Information
The Version Control feature in Enterprise Architect allows
users to check out a Package, locking it from modifications
by other users until it's checked back in. You can then make
changes to the Package, adding new elements, modifying
existing ones, or deleting others. Once your changes are
complete and you're ready to share them with other
modelers, you can check in the Package, requiring other
modelers to do a Get Latest to fetch the new changes from
the Version Control Server.

Edition Information

Version Control facilities are available in the Professional,·

Corporate, Unified and Ultimate Editions of Enterprise
Architect.

A team needs to provide their own Version Control Server·

and Client that are compatible versions.

Notes

Sparx Systems strongly urge you not to manipulate·

Version Controlled Package files outside of Enterprise
Architect; it is possible to leave the Package files in a
state that Enterprise Architect cannot recognize

Database replication should not be combined with·

Version Controlled Packages
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If the Packages under Version Control contain any·

alternative images and those images are subject to
frequent change, you can set the 'Export alternate images'
option on the 'Preferences' dialog to export the images to
the Version Control repository when you check in the
Packages; if the images are not subject to frequent change,
do not select this option and instead use 'Export/Import
Reference Data' to manage alternative images
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Compare Projects
Compares a Source and Target Repository for
Differences

The Compare Project facility provides a summary of the
changes to a repository by providing a comparison of the
number of rows in each system table in the source and the
target repositories. The modeling information contained in
an Enterprise Architect repository is stored in a set of tables
in a relational database. These are system tables that allow
you to compare the number of rows in each of the tables,
which will provide valuable insights into the differences
between two repositories. The tables (with rare exceptions)
have intuitive names as indicated by these examples:

t_attribute - stores element attributes·

t_diagram - stores diagrams·

t_object - stores elements·

t_package - stores Packages (folders)·
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Apart from the deliberate changes that you and other
modelers make when working on your repository, a number
of operations can also make changes to your project that you
either want to monitor carefully or that you do not want to
retain. Such events include:

Recovering from a database problem·

Restoring a backup·

Performing a Project Data Transfer·

Importing from XMI, and·

Deleting model elements·

You might have made a copy of the original project, or the
purpose of the operation is to generate a copy, in which case
you can compare the size and row counts of the 'before' and
'after' copies as a convenient 'sanity check' that the two
repositories are equivalent. The repositories can be on
different platforms and the comparison can be made
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between files and server based repositories as described
here:.

Compare a project file to another project file (e.g. a·

*.qeax file and a *.feap)

Compare a project file to a DBMS-based repository (e.g. a·

*.qeax file and an Oracle db)

Compare two DBMS repositories  (e.g. a MySQL db and·

an Oracle db)

The comparison examines the number of rows in each
database table, producing a report indicating the total
records in each and the difference in record count between
the two. If discrepancies are found, you would need to
investigate further manually. The comparison does not
examine the actual data in the tables but rather provides the
summary in the form of table row counts

Access

Ribbon Settings > Model > Integrity > Project
Compare

Compare two projects

Ste
p

Action
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1 On the 'Project Compare' dialog, select the radio
button for the database types of the two projects you
want to compare:

File to File·

DBMS to File·

File to DBMS·

DBMS to DBMS·

2 In the 'Source Project' and 'Target Project' fields,
select the connection strings for the source and target
projects.

3 Click on the Compare Projects button.
The results of the comparison display in the panel at
the bottom of the dialog.

4 If you want to print the results of the comparison,
click on the Print List button.
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